# Contents

**Introduction** .................................................................10

What is 4Designer? ...............................................................11
Authoring Using 4Designer .......................................................13
4Designer Workflow ...............................................................14
New Features in 4Designer 1.2 ...................................................15
System Requirements ..............................................................17
Licensing ..............................................................................18
  Configuration ........................................................................18
Conventions Used in This Document ........................................19

**Getting Started** .............................................................20

Starting 4Designer ................................................................21
  Starting RenderEngine ..........................................................22
The 4Designer Main Screen .....................................................23
  The Scene Tree: Managing Objects .........................................24
  Using the RE Window ............................................................26
  The Transformation Strip .......................................................27
  The Assets Tab .....................................................................27
  The Properties Tab ...............................................................28
  The Stack............................................................................29
  The Control Interface ...........................................................29
  The Editors: Editing Graphics ...............................................29
Menus and Toolbars .............................................................32
  File Menu ...........................................................................32
  Edit Menu ...........................................................................33
  Animation Menu .................................................................33
  Tools Menu ........................................................................35
  Renderer Menu ....................................................................35
  View Menu ..........................................................................37
  Help Menu .........................................................................39
Creating a New Scene ..........................................................40
  Loading a Scene .................................................................41
  Saving a Scene ...................................................................42
Function Operators .................................................................................................................. 171
Using Math Function Parameters .............................................................................................. 176

Animations .................................................................................................................................. 178
The Animation Strip ..................................................................................................................... 179
The Animation View ...................................................................................................................... 181
  Animation View Controls ........................................................................................................... 182
Using the Right Mouse Button .................................................................................................... 183
Keyframe Fields ............................................................................................................................ 184
  Deleting a Keyframe .................................................................................................................. 187
  Deleting a Channel ................................................................................................................... 187
  Sorting Keys by Type .................................................................................................................. 187
Defining an Animation Sequence ................................................................................................... 188
  Changing Keyframe Properties ............................................................................................... 189
Setting Animation Speed ............................................................................................................. 190
Setting Out-of-Range Behavior ..................................................................................................... 191
Animation Groups ........................................................................................................................ 192
  Creating Multiple Animation Groups ....................................................................................... 192
  Automatic Animation Rewind ..................................................................................................... 192
Filtering Keyframes ....................................................................................................................... 193
Triggers ......................................................................................................................................... 194
  Deleting Triggers ....................................................................................................................... 196
  Triggering Actions ..................................................................................................................... 196
Animating Along a Path ................................................................................................................. 203
  Editing a Path ........................................................................................................................... 205
Master Animations ........................................................................................................................ 206

Interactivity .................................................................................................................................. 207
Making Objects Interactive ............................................................................................................ 208
  Tips for Designing Interactive Scenes ..................................................................................... 211
Applying Physical Properties ........................................................................................................ 212
  Activating Physics ..................................................................................................................... 213
Constraining Objects ..................................................................................................................... 215
  Cage Constraint ......................................................................................................................... 216
  Cone Twist Constraint ............................................................................................................... 216
  Generic Six-Degree Constraint .................................................................................................. 217
  Hinge Constraint ....................................................................................................................... 217
  Point to Point Constraint .......................................................................................................... 218
Slider Constraint ........................................................................................................ 218
Web Interaction ........................................................................................................ 219

**Customization** ..................................................................................................... 220
Customizing the Main Screen .................................................................................... 221
Customizing the Scene Tree ....................................................................................... 222
Setting Preferences .................................................................................................... 223
  Appearance .............................................................................................................. 224
  Extension Button Hotkeys ....................................................................................... 226
  Files and Directories ............................................................................................... 227
  Hotkeys (Shortcuts) ................................................................................................. 229
  Log ........................................................................................................................ 230
  Miscellaneous .......................................................................................................... 231
  Object Operations ................................................................................................... 233
  Paste ...................................................................................................................... 234
  RenderEngine ......................................................................................................... 235

**Shaders** .................................................................................................................. 238
Using Shaders ......................................................................................................... 239
  Applying a Shader .................................................................................................. 240
  Creating a Shader from Scratch .......................................................................... 241
  Assigning a Shader to an Object ......................................................................... 243

**Importing Objects** .................................................................................................. 244
Exporting Graphics for Use in 4Designer ................................................................. 245
  Limitations of Object Importing ......................................................................... 245
Importing Objects into 4Designer .............................................................................. 246
VRML Elements in 4Designer .................................................................................. 248
  Changing Materials in the Scene ........................................................................... 248
  Transparent Objects and Brilliance Effects .......................................................... 248
  Animated Textures ................................................................................................... 248
Exporting Tips for Other 3D Software ....................................................................... 249

**Appendix** .................................................................................................................. 253
Line Charts Design ..................................................................................................... 254
  Modifying the Background of a chart .................................................................... 254
  Changing the point marker type ............................................................................ 254
  Defining a fill area underneath the line ................................................................... 255
  Defining the style and depth of the line ............................................................... 256
Animation of a chart ................................................................. 258
Isometric camera - preview of the available presets....................... 259
1. Introduction

In this section:

*What is 4Designer?* on page 11
*Authoring Using 4Designer* on page 13
*4Designer Workflow* on page 14
*New Features in 4Designer 1.2* on page 15
*System Requirements* on page 17
*Licensing* on page 18
What is 4Designer?

4Designer is a broadcast graphics authoring tool, part of a package that provides a complete graphics environment for creating complex three-dimensional scenes, together with real-time broadcasting control. 4Designer is designed to provide animated real-time performance for a wide range of applications, such as sports, weather, news, finance, elections, special events, etc.

Here is an example of the 4Designer final production output:

A full 4Designer system is made up of three software modules:

**4Designer - authoring module.**

**Control Application** – control RenderEngine and broadcast the graphics created with 4Designer, such as Maestro or 3DPlay.

**RenderEngine** – real-time application for rendering the graphics to a video output.

The 4Designer modules address all requirements for integrating your OAG applications into an automated studio. First, 3D graphic scenes are created in the 4Designer module, where you can define animated sequences and determine what can be changed in real time by "exporting" parameters to the Control module. Reporters can then insert or import current data into the templates using a Controller, which can be run from a remote station.

4Designer’s intuitive authoring capabilities provide maximum design flexibility without the need for programming or professional graphic-design experience. 4Designer authoring allows you to use a 2D layout that simplifies the process of constructing your scene, while allowing you to switch to a 3D display where you can view and edit your work. Using and manipulating a virtual camera, you can provide alternative displays that allow you to view your work from different angles.
4Designer includes project management tools and libraries for objects and templates, and supports imports from external modeling packages in VRML2 / VRML97, COLLADA, and Photoshop file format. The different work-area modes contained in 4Designer take you through the natural stages of defining a scene, as described in the following chapters.
Authoring Using 4Designer

4Designer’s structure is based on the creation of scenes within projects. When authoring a scene, you can either create a completely new scene, or use an existing scene or generic template as a base.

During the creation of the scene, you add objects by dragging and dropping them into the work-area, and you then define characteristics for the objects.

You can use 4Designer to connect and animate the objects in the scene, and to export object data for manipulation in real-time.

**Animation** - 4Designer enables you to create unlimited high-quality animations. Graphic parameters can be animated in 4Designer and, if required, exported for real-time manipulation.

**Exporting for real-time manipulation** - 4Designer provides maximum flexibility for manipulation of on-air graphics in real time. By exporting parameters from 4Designer to the Control module, data can be sent to animated sequences, object properties, and text strings, allowing them to be updated in real time. For example, a bar may grow and change color in real time to represent the score and colors of the winning team.

**Internal reference and math functions** - 4Designer provides the ability to connect a data parameter from one object to any parameter of a second object, so that any manipulation of the first parameter value is also applied to the second. You can also define more advanced math functions for manipulating data allowing complex animated actions based on real-time data (Available in 4Designer Advanced only).

**Exported Parameters** - 4Designer provides a runtime control application that can set data into exported parameters.

**Interactivity** - Interaction parameters can be added in 4Designer, to allow later manipulation of objects by viewers, as set in the 3DPlay Controller.
4Designer Workflow

The following workflow contains the main tasks performed when creating a scene in 4Designer.

Open scene in project

Position objects in the Preview window
To create your scene, you must first add objects, and then define their placement in three-dimensional space.

Define groups and geometric properties
You can define unique characteristics for each object added to the scene, customizing the geometric properties of the objects to your requirements.

Define surface attributes
You can give character to the scene by defining attributes such as color, material, texture and lighting for each object.

Export and edit real-time parameters
You can export most parameters in 4Designer to the 4Designer Control module, where data can be imported and manipulated in real-time.

Create and edit animations
4Designer enables you to animate almost anything in your scene.

Save scene
New Features in 4Designer 1.2

The following features have been added:

Scripting

4Designer now allows to create scripts that can be executed when a Trigger condition is fulfilled. This mechanism gives more options to introduce logic on the scene level.
For more information, see Set Action Script on page 199.

Deformations

Deformations are new, special properties that can be applied to any object to change their appearance. Multiple modifiers can be applied to the same object and be processed one after another.
For more information, see Deformations on page 119.

Line and Area Chart Assets

New Line and Area Chart objects are now available under the Complex Objects tab. These can be used to visualize data in various ways.
For more information, see New complex objects: Line Charts on page 55.

New Masking Options

Masking options have been improved and a new Masks viewer has been introduced to facilitate managing multiple masks within a scene.
For more information, see Mask Options on page 78.

New Control Interface Window

A new Control Interface window is available, which makes managing exports, animations and exposers a lot easier.
For more information, see The Control Interface on page 29.

Rectangle Soft Edge Texture

A new texture Rectangle Soft Edge is now available and allows to create soft edge masks on rectangle objects.
For more information, see Applying Textures on page 103.

New Isometric Camera

The new Isometric Camera allows you to manually set axes’ angles and scales.
For more information, see Isometric Camera on page 65.
New Renderer Toolbar Buttons

Additional buttons are now available in the Renderer Menu: Show Depth, Show Normals, and Hide Bounding Boxes.

For more information, see Renderer Menu on page 35.

New Cut-out Editor

The new Cut-out editor allows to work on complex cross-sections that also feature multiple cut-outs (holes).

For more information, see Cut Editor on page 94.

Pixel lighting Option Added to Material Editor

A new, more realistic per-pixel lighting model has been introduced, which makes all scene objects look smoother on the screen.

For more information, see Setting Colors and Materials on page 99.

Support for SRT Subtitles

Subtitles in the SRT format are now supported and can be added to a 4Designer scene.

For more information, see Subtitles on page 163.

Motion Blur Strength Parameter Added to Layer Editor

Motion Blur Strength parameter has been added to the Layer editor. It changes the motion blur in a way as if the blurred object’s velocity was multiplied by the given value.

For more information, see Motion blur on page 62.

Softness Parameter Added to Fake Shadow Editor

Softness parameter has been added to the Fake Shadow editing options.

For more information, see Applying a Fake Shadow on page 129.
System Requirements

The optimum platform for 4Designer uses an HDVG with authoring on Microsoft Windows®.

Hardware specifications for 4Designer:

- Intel Core i5-3470 3.2G 6M HD 2500 CPU and above.
- 8GB of physical memory.
- 500GB 7200 RPM 3.5 HDD.
- NVidia GeForce card GT640 2048MG DDR3.
- Two onboard or PCI Intel NIC Ethernet cards 1000mps (Only the card connecting the PC and the HDVG should be enabled, the second card is intended for support purposes and should be disabled.)
- 24" 1920x1080 resolution capable monitor (24/32 bit color)
- DVD-ROM/CD-Writer or DVD-Writer
- USB Keyboard and Mouse
Licensing

Install 4Designer using the Installation wizard and the provided installation guide to help you through the various installation requirements.

After restarting the Control-PC, the HASP ID number should be noted and sent to Avid support for licensing and registration.

Configuration

Configure RenderEngine in the HDVG Control Panel. This tool allows you to manage multiple HDVG configurations without the need to edit any files manually.

Use the HDVG Control Panel shortcut on the desktop to open the tool. See the HDVG Control Panel documentation for further information.
Conventions Used in This Document

This symbol marks a step-by-step procedure.

NOTE:
A note specifies useful or optional information, relevant to the preceding text.

TIP:
A tip provides useful information on shortcuts, or how to do things differently.

Bold text marks a part of the User Interface such as a menu item, dialog box name, or button. For example, “click OK”.

ALL CAPITALS text specifies a keyboard key. For example, “press CTRL and drag the name...”.
2. Getting Started

In this section:

- Starting 4Designer on page 21
- The 4Designer Main Screen on page 23
- Menus and Toolbars on page 32
- Creating a New Scene on page 40
- 4Designer HDVG Video Output on page 45
- Manipulators on page 46
- Extension Buttons on page 48
- Controller on page 50
Starting 4Designer

During installation, 4Designer shortcuts are created on the desktop and in the Start menu. (You can switch modes from within 4Designer also):

- 4Designer with RenderEngine on Windows.
- 4Designer with RenderEngine on the HDVG.

To start 4Designer:

- Double-click the 4Designer icon on the desktop.
- or-
- From the Start menu, select Programs > Orad > 4Designer 1.2.

To set various launch options:

- Right-click on a shortcut, and select Properties to display the Properties dialog box;
Add any option as text after the shortcut **Target** name to set how 4Designer opens.

**NOTE:**
*If your HDVGs are shared between productions and graphics preparation, it is recommended that the option `-r localhost` be used, to prevent connection to an HDVG while on-air.*

**Starting RenderEngine**

While working in Local mode, RenderEngine will be launched automatically on Windows.

To start RenderEngine on the HDVG, use the desktop icon.

Alternatively, if you have more than one HDVG connected, you can launch the appropriate RenderEngine from **Start > All Programs > Orad > RenderEngine4Linux > [Hostname] > Start.**

There is also a corresponding icon on the desktop to stop RenderEngine on the remote HDVG.
The 4Designer Main Screen

The 4Designer main screen allows access to all of 4Designer’s menus, functions and windows. In the following example, the RE window shows an open scene.

**NOTE:**
Control the main screen display using the available toolbars. In the Windows toolbar, you can toggle the display of crucial windows such as the Scene Tree, Property Editor strip, Assets tab, etc.
The Scene Tree: Managing Objects

The Scene Tree is a hierarchical list displaying the objects in the scene together with their properties. This is the place to create a clear hierarchy with unique and unambiguous object names to use later as controls to prepare a scene for broadcast.

To hide/display the Scene Tree:

- Hide or display the Scene tree with the Scene Tree button.

  Click the icons in the Scene Tree column headings to expand or minimize the columns to display the full names of the attributes. For more information, see Customizing the Scene Tree on page 222.

When objects are added to a scene, by default they receive unique names that consist of the primitive name and (if there is already an object in the scene that shares the same name) a number. For example, if you add two spheres to a scene, they are named Sphere and Sphere1, respectively. The default name can (and should) be changed in the Scene Tree to a more descriptive name.

The order of objects in the three-dimensional scene is based on the hierarchy in the Scene Tree. This order affects their appearance in the scene. For more information, see Rendering Mode on page 61.

To move objects in the Scene Tree hierarchy:

- Select the object in the tree, and drag it to the required position.

In the Scene Tree, you can change object properties by selecting the object in the list and right-clicking to open a menu. You can also right-click any property in the adjacent columns for further editing possibilities.

Click any icon in the Scene Tree to display the relevant Property Editor tab for editing.
Objects and properties in the Scene Tree (and sometimes related extension buttons, in the editors) have colored indicators next to the property icon to represent exports, animation, connections and functions. Click an indicator to open the appropriate editor.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red/yellow square</td>
<td>This property has an animation assigned in the current animation group. When the indicator is red there is an animation assigned, but the animation is not in the currently selected animation group.</td>
</tr>
<tr>
<td>Yellow/black square</td>
<td>Indicates referenced properties. Click the indicator to highlight all referenced properties in the tree.</td>
</tr>
<tr>
<td>Red/white square</td>
<td>Indicates that this property has sub-properties. For example, text has both style and decoration. Click the indicator to extend the icons underneath the property to show further references (they are also shortcuts).</td>
</tr>
<tr>
<td>Purple square</td>
<td>Object has exported parameters. Click the indicator to open the Export tab in the Connections window.</td>
</tr>
<tr>
<td>Green square</td>
<td>Object has a defined connection to another object. Click the indicator to open the Connections window.</td>
</tr>
<tr>
<td>Yellow square</td>
<td>Object has defined trigger. Click the indicator to open the Triggers window.</td>
</tr>
<tr>
<td>Blue square</td>
<td>Object has a mathematical function connected to it. Click the indicator to open the Math tab in the Connections window.</td>
</tr>
</tbody>
</table>

You can apply a colored background to scene layers by right-clicking the layer and selecting Color.

**To display only specific objects in the Scene Tree:**

1. In the Scene Tree, select the objects that you want to display.
2. Right-click and select **Isolate Selection** (or CTRL+I).
   
   All other objects and layers in the scene are hidden in the Scene Tree and in the RE window, without affecting their visibility properties.
Using the RE Window

The RE (Render Engine) window displays your scene using RenderEngine’s output. You can select objects in the RE window and edit their appearance. This image shows the 4Designer interface with the RE window active.

The RE window displays a layout grid with perspective. From the View menu (View settings), you can display different two-dimensional views. For more information, see View Menu on page 37.

Here you see the final output of your scene. Objects can be added to the scene using drag-and-drop to place objects from the Assets directly into the required location on the RE window.

When you add or select an object in the RE window, its bounding box is displayed. You can change the bounding box color in the preferences. For more information, see RenderEngine on page 235.

**NOTE:**

Operations such as selecting a group, adding assets to groups, and changing the location of objects within the Scene Tree cannot be carried out from the RE window, and must be done from within the Scene Tree.

Items in the RE window can be zoomed using the slider at the right of the RE window. This feature is useful for RE window settings that are customized for multiple tiles (For more information, see RenderEngine on page 235).
The Transformation Strip

The Transformation strip is used for defining position, rotation, and scaling properties for the current object or the object's pivot.

The Pivot is the point around which the object turns, when rotated. By default this point is the center of the object, but you can change the pivot as required.

The Assets Tab

The Assets tab contains a number of libraries with objects, materials, textures and other elements required to build a scene.

To hide/display the Assets tab:

- Hide or display the Assets with the Assets button.

Switch between the various libraries using the tabs.

The Assets tab contains the following libraries that can be accessed by clicking the appropriate icon:

Primitives  
Contains basic geometric shapes used as the basis for other objects; primitive objects are dragged and dropped into a scene. For more information, see Primitive Objects on page 52.
From the **Assets**, you can:

- Drag and drop assets into the Scene Tree (multi-selection available) to add to a scene.
- Drag and drop assets directly into the RE window to add to a scene. For objects, this creates a new object; for properties, this applies the property to the target object.
- Drag and drop items (objects, properties etc), from the Scene Tree to the **Assets** to be saved as a single asset (multi-selection available).
- Drag and drop reference items/properties (like cut-outs, text styles) from editors to the **Assets**.
- Drag and drop property items (from the **Properties** tab) into the **Assets** tab.

**To add an asset to a scene:**

- Drag the element from the **Assets** tab to the RE window or the Scene Tree.

The Properties Tab

The **Properties** tab displays all objects, properties, or resources that are used in the scene or were previously used. For example, materials or textures.
To Use the Properties tab:

■ Select a property in the Scene tree and click Properties.

The Properties tab is displayed, showing all properties of the selected type used in the scene.

Filter the display as required. For example, Active pool type filters a display of all the similar properties in the scene. For more information, see Applying Properties from the Properties Tab on page 133.

The Stack

The Stack is an extended editor that is available at all times, regardless of the object selected in the Scene Tree. You can drag any property to the Stack for editing, without losing focus on the selected object.

The Control Interface

The Control Interface is a separate window gathering all controls for a scene (exports, animations and exposers).

To hide/display the Control Interface:

■ Click Control Interface to hide or display the window.

You can modify all exports belonging to all objects in the scene in the Control Interface. It is also possible to play all animations here.

The Editors: Editing Graphics

The Editors are used to edit the properties of the objects in the current scene.
To hide/display the Editor:

- Click Editor to hide or display the property Editors.

Modify objects and the properties associated with objects using the tabs in the Property Editor strip. You can set properties such as drawing style, resolution, color, texture, illumination, and more.

The Editor tabs display relevant parameters for the object selected in the RE window or in the Scene Tree. The tabs are context sensitive, so the fields displayed vary according to the object. When there is no relevant data the tabs do not display an icon.

The Property Editor tabs are:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layer</td>
<td>Parameters for controlling the layer in the scene. For more information, see Layers on page 60.</td>
</tr>
<tr>
<td>Object</td>
<td>Parameters for controlling the behavior of the selected object. For more information, see Object Properties: Rectangles, Gradients, and Video Textures on page 86.</td>
</tr>
<tr>
<td>Camera</td>
<td>See Cameras on page 62.</td>
</tr>
<tr>
<td>Depth Buffer</td>
<td>See Depth Buffer on page 68.</td>
</tr>
<tr>
<td>Transformation</td>
<td>Controls for positioning, rotating, and scaling the selected object. For more information, see Object Placement and Size on page 81.</td>
</tr>
<tr>
<td>Shape</td>
<td>Parameters for modifying the shape and other physical characteristics of the selected object. For more information, see Defining Shapes and Geometry on page 85.</td>
</tr>
<tr>
<td>Color</td>
<td>Parameters for mixing colors and materials. For more information, see Setting Colors and Materials on page 99.</td>
</tr>
<tr>
<td>Texture</td>
<td>Parameters for modifying textures, importing images to the texture gallery, etc. For more information, see Applying Textures on page 103.</td>
</tr>
<tr>
<td>Light</td>
<td>Parameters for controlling the lighting assigned to an object. For more information, see Lighting on page 128.</td>
</tr>
</tbody>
</table>
The Editors are context sensitive, and the fields change and become active according to the type of object and property selected.

<table>
<thead>
<tr>
<th>Text Effect</th>
<th>Parameters for setting text effect options, when an effect is applied to a text object. For more information, see Animating Text Characters – Text Effects on page 154.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Masks</td>
<td>Parameters for using objects as masks. For more information, see Mask Options on page 78.</td>
</tr>
<tr>
<td>Layer Masks</td>
<td>Parameters for using layers as masks. For more information, see Mask Options on page 78.</td>
</tr>
<tr>
<td>Path</td>
<td>Parameters for grid or path properties for an object. For more information, see Editing a Path on page 205.</td>
</tr>
<tr>
<td>Projectors</td>
<td>Parameters for setting different shadowing for objects. For more information, see Shadows on page 129.</td>
</tr>
<tr>
<td>Shaders</td>
<td>Parameters for adjusting the properties of a shader assigned to an object. For more information, see Using Shaders on page 239.</td>
</tr>
<tr>
<td>Interaction</td>
<td>Parameters for defining interactivity options of objects. For more information, see Making Objects Interactive on page 208.</td>
</tr>
<tr>
<td>Physics</td>
<td>Parameters for setting physical movements of interactive objects. For more information, see Applying Physical Properties on page 212.</td>
</tr>
<tr>
<td>Constraints</td>
<td>Parameters for restricting the movement of interactive objects. For more information, see Constraining Objects on page 215.</td>
</tr>
<tr>
<td>Container Camera</td>
<td>Parameters for assigning a camera to follow a path.</td>
</tr>
<tr>
<td>Deformations</td>
<td>Parameters for modifying deformations. For more information, see Deformations on page 119.</td>
</tr>
</tbody>
</table>

For further (advanced) property editing options, see The Advanced Window on page 133.
Menus and Toolbars

The following tables provide information on the menus and toolbars available in 4Designer.

File Menu

<table>
<thead>
<tr>
<th>New Scene</th>
<th>Open a dialog box to create a new scene/project. For more information, see Creating a New Scene on page 40. (Keyboard shortcut: CTRL+N).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Scene</td>
<td>Open a dialog box to open an existing scene. For more information, see Loading a Scene on page 41. (Keyboard shortcut: CTRL+O).</td>
</tr>
<tr>
<td>Save Scene</td>
<td>Save the current scene. For more information, see Saving a Scene on page 42. (Keyboard shortcut: CTRL+S).</td>
</tr>
<tr>
<td>Save Scene As</td>
<td>Open a dialog box to save the scene under a different name in the current project. For more information, see Saving a Scene on page 42. (Keyboard shortcut: CTRL+SHIFT+S).</td>
</tr>
<tr>
<td>Merge Scene</td>
<td>Open a dialog box to merge a saved scene into the current one.</td>
</tr>
<tr>
<td>Commit Scene</td>
<td>Save the scene with a new name, and mark the scene as completed to allow filtering of completed scenes in the controller.</td>
</tr>
<tr>
<td>Commit Scene As</td>
<td>Save a committed scene under a new name (also marked as a completed scene.)</td>
</tr>
<tr>
<td>Close Scene</td>
<td>Close the current scene.</td>
</tr>
<tr>
<td>Import</td>
<td>Enable import of compacted 4Designer scenes (from a different system), Geometry 3D (FBX, OBJ), Mocha, PDF, Photoshop CS3, PowerPoint presentations, VRML objects, and SVG files from external applications.</td>
</tr>
<tr>
<td>NOTE:</td>
<td>For Photoshop CS3 an additional license is required.</td>
</tr>
<tr>
<td>Export</td>
<td>Collect all scene properties (such as Shape, material, textures, fonts, etc.) into one folder, ready for use on a different 4Designer system.</td>
</tr>
<tr>
<td>Quit</td>
<td>Close 4Designer.</td>
</tr>
<tr>
<td>Recent Scenes</td>
<td>List of the last ten scenes that were opened.</td>
</tr>
</tbody>
</table>
Edit Menu

**NOTE:**
The options in this menu have a dedicated toolbar.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Undo</strong></td>
<td>Undo the last editing action. (Keyboard shortcut: CTRL+Z).</td>
</tr>
<tr>
<td><strong>Redo</strong></td>
<td>Redo the last editing action. (Keyboard shortcut: CTRL+Y).</td>
</tr>
<tr>
<td><strong>Cut</strong></td>
<td>Cut an object from the scene to the clipboard. Can be pasted if required. (Keyboard shortcut: CTRL+X).</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td>Copy an object. The selected object, together with all stored information, is copied to the clipboard. (Keyboard shortcut: CTRL+C).</td>
</tr>
<tr>
<td><strong>Paste</strong></td>
<td>Insert the contents of the clipboard into the scene. (Keyboard shortcut: CTRL+V).</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Delete an object from the scene without copying it to the clipboard. (Keyboard shortcut: DEL).</td>
</tr>
<tr>
<td><strong>Find</strong></td>
<td>Open a dialog box to define a search for particular objects in your project. For a simple search, type the object name into the adjoining field, and press ENTER. For more information, see Using the Search Tool on page 43. (Keyboard shortcut: CTRL+F).</td>
</tr>
<tr>
<td><strong>Batch rename</strong></td>
<td>Open a dialog box to rename multiple objects in the Scene Tree. For more information, see Renaming Objects on page 58.</td>
</tr>
<tr>
<td><strong>Cleanup</strong></td>
<td>Remove properties from the scene that are not attached to a specific object, such as material and texture, to clear the Used Objects Gallery. (Keyboard shortcut: CTRL+R).</td>
</tr>
</tbody>
</table>

Animation Menu

**NOTE:**
Most options in this menu appear in the Animation Timeline.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Go to start</strong></td>
<td>Go to the beginning of the current animation group.</td>
</tr>
<tr>
<td><strong>Go to previous</strong></td>
<td>Go to the previous keyframe.</td>
</tr>
<tr>
<td><strong>Play</strong></td>
<td>Play the animation.</td>
</tr>
<tr>
<td><strong>Play back</strong></td>
<td>Play the animation from end to start.</td>
</tr>
<tr>
<td><strong>Continue</strong></td>
<td>Continue the animation from the current keyframe.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Stop</td>
<td>Stop the animation.</td>
</tr>
<tr>
<td>Finish loop and continue</td>
<td>Finish loop and continue the animation.</td>
</tr>
<tr>
<td>Go to next</td>
<td>Go to the next keyframe.</td>
</tr>
<tr>
<td>Go to end</td>
<td>Go to the end of the animation.</td>
</tr>
<tr>
<td>Create new animation group</td>
<td>Create a new group in the current animation.</td>
</tr>
<tr>
<td>Remove animation group</td>
<td>Remove an a group from the current animation.</td>
</tr>
<tr>
<td>Clone animation group</td>
<td>Clone a group in the current animation.</td>
</tr>
<tr>
<td>Mirror animation group</td>
<td>Reverse the sequence of the current animation group.</td>
</tr>
<tr>
<td>Next animation group</td>
<td>Jump to next animation group (when there are more than one group).</td>
</tr>
<tr>
<td>Previous animation group</td>
<td>Jump to previous animation group (when there are more than one group).</td>
</tr>
<tr>
<td>Create keys</td>
<td>Create keyframe.</td>
</tr>
<tr>
<td>Edit key</td>
<td>Edit keyframe.</td>
</tr>
<tr>
<td>Record</td>
<td>Start / Stop record.</td>
</tr>
<tr>
<td>Set start range</td>
<td>Set the start frame of the animation range (to the left of the Timeline in the Animation strip).</td>
</tr>
<tr>
<td>Set current frame</td>
<td>Select the current keyframe to display.</td>
</tr>
<tr>
<td>NOTE:</td>
<td>This field is not displayed if the timeline is set to use a timecode (see Miscellaneous on page 231).</td>
</tr>
<tr>
<td>Set end range</td>
<td>Set the end frame of the animation range (to the right of the Timeline in the Animation strip).</td>
</tr>
<tr>
<td>Jump</td>
<td>Use the SPACE bar to jump forward 10 frames on the timeline.</td>
</tr>
<tr>
<td>Set snap to frames</td>
<td>Select to set the animation timeline to Snap to Frames or clear to Snap to Fields (0, 0+, 1, 1+, etc.).</td>
</tr>
</tbody>
</table>
Menus and Toolbars

2. Getting Started

Tools Menu

<table>
<thead>
<tr>
<th>Alignment</th>
<th>Align the selected object to one of the following axes, relative to the design view, as required: Top, Vertical Center, Bottom, Left, Horizontal Center, Right.</th>
</tr>
</thead>
</table>

Controller | Open an internal Controller window to connect to an HDVG and simulate a scene as if controlled from an external controller. For more information, see Controller on page 50. |

Mirror | Create a mirror image for an object, and make the internal connections required to properly reverse the reflected objects. For more information, see Mirroring Objects on page 132. |

Pie Chart | Create a pie chart object with user defined segments and animations. |

Radial Array | Transform the selected object(s) into a radial array of identical objects. |

Rectangular Array | Transform the selected object(s) into a rectangular array of identical objects. |

Shaders | Open the Shader Generator dialog box to define your own shader for use. For more information, see Assigning a Shader to an Object on page 243. |

NOTE: The options in the first section of this menu have a dedicated toolbar.

Show Translation Manipulator | Activate the translation (positioning) manipulators for the selected object. |

Show Scale Manipulator | Activate the scaling manipulators for the selected object. |

Show Rotation Manipulator | Activate the rotation manipulators for the selected object. |

Show Text Manipulator | Activate the text manipulator for text objects. |

Show Selection Manipulator | Activate the selection manipulator for the selected object. |

Show Active Camera Manipulator | Activate the current camera (layer) manipulator. |
### Menus and Toolbars

<table>
<thead>
<tr>
<th>Show All Cameras Manipulator</th>
<th>Activate the manipulator for all cameras.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Camera Position</td>
<td>Save the current camera position before using the camera manipulators</td>
</tr>
<tr>
<td>Restore Camera position</td>
<td>Restore the camera position to the last saved camera position.</td>
</tr>
<tr>
<td>RenderEngine Connection</td>
<td>Open the <strong>RenderEngine Connection</strong> dialog box.</td>
</tr>
<tr>
<td>Dock RE Window</td>
<td>Dock the local RE window in place or undock as a free window.</td>
</tr>
<tr>
<td>Show Alpha</td>
<td>Show the alpha layer of the scene.</td>
</tr>
<tr>
<td>Show Normals</td>
<td>Select to show normals.</td>
</tr>
<tr>
<td>1 RE viewport</td>
<td>Display one viewport in the RE window.</td>
</tr>
<tr>
<td>2X2 RE viewport</td>
<td>Display 2X2 viewports in the RE window.</td>
</tr>
<tr>
<td>1+3 RE viewport</td>
<td>Display one expanded and three mini-viewports in the RE window.</td>
</tr>
<tr>
<td>Hide Bounding Boxes</td>
<td>Select to hide the object’s bounding boxes.</td>
</tr>
<tr>
<td>Lock Object</td>
<td>Lock all selected objects to prevent editing.</td>
</tr>
<tr>
<td>Unlock Object</td>
<td>Unlock all selected objects to allow editing.</td>
</tr>
<tr>
<td>Show selected object</td>
<td>Make all selected objects visible in scene.</td>
</tr>
<tr>
<td>Hide selected object</td>
<td>Hide all selected objects.</td>
</tr>
<tr>
<td>RE settings</td>
<td>Open the RenderEngine settings. For more information, see Setting Preferences on page 223.</td>
</tr>
<tr>
<td>Render image</td>
<td>Render a still image of the currently selected view to a user defined image file. (Keyboard shortcut: CTRL+I).</td>
</tr>
</tbody>
</table>
### Safe Areas

The safe area boundaries reflect the **Display Aspect** of the current video standard setting.

To set the current video standard, see *RenderEngine* on page 235 or select an option as required.

- **Safe Areas Off** - turn off the Safe area OSD.
- **Safe Areas 16/9** - display the 16/9 safe area boundaries (HD).
- **Safe Areas 4/3** - display the 4/3 safe area boundaries (SD).
- **Safe Areas Both** - display both the 16/9 and the 4/3 safe area boundaries.

### View Menu

#### Windows

Choose toolbars and windows from the list to display or hide as follows:

*NOTE:*

*The options in this menu have a dedicated toolbar.*

- **Scene Tree**
  
  Toggle the Scene Tree where all objects in your scene are displayed as a hierarchical list in their drawing order. The Scene Tree also displays object properties and other information. For more information, see *The Scene Tree: Managing Objects* on page 24.

- **Transformation Strip**
  
  Toggle controls for X,Y,Z axes where you can position, scale, or rotate objects, and toggle between parent and axis. For more information, see *The Transformation Strip* on page 27.

- **Assets**
  
  Toggle a range of elements such as objects, textures, materials, etc. that you select from to build your scene. For more information, see *The Assets Tab* on page 27.

- **Editor**
  
  Toggle the object editor to modify various properties. These include color, lighting, etc. For more information, see *The Assets Tab* on page 27.

- **Timeline**
  
  Toggle controls for playing and recording animations, advancing from frame to frame, etc. For more information, see *The Animation Strip* on page 179.

- **Properties**
  
  Toggle the Properties tab to show properties used in the scene, filtered in different ways. For more information, see *The Properties Tab* on page 28.

- **Advanced**
  
  Toggle the Advanced tab to show all available properties for an object. For more information, see *The Advanced Window* on page 133.

- **Connections**
  
  Toggle the connections between objects to connect or disconnect them. You can export parameters and apply mathematical functions here. For more information, see *Internal Connections* on page 169.

- **Triggers**
  
  Toggle the Triggers to set a trigger for actions to be executed. For more information, see *Triggers* on page 194.
<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stack</td>
<td>Toggle the Stack to edit properties. For more information, see The Stack on page 29.</td>
</tr>
<tr>
<td>Animation View</td>
<td>Toggle the Animation View for an advanced timeline view. For more information, see The Animation View on page 181.</td>
</tr>
<tr>
<td>Key Filter</td>
<td>Toggle the Key Filter to filter animation keys according to the required parameters. For more information, see Sorting Keys by Type on page 187.</td>
</tr>
<tr>
<td>Control Interface</td>
<td>Toggle the Control Interface to set the exports, animations and exposer options. For more information, see The Control Interface on page 29.</td>
</tr>
<tr>
<td>Animations Setup</td>
<td>Toggle the Animation Setup window to set play options. For more information, see Automatic Animation Rewind on page 192 and Filtering Keyframes on page 193.</td>
</tr>
<tr>
<td>Scene configure</td>
<td>Toggle the Scene Configuration to set options for scene settings, environment, and physics. For more information, see Scene Configuration on page 70.</td>
</tr>
<tr>
<td>Log</td>
<td>Toggle the 4Designer error log from the last editing session.</td>
</tr>
<tr>
<td>Mask</td>
<td>Toggle the Mask viewer to manage all masks within a scene. For more information, see Mask Options on page 78.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout</td>
<td>Select one of the following pre-programmed Main screen layout options (For more information, see Customizing the Main Screen on page 221 and Layout on page 225):</td>
</tr>
<tr>
<td>Load Layout</td>
<td>Load a previously saved layout of the main screen.</td>
</tr>
<tr>
<td>Save Layout</td>
<td>Save the current customized layout of the main screen.</td>
</tr>
<tr>
<td>Restore Layout</td>
<td>Restore the default program layout.</td>
</tr>
<tr>
<td>Scene Assembly</td>
<td>Display the layout tailored for scene authoring.</td>
</tr>
<tr>
<td>Scene Logic</td>
<td>Display the layout tailored for animation editing and triggers.</td>
</tr>
<tr>
<td>Animations</td>
<td>Display the layout tailored for general animations.</td>
</tr>
<tr>
<td>Load Control Interface Layout</td>
<td>Display the layout tailored for multiple viewports.</td>
</tr>
<tr>
<td>User</td>
<td>Display the layout tailored for dual monitors in a undocked view. By default this layout is similar to the Scene Assembly layout, but is intended to be changed for any purpose required.</td>
</tr>
<tr>
<td>Settings</td>
<td>Open the Settings window to configure the way 4Designer performs a wide range of actions. For more information, see Setting Preferences on page 223.</td>
</tr>
</tbody>
</table>
View

**Design** - display the objects in the scene as three-dimensional objects with shading, texture, lighting, etc. This view shows the final output of your scene. (Keyboard shortcut: CTRL+4).

**Top** - display the top view of the objects in the RE window, on the X and Z-axes. (Keyboard shortcut: CTRL+2).

**Front** - display the front view of the objects in the RE window, on the X and Y-axes. (Keyboard shortcut: CTRL+1).

**Left** - display the left view of the objects in the RE window, on the Y and Z-axes. (Keyboard shortcut: CTRL+3).

---

**Help Menu**

<table>
<thead>
<tr>
<th>Show Help</th>
<th>Open this manual in a web browser.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show me how</td>
<td>Open a list of tutorials that provide a guided tour of the new features in 4Designer.</td>
</tr>
<tr>
<td>Internet Forum</td>
<td>Open the 4Designer support forum in a web browser.</td>
</tr>
<tr>
<td>About</td>
<td>Displays 4Designer version information.</td>
</tr>
</tbody>
</table>
Creating a New Scene

You can create a new scene from scratch or base your new scene on an existing template. A template is a set of characteristics saved previously. Such characteristics include complex objects that you may have created and saved as a template, as well as textures, colors, cameras, and other elements.

To create a new scene:

1. Select File > New or +.
   The New Scene dialog box is displayed.

2. Select the Empty template (in Templates) to create a scene from scratch,
   -Or-
   Select a template to create a scene with previously edited parameters.

3. Click OK.
   A scene is created with one layer, containing an infinite light object, open in the Scene Tree.
To load a scene from an existing project:

1. Select **File > Open**.

   The **Open Scene** dialog box opens with list of existing projects and scenes:

   ![Open Scene dialog box](image)

   **TIP:**
   You can view the scenes in the window as a list (**Show List**) or as thumbnails (**Show Thumbnails**). In the list view, you can sort the scenes by date.

2. Select a project and then select a scene in the **Scene** window.
3. Click **OK**.

   The selected scene opens in 4Designer.
Saving a Scene

Scenes can be saved in a selected project folder or as a template.

▶ To save a scene:

1. Select File > Save.
The Save Scene dialog box opens.
2. In the Project list, select the folder in which you want to save the scene.
   
   **TIP:**
   You can create a new folder, remove or rename a folder; right-click within the list of projects.

3. If required, add a note under Description and select or clear Finish to mark the scene appropriately.
4. Type in a Scene Name and click OK.
The scene is saved.

▶ To set the scene’s thumbnail image:

1. In the RE window, arrange the scene as you want it to appear in the thumbnail image.
2. Open the Scene Configure window and show the Scene Settings tab.

   ![Scene Configure window](image)

3. Click Update preview with current view.

   The scene will be saved with a thumbnail image of the current view. The Create Preview on Scene Save check box is cleared so that the thumbnail you created manually is preserved when the scene is saved.
Deleting a Scene

To delete a scene from a project:

1. Click Open to display a list of projects and scenes in the Open Scene dialog box.
2. Right-click the scene that you want to delete.
3. Select Remove Scene.
   The scene is deleted.

Using the Search Tool

The Find dialog box allows you to search the current scene for particular objects or properties, based upon multiple parameters.

- Click Find or use the shortcut CTRL+F, to open the Find dialog box. From here, you can run an advanced search.

Finding Objects

To search by object name:
- Perform a search from the Find Object tab.

To find objects by property:
1. Select the Used properties check box.
2. Use the drop-down lists to select the property and the parameter to find.
3. Click Advanced to display and search another level of objects that refer to other objects.
To find objects by additional parameters:

1. Select the **Active parameter options** check box.
2. Choose to find **ANY** or **ALL** of the selected parameters.
3. Select the parameters to find using the respective check boxes.

💡 **TIP:**
You can define both Properties and Additional parameters for a search.

4. Finally, choose to **Select**, **Add to Selection** or **Remove from Selection** each of the objects for which you want to search.

Finding Text

To search for text string:

- Perform a search from the **Text** tab.

![Find dialog box](image)
4Designer HDVG Video Output

When the 4Designer authoring station is connected to an HDVG, 4Designer can display the scene using the SDI video output while you create it. The video output is viewed on a separate monitor, showing the combined view from all cameras. You can click on any layer in the hierarchy, and from the camera property editor tab, you can change the camera’s view. All changes made to the scene are displayed in the video output in real time (Requires an HDVG for visualization).

Each camera in a scene functions as a separate layer with its own three-dimensional space. A camera can only control the view of objects that are placed within its layer. This allows the creation of complex scenes with multiple camera animations that affect only a particular subset of objects.
Manipulators

The Manipulators are a visual and interactive tool used for changing an object’s Transformation parameters in the RE window. Use them to directly position, scale and rotate objects.

➤ To open and use the manipulators:

1. Right-click an object in the RE window, or use the icons in the sidebar.
   The Manipulator menu is displayed, context sensitive for different object types.

2. Right-click the required option as follows:

<table>
<thead>
<tr>
<th>Select</th>
<th>Switch to selection mode. (In effect, this turns the manipulators off.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Translation</td>
<td>Position the object along the XYZ axes.</td>
</tr>
<tr>
<td>Rotation</td>
<td>Rotate the object along the XYZ axes.</td>
</tr>
<tr>
<td>Scale</td>
<td>Scale the object along the XYZ axes.</td>
</tr>
<tr>
<td>Text</td>
<td>Available for text objects only. Allows entering text directly in RE window, and also cutting, copying, and pasting.</td>
</tr>
<tr>
<td>Camera</td>
<td>Available in all views but design view. Allows you zoom the view in or out, and to change camera position. When selected, the middle mouse button functions as follows:</td>
</tr>
<tr>
<td></td>
<td>• When pressed, moving the mouse will move the view port vertically / horizontally.</td>
</tr>
<tr>
<td></td>
<td>• If the button is a roller, you can roll to zoom in / out.</td>
</tr>
<tr>
<td></td>
<td>• If the button is not a roller, hold the CTRL key while pressing the middle mouse button, and the viewport will zoom in/out.</td>
</tr>
</tbody>
</table>
### Manipulators

<table>
<thead>
<tr>
<th><strong>Show Active Camera manipulator</strong></th>
<th>Click to move the active camera angle.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show All Camera manipulator</strong></td>
<td>Click to move all camera angles together.</td>
</tr>
<tr>
<td><strong>Tools</strong></td>
<td>Switch RE to work in touch screen mode (even when the mouse is used to simulate touch-screen function).</td>
</tr>
<tr>
<td><strong>Coordinates System</strong></td>
<td>Click to open the local, parent, screen, and world options.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Local</strong></th>
<th>Uses the object’s own coordinates to transform the object. (Same as using parent mode in the transformation strip/tab).</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parent</strong></td>
<td>Uses the coordinates of the parent object (like a group). If there is no parent object, this is the same as World mode.</td>
</tr>
<tr>
<td><strong>Screen</strong></td>
<td>Transforms the object relative to the screen, regardless of camera position or of any local transformation.</td>
</tr>
<tr>
<td><strong>World</strong></td>
<td>Transforms the object relative to the origin of the scene (0, 0, 0).</td>
</tr>
</tbody>
</table>

The manipulators are displayed on the object.

- **Red** handle—X Axis
- **Green** handle—Y axis
- **Blue** handle—Z axis

3. Drag the handles in the RE window to transform the object as required.
   You can click an area between handles to transform the object on two axes.
4. Click an area in the RE window, off the object, to hide the manipulators.
   To show the manipulators again, click the object.
Extension Buttons

Many of the parameters in the Editor have extension buttons next to them. Extension buttons enable you to connect parameters to dynamic actions within your scene. For example, you can attach a parameter value to an animation key frame, so when the key frame is played, the parameter is activated.

To attach an action to a parameter:

1. After specifying the parameter’s values in the Editor, click the extension button beside it.
   A menu is displayed.
2. Select the required menu option:

<table>
<thead>
<tr>
<th>Extension Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Channel</td>
<td>Display the animation channel associated with the parameter (if existing) in the Animation window.</td>
</tr>
<tr>
<td>Create Channel</td>
<td>Create a new animation channel to use for keyframes associated with the parameter. This channel is displayed in the Animation window.</td>
</tr>
<tr>
<td>Remove Channel</td>
<td>Remove the animation channel associated with the parameter.</td>
</tr>
<tr>
<td>Set Key</td>
<td>Set a keyframe in the animation timeline for the currently selected parameter.</td>
</tr>
<tr>
<td>Edit Key</td>
<td>Open the Key Editor dialog box.</td>
</tr>
<tr>
<td>Remove Key</td>
<td>Remove keyframe from the animation timeline for the currently selected parameter.</td>
</tr>
<tr>
<td>Create Export</td>
<td>Opens the Connections dialog box to associate the parameter with external input to control the parameter values in real time. For more information, see Exporting Parameters for Real-time Manipulation on page 168</td>
</tr>
<tr>
<td>Remove Exports</td>
<td>Enabled only if an export was created for the object. Remove exports for the current parameter.</td>
</tr>
<tr>
<td>Out Connection</td>
<td>Open the Connections dialog box to define the dependent parameter value (out connection) associated with the parameter. For more information, see Internal Connections on page 169.</td>
</tr>
<tr>
<td><strong>In Connection</strong></td>
<td>Open the <strong>Connections</strong> dialog box to define the independent variable value (in connection) associated with the parameter. For more information, see <em>Internal Connections</em> on page 169.</td>
</tr>
<tr>
<td><strong>Create Exposer</strong></td>
<td>Expose a value inside RenderEngine/4Designer to the controllers, making the value open to queries.</td>
</tr>
<tr>
<td><strong>Remove Exposer</strong></td>
<td>Delete an exposed value.</td>
</tr>
<tr>
<td><strong>Function</strong></td>
<td>Open the <strong>Connections</strong> dialog box to define a function expression that regulates the parameter value. For more information, see <em>Using Functions</em> on page 170.</td>
</tr>
<tr>
<td><strong>Create Trigger</strong></td>
<td>Set an animation time or interaction to trigger an action for the selected property. For more information, see <em>Triggers</em> on page 194.</td>
</tr>
<tr>
<td><strong>Edit Trigger</strong></td>
<td>Open the Triggers window to the selected property for editing. For more information, see <em>Triggers</em> on page 194.</td>
</tr>
<tr>
<td><strong>Reset to Defaults</strong></td>
<td>Reset the parameter values to their default setting.</td>
</tr>
</tbody>
</table>
Controller

4Designer has a basic internal Controller that can be used to connect to an HDVG and simulate a scene as if controlled from an external controller, or connect to any running instance of RenderEngine (except the local host).

To use the Controller:

1. Select Tools > Controller.
   The Controller window is displayed.

2. Type in the required HDVG Host name or IP, and click Connect.
3. Click Load to select a scene (or scenes) to load.
   Loaded scenes are listed under Scenes.
4. Select a scene to display its exports and exposers; set values by selecting an export or exposer, type values in the Set Value field, and click Set Value.
5. Click Activate to activate the scene.
6. Select an animation and click Play to play an animation group.
3. Creating a Scene

In this section:

- *Adding Objects to a Scene* on page 52
- *New complex objects: Line Charts* on page 55
- *Global Tabs* on page 60
- *Scene Configuration* on page 70
Adding Objects to a Scene

Once you have created a scene (see Creating a New Scene on page 40), you can begin to design the graphics to display in the scene. Primitive Objects and Complex Objects are available in the Assets tab. Each item can be dragged to a scene and then modified, as required.

To add an object to the scene:

1. Select any object available in the Assets tab.
2. Drag the object to an existing layer in the Scene tree or RE window.

Now you can edit the object properties as required. Objects dragged from the Assets tab have default names. Rename them in the Scene tree, using unique and unambiguous names (for easy identification later).

Primitive Objects

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flat Layer</td>
<td>Add an orthogonal flat layer to the scene ideal for two dimensional graphics. For more information, see Cameras on page 62.</td>
</tr>
<tr>
<td>Free Layer</td>
<td>Add a free layer camera to the scene. Provides a full three-dimensional view of a scene and can be manipulated directly. For more information, see Cameras on page 62.</td>
</tr>
<tr>
<td>Perspective Layer Camera</td>
<td>Add a perspective layer camera. This is a free layer camera that can receive external tracking information (4Designer Advanced). For more information, see Cameras on page 62.</td>
</tr>
<tr>
<td>Group</td>
<td>Group objects are containers that hold various objects to allow modification of all objects in the group. For more information, see Working with Groups on page 59 and New complex objects: Line Charts on page 55.</td>
</tr>
<tr>
<td>Text</td>
<td>Add a text object to the scene. The text content is defined as described in Working with Text on page 142.</td>
</tr>
<tr>
<td>Rectangle</td>
<td>Add a 2D rectangle object to the scene. For more information, see Object Properties: Rectangles, Gradients, and Video Textures on page 86.</td>
</tr>
<tr>
<td>Super Tetragon</td>
<td>Add a 2D super tetragon object with options for rounded corners and a cutout section to the scene. Object Properties: Super Tetragons on page 86.</td>
</tr>
<tr>
<td>Super N-gon</td>
<td>Add a 2D super n-gon object to the scene. You can set the number of vertices on the N-gon circumference, enabling you to create any 2D polygon object required, as well as a cutout section. For more information, see Object Properties: Super N-gons on page 87.</td>
</tr>
</tbody>
</table>
### Adding Objects to a Scene

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Disk</strong></td>
<td>Add a 2D disk object to the scene. For more information, see <em>Object Properties: Disks</em> on page 89.</td>
</tr>
<tr>
<td><strong>Cube</strong></td>
<td>Add a 3D cube object to the scene. For more information, see <em>Object Properties: Cubes</em> on page 89.</td>
</tr>
<tr>
<td><strong>Super Cube</strong></td>
<td>Add a 3D super cube object to the scene. For more information, see <em>Object Properties: Super Cubes</em> on page 89.</td>
</tr>
<tr>
<td><strong>Sphere</strong></td>
<td>Add a 3D sphere object to the scene. For more information, see <em>Object Properties: Spheres</em> on page 90.</td>
</tr>
<tr>
<td><strong>Cylinder</strong></td>
<td>Add a 3D cylinder object to the scene. For more information, see <em>Object Properties: Cylinders and Cones</em> on page 90.</td>
</tr>
<tr>
<td><strong>Cone</strong></td>
<td>Add a 3D cone object to the scene. For more information, see <em>Object Properties: Cylinders and Cones</em> on page 90.</td>
</tr>
<tr>
<td><strong>Rotary</strong></td>
<td>Add a 3D rotary object to the scene. For more information, see <em>Object Properties: Rotaries</em> on page 91.</td>
</tr>
<tr>
<td><strong>Spline</strong></td>
<td>Add a 3D construction spline to the scene that can be used as a shape or as a path for animated sequences. Additional segments/control points can be added, or removed in the Path editor. The easiest way to position control points is to use the manipulator handles in the RE window. For more information, see <em>Object Properties: Splines</em> on page 91 and <em>Editing a Path</em> on page 205.</td>
</tr>
<tr>
<td><strong>Extrusion</strong></td>
<td>Add a 3D extruded object to the scene. For more information, see <em>Object Properties: Extrusions</em> on page 91.</td>
</tr>
<tr>
<td><strong>Beveled cut-out</strong></td>
<td>Add a 3D beveled object to the scene. This object has a Cut editor available for changing its cross section. For more information, see <em>Object Properties: Beveled Cut-Outs</em> on page 92.</td>
</tr>
<tr>
<td><strong>Paper Roll</strong></td>
<td>Add a 3D paper roll object to the scene. This object can be animated to appear as though it is being unrolled. For more information, see <em>Object Properties: Paper Rolls</em> on page 92.</td>
</tr>
</tbody>
</table>
Adding Objects to a Scene

**Ticker**
Add a ticker object that presents data in a horizontally or vertically moving display. The ticker is a container with unique properties, that holds objects that are the repeatable content of the ticker. Content can be updated continuously. For more information, see *Ticker Objects* on page 157.

**Clock**
Add a clock object to the scene. Time is taken from the system clock or from the HDVG when working remotely. For more information, see *Clock Objects* on page 159.

**Text Deco**
Add a text object with decoration presets to a scene. For more information, see *Working with Text* on page 142.

**Gradient**
Add a 2D rectangle object with a preset color gradient to the scene. For more information, see *Object Properties: Rectangles, Gradients, and Video Textures* on page 86.

**Video Texture**
Add a 2D rectangle object with an applied video texture to the scene. For more information, see *Video Textures* on page 118 and *Object Properties: Rectangles, Gradients, and Video Textures* on page 86.

**Infinite Light**
Add a diffused light object to the scene. You can determine the light position and rotation in the RE window. Lights are connected to materials in the *Color* tab in the Editor. Other light parameters are defined in the *Light* tab. For more information, see *Lighting* on page 128.

**Point Light**
Add a point light object to the scene. For more information, see *Lighting* on page 128.

**Spot Light**
Add a spotlight object to the scene. For more information, see *Lighting* on page 128.

**Countdown Clock**
Add a countdown clock object to the scene, that displays a countdown to any set point in time. For more information, see *Countdown Clock* on page 162.

**NOTE:**
4Designer can process imported mesh shapes that don’t exist as primitive objects in 4Designer and external mesh shapes that use a dynamically loaded VRML file (to create an export and then change the object during production).
Complex Objects

Complex objects are imported objects or objects that are built up of primitive objects. You can use the complex objects that are provided (bell, teapot, analog clock, compound shapes), or you can create your own by creating Group objects and assigning them properties.

To add a complex object to the Assets tab:

- After placing all required primitives in a group (or importing an object), drag the group object from the Scene tree into the Complex Objects library in the Assets tab. The object appears in the strip. When you add the object to the strip, it becomes part of the current library and is available for use in other scenes.

New complex objects: Line Charts

The Line Charts are complex objects, which can be used to visualize the value of something over time. 4Designer provides five examples of Line Chart objects:

- Line Chart
- Line Chart 2
- Combo chart
- Area chart
- Labels at points

Charts are manipulated by Data Series, which drive object sets implemented with Array containers. To achieve the graph design, the Chart Grid, Geometry Creator, and Chart Label geometries are used.

To add a Line Chart object:

- From the Assets tab, select a Line Chart object, and drag it into the Preview window or the Scene tree.

To modify the data of the chart, the Data Series element needs to be altered. Data can be changed one by one, or the whole series can be updated by inserting Coma Separated Values into the 0 cell of the Data Serie A row.
To modify the Data Series of a Line Chart:

- Select the **Array** container in the Scene tree. In the **Editor**, select the **Array** tab to display its properties. The Data Series values can be changed in the **Data** section.

or

- Go to **View > Windows > Control Interface** to open the Control Interface. The Control Interface gathers all scene items which are available during controlling (exports, animations, exposers).

For more information on how to modify the design elements of the charts, see **Line Charts Design** on page 254.

Copying Object Properties

You can copy properties between objects in the Scene tree. For example, you can copy color properties from one object to another.

To copy properties between objects:

- Click and drag the required property icon (of the source object) from its column to the respective column of the target object.
When you right-click any property in the Scene Tree, a menu is displayed with appropriate choices dependent on the icon that you clicked.

<table>
<thead>
<tr>
<th>Aid</th>
<th>Available for masks, to allow masking options for the object.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New [property]</strong></td>
<td>Create a new object property according to the type of property selected, i.e., New Transformation, New Color, New Texture.</td>
</tr>
<tr>
<td><strong>Rename</strong></td>
<td>Make the property name editable for renaming (type the required name, then ENTER).</td>
</tr>
<tr>
<td><strong>Separate [property]</strong></td>
<td>If the property is derived from another object by copying objects, it is disconnected and both properties become unique. This action is only available over icons which indicate that it is a copied object.</td>
</tr>
<tr>
<td><strong>Unrefer [property]</strong></td>
<td>Unrefer the property from the current object so that the property is not linked to another object, but still available in the Properties tab.</td>
</tr>
<tr>
<td><strong>Remove [property]</strong></td>
<td>Remove the current property from the object, and from the property pool.</td>
</tr>
</tbody>
</table>
Renaming Objects

To rename objects in the Scene Tree:
- Right-click the object name in the Scene Tree and select Rename.
  Or-
- Select the object, and press F2.

You can also rename multiple objects in the Batch rename dialog box.

To rename multiple objects:
1. In the Scene Tree, select the objects to rename.
2. In the Batch rename dialog box, type in the Old name of the object(s) or leave * to rename all objects.
3. Type in the New name, as required.
4. Select the renaming method from the Type list.
5. Select or clear the required options, and click OK.

The selected objects are renamed as specified.

For more information, see New complex objects: Line Charts on page 55 and Customizing the Scene Tree on page 222.
Working with Groups

Object and property grouping enables creating complex objects. Transformations, color, textures, and animations can then be applied to the whole group at once.

To create a group:

- From the Primitives tab in Assets, drag the Group icon to the Scene tree or the RE Window, and drag existing objects into the Group so that they are nested below.
  -or-
  Select the objects that you want to group in the Scene Tree, right-click and select Group Containers (or CTRL+G).

A group is marked in the RE window by a green bounding box, as in the following example.

You can apply properties to the entire group to affect all of the objects simultaneously. For example, you can specify Transformation parameters for the group that apply to all of the objects in the group. Or, you can resize or rotate the group or specify a texture to apply to all objects in the group. Group properties do not overwrite individual object properties that you set. For example, assigning a color to the entire group assigns a default color, but does not override colors assigned to individual objects.

Any object can function as a group. Transfer objects to the object that you want to act as a group in the Scene tree to create an object with child-objects.

To expand and contract the groups in the Scene tree, click expand (+ sign) or shrink (- sign) next to the group name. Right-click to display a menu that allows you to edit the group by expanding, shrinking, removing objects and other functions.

When you delete a group with the Remove option, only the group object is removed, and all child objects are moved up in Scene tree. If you want to delete the group completely, use Delete.
Global Tabs

When a Layer is selected in the Scene tree, three tabs are available in the Editor:

- **Layers** on page 60
- **Cameras** on page 62
- **Depth Buffer** on page 68

These tabs define properties that apply to your entire layer, rather than to a specific object, or set the default for certain properties, inherited by objects.

Layers

In the Layer editor, you determine whether the layer is **Visible** (the layer’s objects are displayed) or not. You can also **Lock** the layer for editing.

Under **Blending**, you can set the default blending mode for the layer, that is inherited by each object in the layer, unless changed per object. For more information, see *Blending Objects* on page 75.

<table>
<thead>
<tr>
<th>Visible</th>
<th>When selected, all objects in the layer are displayed. When cleared, all objects in the layer are hidden (with the exception of Light objects).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock</td>
<td>When selected, you cannot edit translation or rotation of all objects in the layer, using the manipulators.</td>
</tr>
<tr>
<td>Current grid</td>
<td>Select the grid to which the layer refers. A grid must be added to the scene as an object (as a helper in the Scene Tree, or from the Misc tab in the Assets).</td>
</tr>
</tbody>
</table>
### Rendering Mode

Set the way RE renders the objects in the Scene tree:

- **Sorted** (default) - non-transparent (fully opaque, RGB) objects are rendered according to their position in the Scene tree, and then transparent objects (and opaque objects with textures that contain alpha values equal to 1) are rendered, according to their position in the Scene tree.

  Objects with image or video textures are considered opaque, unless the video or image contain an alpha channel.

  Mask objects, not drawn in color, are considered opaque if their alpha value is set to 1.

- **Hierarchical** - All objects, regardless of their opacity, are rendered according to their position in the Scene tree. (This allows compatibility with scenes authored in older versions of 4Designer. Opaque, motion blur, transparent - objects are rendered (displayed) in this order. Opaque objects are displayed first, before objects that have Motion blur applied, and then transparent objects, for more accurate rendering. (System performance may be affected.)

  Opaque, transparent, motion blur - objects are rendered (displayed) in this order. Opaque objects are displayed first, before transparent objects and then objects that have Motion blur applied, for more accurate rendering. (System performance may be affected.)

### Opaque order

When one of the Opaque-first modes is selected, set the order in which the opaque objects are rendered;

- **Hierarchical** - from top to bottom, as listed in the Scene Tree.
- **Front to back** - from the closest object to the camera to the farthest object from the camera.

### Transparent order

When one of the Opaque-first modes is selected, set the order in which the transparent objects are rendered;

- **Hierarchical** - from top to bottom, as listed in the Scene Tree.
- **Back to front** - from the back of the scene to the front, so that successive layers of transparency are rendered to look through an object to see the one behind it.

- **Order independent** - transparent objects are rendered first, then opaque objects are rendered and blended by RenderEngine. This setting could affect performance.

### Draw in Color

Control the image color in the HDVG output, generally used for masks.

- When marked “”, the layer inherits its draw setting from the scene.
- When selected, the layer is always shown in color. When cleared, the layer is hidden.

### Draw in Key

Control key drawing in the HDVG output, enabling alpha output for a layer.

- When marked “” the layer inherits its draw setting from the scene.
- When selected, the layer is always displayed. When cleared, the layer is hidden.
Cameras provide a view of the scene according to the way the camera is positioned. The Camera editor allows you to create a camera for the layer and set its properties. You can create four types of cameras: **Flat Layer**, for orthogonal flat layers ideal for two dimensional graphics, **Free Layer** for a full three-dimensional scene view and direct manipulation, **Perspective Layer** for working with external tracking data, and **Window Camera** for working with a video wall. A layer can have multiple container cameras that allow you to view the same scene from different camera angles.

### To create a layer:

- Drag the required layer type object from the Primitives tab to the Scene tree.

Orthogonal cameras are also called Flat Layers in the Primitives tab. They are used to provide a two dimensional view of a scene.

A Free Layer camera provides a full three dimensional view of a scene and can be manipulated directly.

Perspective layer cameras also have a full three-dimensional view of the scene, but tracking data from an external tracking device can control their properties.
A Window camera allows you to define video wall geometry.

A camera’s parameters vary according to the type of camera. For more information, see:

- *Flat/Orthogonal Camera Layer* on page 63
- *Free Layer Camera* on page 64
- *Perspective Layer Camera* on page 66
- *Window Camera* on page 67

Flat/Orthogonal Camera Layer

<table>
<thead>
<tr>
<th>Viewing</th>
<th><strong>Height</strong> - The height of the screen in RE units. <strong>Aspect</strong> - aspect ratio of the camera.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clipping</td>
<td><strong>Near</strong> - set the near clipping plane for the camera. Nothing is drawn between the camera and this clipping plane. <strong>Far</strong> - set the far clipping plane for the camera. This defines the 'horizon' of the scene, i.e., the camera range.</td>
</tr>
<tr>
<td>Position</td>
<td>Define camera location along the X, Y, and Z-axes to specify camera position.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Adjust the angle between the camera and the point of interest. <strong>Pan</strong> is the degree of horizontal angle, <strong>Tilt</strong> is the degree of vertical angle, and <strong>Twist</strong> is the degree of rotation on the Z-axis.</td>
</tr>
</tbody>
</table>
### Free Layer Camera

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Vertical FOV</strong></td>
<td>Set the vertical FOV in degrees.</td>
</tr>
<tr>
<td><strong>Aspect</strong></td>
<td>Set the aspect ratio (horizontal to the Vertical FOV) for the camera.</td>
</tr>
<tr>
<td><strong>Near</strong></td>
<td>Set the near clipping plane for the camera. Nothing is drawn between the camera and this clipping plane.</td>
</tr>
<tr>
<td><strong>Far</strong></td>
<td>Set the far clipping plane for the camera. This defines the 'horizon' of the scene, i.e., the camera range.</td>
</tr>
<tr>
<td><strong>Position</strong></td>
<td>Define camera location along the X, Y, and Z-axes to specify camera position.</td>
</tr>
<tr>
<td><strong>Orientation</strong></td>
<td>Adjust the angle between the camera and the point of interest. <strong>Pan</strong> is the degree of horizontal angle, <strong>Tilt</strong> is the degree of vertical angle, and <strong>Twist</strong> is the degree of rotation on the Z-axis.</td>
</tr>
<tr>
<td><strong>Use Tracking</strong></td>
<td>Set the layer camera to receive tracking data from a real studio camera or from a tracking file; used for virtual studios.</td>
</tr>
<tr>
<td><strong>Update camera from tracking</strong></td>
<td>Update the camera tracking data when tracking data is connected. This is used when scene logic is dependent on camera parameters.</td>
</tr>
<tr>
<td><strong>Tracking file</strong></td>
<td>Reference a camera tracking file to preview changing camera paths, and export the path to the Controller application. For more information, see <em>Using a Tracking File</em> on page 134.</td>
</tr>
</tbody>
</table>
Isometric Camera

**Viewing**
- **Height** - The height of the screen in RE units.
- **Aspect** - Aspect ratio of the camera.

**Position**
Define camera location along the X, Y, and Z-axes to specify camera position.

**Axis projection**
Set the projection type to one of the available presets: Isometric, Dimetric, Trimetric, Military, Cavalier, Top-Down, Custom. To find out about the differences between these presets, see Isometric camera - preview of the available presets on page 259.

**Clipping**
Set the far clipping plane for the camera. This defines the 'horizon' of the scene, i.e., the camera range.

**Orientation**
Adjust the angle between the camera and the point of interest. **Pan** is the degree of horizontal angle, **Tilt** is the degree of vertical angle, and **Twist** is the degree of rotation on the Z-axis.
Perspective Layer Camera

**Vertical FOV**  Set the vertical FOV in degrees.

**Aspect**  Set the aspect ratio (horizontal to the Vertical FOV) for the camera.

**Near**  The clipping planes define the virtual area in which objects are visible to the camera. Set the near clipping plane for the camera. Nothing is drawn between the camera and this clipping plane.

**Far**  Set the far clipping plane for the camera. This defines the ‘horizon’ of the scene, i.e., the camera range.

**Roll**  Set the roll angle of the camera in degrees (on the Z axis).

**Position**  Specify the X, Y, Z coordinates of the camera.

**Target**  Specify the X, Y, Z coordinates of the object of interest.

**Position Run**  Allows you to connect the camera position to a path in the scene. The position of the camera changes as it moves along the path. The target remains fixed in position unless it is connected to a path.

**Target Run**  The camera target is the position on which the camera is trained. This parameter allows you to connect the camera target to a path in the scene. If the camera position is not connected to a path, then it remains in place with the view from the camera following the target as it moves along the path.

**Use Tracking**  Allows the layer camera to receive tracking data from a real studio camera; used for virtual studios.

**Update camera from tracking**  Update the camera tracking data when tracking data is connected. This is used when scene logic is dependant on camera parameters.

**Tracking file**  Reference a camera tracking file to preview changing camera paths, and export the path to the Controller application. For more information, see *Using a Tracking File* on page 134.
Window Camera

The Window Camera provides users of flat video walls and camera tracking with a way to create the illusion of depth in the video wall when the camera is moving in front of it.

Change an existing camera in the Scene Tree to a Window camera by right-clicking the layer's Camera column and selecting New Camera > Window Camera. The following option are displayed in the Camera editor:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upper left point X/Y/Z</td>
<td>Set the position of the upper left corner of the screen array.</td>
</tr>
<tr>
<td>Bottom left point X/Y/Z</td>
<td>Set the position of the bottom left corner of the screen array.</td>
</tr>
<tr>
<td>Bottom right point X/Y/Z</td>
<td>Set the position of the upper right corner of the screen array.</td>
</tr>
<tr>
<td>Clipping</td>
<td>Set near clipping automatically - select this option to set the near clipping plane automatically or clear to use the clipping plane parameter specified below. <strong>Near</strong> - set the near clipping plane for the camera. Nothing is drawn between the camera and this clipping plane. <strong>Far</strong> - set the far clipping plane for the camera. This defines the 'horizon' of the scene, i.e., the camera range.</td>
</tr>
</tbody>
</table>
Depth Buffer

The Depth Buffer editor allows you to set the visibility of layers in the scene, relative to other layers.

<table>
<thead>
<tr>
<th><strong>Compare Depth Function</strong></th>
<th>Set how a layer is displayed in relation to other layers in the scene, as described below;</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Inherit</strong></td>
<td>Depth buffering settings are inherited from the scene. Scene is always set to Less Equal, and cannot be changed.</td>
</tr>
<tr>
<td><strong>Never</strong></td>
<td>The objects in the layer are never displayed.</td>
</tr>
<tr>
<td><strong>Less</strong></td>
<td>The layer is always visible. If layer position in the Scene tree is lower than other layers, then:</td>
</tr>
<tr>
<td></td>
<td>• The layer is displayed in front of other layers when its Z-position is greater than the Z-position of other objects.</td>
</tr>
<tr>
<td></td>
<td>• The layer is displayed in back of other layers when its Z-position is identical to or less than the Z-position of other objects.</td>
</tr>
<tr>
<td></td>
<td>If layer position in the Scene tree is higher than other layers, then:</td>
</tr>
<tr>
<td></td>
<td>• The layer is displayed in back of other layers, regardless of its Z-position.</td>
</tr>
<tr>
<td><strong>Less Equal</strong></td>
<td>The layer is always visible, as described for the <strong>Less</strong> setting, with the following exception:</td>
</tr>
<tr>
<td></td>
<td>If layer position in the Scene tree is lower than other layers, and its Z-position is identical to the Z-position of other layers, then the layer is displayed in front of other layers.</td>
</tr>
<tr>
<td><strong>Greater</strong></td>
<td>The layer is visible only in front of other layers, and only in other layer's display area, when all the following conditions are met:</td>
</tr>
<tr>
<td></td>
<td>• The layer's (X,Y) position overlaps other layers.</td>
</tr>
<tr>
<td></td>
<td>• Layer position in the Scene tree is lower than the place of other layers, and–</td>
</tr>
<tr>
<td></td>
<td>• The layer's Z-position is less than the Z-position of other layers.</td>
</tr>
<tr>
<td></td>
<td>In all other cases, the layer is not visible.</td>
</tr>
<tr>
<td><strong>Greater Equal</strong></td>
<td>The layer is displayed as described for the <strong>Greater</strong> setting, and is also visible when the layer's Z-position is identical to the Z-position of other layers.</td>
</tr>
</tbody>
</table>
| Equal | The layer is visible only in front of other layers, and only in other layer's display area, when all the following conditions are met:  
• The layer's (X,Y) position overlaps other layers.  
• Layer position in the Scene tree is lower than other layers, and–  
• The layer's Z-position is identical to the Z-position of other layers.  
In all other cases, the layer is not visible. |
|---|---|
| Not Equal | The layer is always visible.  
If the layer position in the Scene tree is lower than other layers, then:  
• The layer is displayed in back of other layers when its Z-position is identical to the Z-position of other layers.  
• If the Z-position is not identical, then the layer is displayed in front of other layers.  
If layer position in the Scene tree is higher than the place of other layers, then:  
• The layer is displayed in back of other layers, regardless of its Z-position. |
| Always | The layer is always visible.  
If layer position in the Scene tree is lower than other layers, then:  
• The layer is displayed in front of other layers.  
If layer position in the Scene tree is higher than other layers, then:  
• The layer is displayed in back of other layers. |
| Draw in depth | When marked “”, the layer inherits its setting from the scene. When selected, the layer is always shown in color, when cleared the layer is not shown, both regardless of the scene setting. |
| Clear | When selected, information regarding the Z axis is not considered between the current layer and the next layer in the Scene tree hierarchy, so that each layer is rendered independently. When cleared, the scene retains the relativity between layers for rendering. |
Scene Configuration

Configure various scene settings in the Scene Configuration dialog box, as described in the following sections.

Scene Settings

<table>
<thead>
<tr>
<th>Enable scene caching</th>
<th>Select this option to save all resources used in the scene to the system, when scene is saved.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Separated RE cache at save</td>
<td>Select the elements to be cached in RenderEngine when the scene is saved.</td>
</tr>
<tr>
<td>Aspect ratio</td>
<td>Set the aspect ratio of the scene.</td>
</tr>
<tr>
<td>Behavior of RE when different aspects</td>
<td>Set RE behavior when the scene aspect is different from the aspect set for the HDVG.</td>
</tr>
<tr>
<td>Keep aspect backwards compatibility</td>
<td>Preserve aspect for scenes imported from 3Designer.</td>
</tr>
<tr>
<td>Texture compression</td>
<td>Set the texture compression to apply to textures used in the scene.</td>
</tr>
<tr>
<td>Antiflicker filter strength</td>
<td>Set the strength of the antiflicker filter used for video inserts.</td>
</tr>
<tr>
<td>Description</td>
<td>Add a textual description for the scene.</td>
</tr>
<tr>
<td>Scene preview</td>
<td>See Saving a Scene on page 42.</td>
</tr>
</tbody>
</table>
Environment Settings

Set the scene background in the Environment tab. You can add a background color, image, or texture. Click Remove Environment to use no environment at all or Reset to default to undo.

NOTE:
Previously (in 3Designer), this property was a layer property. In 4Designer it is a scene property that isn't applied to any one layer. Settings and capabilities are the same.

Physics Tab

For information on using the Physics tab, see Activating Physics on page 213.
4. Designing Your Graphics

In this section:

- Setting Visibility on page 73
- Setting Drawing Options on page 74
- Blending Objects on page 75
- Motion Blur on page 76
- Notes on page 77
- Using the Bounding Box on page 77
- Mask Options on page 78
- Object Placement and Size on page 81
- Defining Shapes and Geometry on page 85
- Setting Colors and Materials on page 99
- Applying Textures on page 103
- Lighting on page 128
- Shadows on page 129
- Mirroring Objects on page 132
- The Advanced Window on page 133
- Applying Properties from the Properties Tab on page 133
- Using a Tracking File on page 134
- Depth Buffer on page 135
- Adding Particles to a Scene on page 138
Setting Visibility

You can control the visibility of each object in the scene, or the visibility of objects in a group. Visible objects are displayed in a scene. Objects that are hidden can be used for reference by other objects. For example, when using a spline to define an object’s animation path. Objects can also be hidden and displayed in the course of an animation. Visibility parameters can be exported for use in a Controller.

There are a number of ways to set visibility.

To set object/group visibility:

- Toggle the Visibility icon in the Scene tree.
- Select Visible in the Object editor.

Define the visibility of objects or groups in the scene using the additional properties in the Object editor:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visible</td>
<td>Show or hide an object.</td>
</tr>
<tr>
<td>Lock</td>
<td>Select Lock to protect an object from editing.</td>
</tr>
<tr>
<td>Fade in/out time</td>
<td>Set the fade in and fade out time for an object or group of objects within the animation timeline. Time is defined in seconds. This effect is seen in the animation when the state of the Visible parameter is changed.</td>
</tr>
<tr>
<td>Visibility</td>
<td>Control the transparency of the object/group; 1.0 is fully opaque, 0.0 is fully transparent. This is useful especially for changing the visibility of a group containing objects with different alpha values.</td>
</tr>
</tbody>
</table>
Setting Drawing Options

Define draw options for the object in the scene under various conditions using the **Draw Options** in the **Object** editor:

**Draw in Color**
Control the image color in the HDVG output. Generally used for masks, because objects without color are still visible in the alpha channel.
When marked “✓” the object inherits its draw setting from the parent object (if it is in a group, is the child of another object, or from the layer).
When selected, the object is always shown in color, regardless of the parent object.
When cleared, the object is not shown, regardless of the parent object.

**Draw in Key**
Control key drawing in the HDVG output.
When marked “✓” the object inherits its draw setting from the parent object (if it is in a group, is the child of another object, or from the layer).
When selected, the object is always drawn, regardless of the parent object.
When cleared, the object is not drawn, regardless of the parent object.

**Single Child Mode**
**Single Child Mode** is used to enable object flipbooks, that is, to show different objects or containers in a sequence, by switching their **Visible** setting on and off. This allows the creation of complex animations.
By selecting a group object that contains child objects, and then selecting **Single Child Mode**, you can cycle visibility of the objects according to their position in the group. The **Single child selector** number is the visible object’s position in the group. Use the **Single child selector** extension button to set keyframes for the flipbook, to control which child is visible.
Blending Objects

Blending modes are used to add visual effects for displaying images together, with or without applied textures. You can control the blending used for the RGB channel and for the Alpha channel independently. Blending modes can be set per object (in the Object editor) or per layer (in the Layer editor). The available blending options are:

**Inherit**
By default, the blending mode is inherited from the parent object or layer.

**Add**
Increases the brightness of the foreground color by adding the value of the foreground to the background for each pixel.

**Clear**
The foreground is changed entirely to black. All pixels are set to 0.

**Lighten**
Lightens the blended image. Pixels of the foreground and the background are compared, and the lighter pixel in each set of pixels is displayed.

**Darken**
Darkens the blended image. Pixels of the foreground and the background are compared, and the darker pixel in each set of pixels is displayed.

**Multiply**
Darkens the blended image. Multiplies the foreground color by the background color for each pixel. Multiplying a color with black produces black; multiplying a color with white leaves the color unchanged.

**Subtract**
Darkens the blended image. Subtracts the foreground color from the background color. If the result is less than 0, the color is set to 0.

**Normal**
Uses the foreground color, and ignores the alpha channel.

**Override**
This is the scene’s default blending mode. Colors are mixed to reflect the lightness or darkness of the original color.

**Difference**
Darkens the blended image. Subtracts the background color from the foreground color. If the result is less than 0, the color is set to 0.

**Premultiplied**
Use for premultiplied objects in scenes that are already multiplied to prevent double multiplication.
## Motion Blur

Motion blur applies a blurred look to objects during animation.

Select **On during stop** to continue displaying the object as blurred when the animation if finished.

**TIP**

The Demo_reel scene, installed with 4Designer, contains an example of how motion blur can be used.

<table>
<thead>
<tr>
<th>Screen</th>
<th>Lightens the blended image. Pixel values in the two layers are inverted, then multiplied, and then inverted again. This yields the opposite effect to multiply.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Alpha Cutout</td>
<td>When this check box is selected, you can create a cutout effect by using an image file with embedded alpha, or a jpg/bmp file with 100% white/black in the texture key channel. When this check box is cleared, there is no cutout, and images are blended.</td>
</tr>
<tr>
<td>Compare depth function</td>
<td>Set the Z-depth comparison to use for blending. For example, if set to greater, then blending is only applied when the blending object has a greater Z value than the object it is being blended over.</td>
</tr>
</tbody>
</table>
Notes

You can add any text (description, note to other designers, etc.) to be saved with the object under **Notes**.

Using the Bounding Box

The **Bounding Box** parameters in the Object editor allow you to perform an action on a side of a bounding box surrounding the selected object. Click the extension button next to the bounding box side listed here, to create an out connection.

The **Out Connection** option (in the extension menu) can be used to set the relative edges of objects in the scene; for example, this could be used when constructing a ticker that should contain multiple objects of varying lengths. By taking the right bounding box of a text object as the out connection, and connecting this to the X position of an object such as a station logo, the position of the logo will automatically be adjusted when the text length changes.

**NOTE:**

The bounding box can only have an out connection, and not an in-connection.
Mask Options

The Mask options allow you to set how one object masks another object or how one layer masks another layer. You can set objects to display the parts visible within the mask area, outside of the mask area, or to inherit the default option from the layer. In order to use masking you must set an object or multiple objects as the mask and the object or objects to be masked. Any object or layer in the scene can be set as a mask.

You can also set a Scissor mask for each object, to display an object within a certain area only.

TIP

The Demo_reel scene, installed with 4Designer, contains an example of how masks can be used.

Masking Objects

To set an object as a mask:
1. Select the object in the Scene tree.
2. Right-click the Masks column, and select Create a mask group.

   The object becomes a mask and the icon appears in the Masks column.
3. A new mask is added to the list and the object is set as a mask. Right-click to rename it, as required.

![Mask Options](image)

To set an object to be masked:
1. Select the object in the Scene tree.
2. Right-click the Masks column, select Apply Inside Mask.

   The Masks editor is displayed.
3. A new mask is added to the list and the object is set to be masked. Right-click to rename it, as required.

To set an outside mask:
1. Select the object in the Scene tree.
2. Right-click the **Masks** column, select **Apply Outside Mask**.

   The  
   **Masks** editor is displayed.

3. A new mask is added to the list and the object is set to work as an outside mask. Right-click to rename it, as required.

### Masking Layers

**NOTE:**

A layer can only be set as a mask for, or masked by another layer. You cannot set individual objects as a mask for a layer, or vice versa.

#### To set a layer as a mask:

1. Select the layer in the Scene tree.
2. Right-click the **Layer Masks** column, select **Create Mask Group**.

   The  
   **Layer Masks** editor is displayed.

3. Apply any mask listed under **All Masks**, by dragging it to **Part of Masks**.

   Or-

   Right-click the **Part of Masks** list, and select **Create and refer > Mask**.

   A new mask is added to the list and the layer is set as a mask. Right-click to rename it, as required.

#### To set a layer to be masked:

1. Select the layer in the Scene tree.
2. Right-click the **Masks** column, select **Apply Inside Mask** or **Apply Outside Mask**.

<table>
<thead>
<tr>
<th>Masked Outside</th>
<th>Hide the masked object only outside of the masked areas.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Masked Inside</td>
<td>Display the masked object only inside the masked areas.</td>
</tr>
</tbody>
</table>

A new mask is added to the list and the layer is set to be masked. Right-click to rename it, as required.

### Applying a Scissor Mask

Scissor masks are 2D masks, set per object, based on normalized screen coordinates (0 -1) to work correctly regardless of screen shape.

#### To apply a scissor mask:

1. Select the object to be masked.
2. In the **Object** editor, select **Enabled** under **Scissor Mask**.
3. Set the **Left**, **Right**, **Top**, and **Bottom** limits of the mask.
Managing all Masks within a scene

When a scene has a number of masks, it can be troublesome to find them all in the Scene tree. The Masks viewer gathers all masks from the whole scene and displays the information about the particular mask groups:

 الفرنسي To find a mask in the Scene tree:

1. Select the mask group in the All masks window, and then click on the mask that you want highlight in the Scene tree.
2. Click on the Select button.
   
   The selected mask is highlighted in the Scene tree and can be further edited.
Object Placement and Size

**NOTE:** When resizing text objects, it is recommended to use the **Size** field, in the object’s **Shape editor**. For more information, see **Setting Text Size and Density** on page 147.

Object placement and size, is defined in the **Transformation** strip and in the **Transformation** editor (values are linked).

![Transformation Editor](image)

The following options are available:

| Object/Pivot tabs (Coordinate System) | The coordinate system settings for **Object** allow you to move the object and its pivot together.
| Position, Rotation, Scale | **Position**, **Rotation** and **Scale** parameters of the selected objects, relative to the X, Y, and Z-axes.
| Scale Lock | When using the **Object** coordinate system, you can lock the scale along the selected combination of axes to scale the object more precisely and change proportions.
| Modifiers | Right-click, and select **Create and refer** to add one of the following modifiers:
  - **Front Face** - Use this mode to set an object to be facing the layer camera at all times, even when the camera position changes.
  - **Full Screen** - When using the **Parent** coordinate system, use this parameter to animate a video insertion object to full frame, without creating a precise scale animation. This parameter has a 0 to 1 range. 0 - the original object scale, 1 - object is scaled to be exactly the full frame, according to the resolution set for the video output. (If you encounter a scaling problem in Full screen, put your object in a group, scale to the group, and apply the full frame transformation to the object.)
If you want an object to appear facing the studio camera at all times, apply the Screen Flower modifier. Tracking must be enabled for the studio camera.

To apply the Screen Flower modifier:

1. Create a free layer to contain the Screen Flower objects. (See Free Layer Camera on page 64.)
2. Add the object(s) to the layer, as required.
3. In the Transformation editor, right-click the Modifiers list.
4. Select Create and refer > Screen Flower Modifier. A screen flower modifier is added to the list.
5. Select the modifier. The modifier’s properties are displayed in the Stack.
6. For a single object, select Local Hierarchy to use object placement and size properties directly.
   For a group, clear Local Hierarchy to calculate placement and size of all objects which are part of the group.
7. Verify that the Studio Orientation parameters are connected to the tracked layer.
   (Tracked_Layer/Position/X -&gt; SFM/PW Studio Position X
   Tracked_Layer/Position/Y -&gt; SFM/PW Studio Position Y
   Tracked_Layer/Position/Z -&gt; SFM/PW Studio Position Z
   Tracked_Layer/Orientation/Tilt -&gt; SFM/PW Studio Orient X
   Tracked_Layer/Orientation/Pan -&gt; SFM/PW Studio Orient Y
   Tracked_Layer/Orientation/Roll -&gt; SFM/PW Studio Orient Z)
8. Enter the required **Studio Parameters**, described in the following graphic.

![Diagram of Studio Parameters]

**NOTE:**

The **Coeff** value must be 1, and the object must be viewed through the Studio Camera to see the effect of this modifier.

**Gimbal Lock**

When working with the rotation of different scene objects, you may encounter Gimbal lock. This is a phenomenon where two rotational axes of an object point in the same direction. You can see this by taking an object such as a cube, rotating it by 90 degrees on the Y axis, and then trying to manipulate the X and Z axis; you will notice that both the X and Z axis affect the cube in the same way.

4Designer uses Euler angles (in the same way as Maya, 3dsMax, Lightwave, Softimage), which are calculated in the order of X, Y then Z. For the cube mentioned above, the Y axis is changed to 90 degrees; as the X rotation has already been calculated, it does not get carried along with the calculation of the other two axes, so the X and Z axis end up pointing down the same axis of rotation.

Gimbal lock affects scene editing, but does not affect the final output. If you encounter gimbal lock in one view, try editing the scene or object in a different view.
Grid Objects

You can control the placement of objects in the RE window (using RenderEngine on Windows only), by adding a grid to the current layer. Dropping objects on the grid places them with the pivot on the grid and assigns object X/Z positions according to the grid coordinates.

Grid dimensions and colors can be changed through the Helper editor.

Before you begin, you must assign the grid to a layer.

To assign the grid to a layer:

1. From the Misc. library in the Assets, place the Grid object in the layer.
2. Select the layer in the Scene tree.
3. Click the Helper column in the Scene tree, and select the grid object from the list.

   The grid is assigned to the layer. You can drop objects as required.

   **NOTE:**
   
   Objects dropped on the grid are not attached to the grid.
Defining Shapes and Geometry

The Shape editor properties define drawing options for an object. Different types of objects have different properties available. This section discusses the Shape related options for the shapes available in 4Designer. For example, you can:

- Show all sides of an object, or hide certain sides.
- Set the number of sides, segments, or resolution for an object.
- Set a cut angle for objects that have a rounded characteristic.
- Show the outline/wire-frame of an object.
- Set one-way visibility for an object.

Edit the unique characteristics of each primitive object in the Shape editor. The fields displayed vary for each object type.

To learn more about the Shape properties of text-oriented objects, see Working with Text on page 142.

Common Properties

**NOTE:**
Increasing resolution generates a smoother surface, but also increases rendering time.

<table>
<thead>
<tr>
<th>Object Center Modification</th>
<th>Set the object center from which the object is aligned for the X, Y, and Z axes.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Layout X</strong></td>
<td>align the object to the right, left, or center of selected point of origin on the X axis. Off uses the center point.</td>
</tr>
<tr>
<td><strong>Layout Y</strong></td>
<td>align the object to the bottom, top, or center of selected point of origin on the Y axis. Off uses the center point.</td>
</tr>
<tr>
<td><strong>Layout Z</strong></td>
<td>align the object to the back, front, or center of selected point of origin on the Z axis. Off uses the center point.</td>
</tr>
</tbody>
</table>

| Polygon mode | Select the polygon fill mode for the object: Fill to draw the object as a filled object. Lines to draw only the wire-frame model of the object. Points to draw only the vertex points of the object. |

| Cull faces | Select the object culling. The culling defines whether the back side (or sides) of the object is drawn. Culling makes rendering objects quicker and more efficient by reducing the number of polygons to draw; you can see the object face if the camera is viewing the object from the front (for 2D objects) or from the outside (for 3D objects), but you cannot see the object face if the camera is viewing the object from the back (for 2D objects) or inside (for 3D objects). None for no culling. Counter clockwise to display the points in the polygon in counter clockwise order (front to back). Clockwise to display the points in the polygon in clockwise order (back to front). |
Object Properties: Rectangles, Gradients, and Video Textures

The rectangle object is a 2D object. You can apply different colors to each corner of the rectangle.

The gradient is a rectangle with a preset color gradient. The video texture is a rectangle with a video texture applied. Therefore, all Shape parameters are derived from the rectangle object.

To apply corner colors to a rectangle object:

1. In the Shape editor, select Enable corner colors.
2. Click the quarter for which to set a color (top left/top right/bottom left/bottom right).
3. Apply a color from the palette and set the alpha/transparency (A) value.
   Repeat for each quarter, as required.

Object Properties: Super Tetragons

The super tetragon is a 2D object that can display rounded corners and a cutout section. The super tetragon expands 3Designer’s round-up rectangle object, and replaces it, while maintaining backwards compatibility. An explosion effect can be applied to the super tetragon. You can set the following properties to determine object shape.

TIP
The Demo_reel scene, installed with 4Designer, contains an example of the super tetragon’s capabilities

| Modifiers | Right-click, and select Create and refer to add one of the following modifiers:
|-----------|----------------------------------------------------------------------------------|
| Taper     | Explode -
| Tessellation - | Skew - |

<table>
<thead>
<tr>
<th>Modifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Width</strong></td>
<td>Set object width (without distorting the rounded corners).</td>
</tr>
<tr>
<td><strong>Height</strong></td>
<td>Set object height (without distorting the rounded corners).</td>
</tr>
<tr>
<td><strong>Radius</strong></td>
<td>Set the length of the radius used to round out object corners, for each corner.</td>
</tr>
<tr>
<td><strong>Vertices</strong></td>
<td>Set the number of pieces used to round out each corner of the object.</td>
</tr>
<tr>
<td><strong>Inner Section width/height</strong></td>
<td>Set the width/height of the inner section.</td>
</tr>
<tr>
<td><strong>H/V shift</strong></td>
<td>Set the Horizontal/Vertical offset of the inner section from the object center.</td>
</tr>
</tbody>
</table>
### Object Properties: Super N-gons

The super N-gon is a 2D polygonal object. You can set the number of base corners, as required. Each edge (between two corners) can be indented, and the position of the indentation can be set, enabling the creation of shapes with varying angles. Odd and even edges can be shifted, allowing further manipulation.

*TIP*

The Demo_reel scene, installed with 4Designer, contains an example of the super n-gon’s capabilities.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Radius</strong></td>
<td>Set the length of the object radius. This affects the outer size of the n-gon, without affecting the size of the inner section.</td>
</tr>
<tr>
<td><strong>Aspect</strong></td>
<td>Set the aspect ratio between object height and width.</td>
</tr>
<tr>
<td><strong>Vertices</strong></td>
<td>Set the number of base corners of the n-gon.</td>
</tr>
<tr>
<td><strong>Rotation</strong></td>
<td>Set the rotation angle of the n-gon. This affects the outer silhouette of the n-gon, without affecting the rotation of the inner section.</td>
</tr>
<tr>
<td><strong>(Rounding) Radius</strong></td>
<td>Set the length of the radius of the vertices.</td>
</tr>
<tr>
<td><strong>(Rounding) Radius pieces</strong></td>
<td>Set the resolution of the radius of the vertices.</td>
</tr>
<tr>
<td><strong>(Rounding) Internal radius</strong></td>
<td>Set the length of the radius of the vertices of the inner section.</td>
</tr>
<tr>
<td><strong>Rounding</strong></td>
<td>Set the resolution of the radius of the vertices of the inner section.</td>
</tr>
<tr>
<td><strong>Internal radius pieces</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Even edge indentation</strong></td>
<td>Set the degree of the indentation or projection of the even edges.</td>
</tr>
<tr>
<td><strong>Odd edge indentation</strong></td>
<td>Set the degree of the indentation or projection of the odd edges.</td>
</tr>
<tr>
<td><strong>Even edge shift</strong></td>
<td>Set the location of the even edge indentation or projection.</td>
</tr>
<tr>
<td><strong>Odd edge shift</strong></td>
<td>Set the location of the odd edge indentation or projection.</td>
</tr>
<tr>
<td><strong>(Section) Radius</strong></td>
<td>Set the length of the radius of the n-gon’s inner section. This affects the size of the inner section, without affecting the n-gon silhouette.</td>
</tr>
<tr>
<td><strong>(Section) Aspect</strong></td>
<td>Set the aspect ratio between the height and width of the inner section.</td>
</tr>
<tr>
<td><strong>(Section) Vertices</strong></td>
<td>Set the number of base corners of the inner section.</td>
</tr>
<tr>
<td><strong>(Section) Rotation</strong></td>
<td>Set the rotation angle of the inner section.</td>
</tr>
<tr>
<td><strong>H shift</strong></td>
<td>Set the horizontal position of the inner section in relation to the object center.</td>
</tr>
<tr>
<td><strong>V shift</strong></td>
<td>Set the vertical position of the inner section in relation to the object center.</td>
</tr>
<tr>
<td><strong>Even section edge indentation</strong></td>
<td>Set the degree of the indentation (or projection) of the even edges of the inner section.</td>
</tr>
<tr>
<td><strong>Odd section edge indentation</strong></td>
<td>Set the degree of the indentation (or projection) of the odd edges of the inner section.</td>
</tr>
<tr>
<td><strong>Fill section when outside</strong></td>
<td>Select to render the inner section as filled when it is shifted to appear outside of the object. When cleared, the section will be hidden when shifted outside the object silhouette.</td>
</tr>
<tr>
<td><strong>Tessellation factor</strong></td>
<td>Set the number of polygons on the object’s surface. Lower tessellation values set greater surface detailing, higher values reduce rendering time.</td>
</tr>
<tr>
<td><strong>Apply skew</strong></td>
<td>Apply a one-directional skew to the object, as specified in the Skew angle.</td>
</tr>
<tr>
<td><strong>Skew deformation</strong></td>
<td>Specify the object twist.</td>
</tr>
<tr>
<td><strong>Apply right skew</strong></td>
<td>Apply an additional skew to the object, as specified in the Right skew angle.</td>
</tr>
<tr>
<td><strong>Right skew deformation</strong></td>
<td>Specify a twist to the right side of the object.</td>
</tr>
</tbody>
</table>
Object Properties: Disks

The disk object is a 2D object that can have 3-2000 sides, to be rendered as a disk or polygon. You can set a centered inner section that will always be proportional to the object, and set a sector.

<table>
<thead>
<tr>
<th><strong>Sides</strong></th>
<th>Specify the number of sides on the object’s circumference. Increasing the number improves the object’s resolution, but increases rendering time.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Inner Radius</strong></td>
<td>Specify the radius of the empty space at the center of the object. 0=no empty space, 1=entire space of disk is empty.</td>
</tr>
<tr>
<td><strong>Cut Angle</strong></td>
<td>Define the Start and Stop angle coordinates for a removed sector, if you do not want the object (or its cross section) to be a complete circle. (Range = 0-360°)</td>
</tr>
</tbody>
</table>

Object Properties: Cubes

The cube object is a 3D object with six facets. You can show or hide each facet and set the resolution of each facet. Increasing the resolution gives a smoother lighting effect when using spot or point lights.

Object Properties: Super Cubes

The super cube object is a 3D object with six facets. You can round the object’s corners, and define an inner hole that can be shifted within the object’s silhouette, and shown on some or all facets. The super cube replaces the roundup rectangle asset, that was available in 3Designer.

**TIP**

The Demo_reel scene, installed with 4Designer, contains an example of the super cubes’s capabilities.

<table>
<thead>
<tr>
<th><strong>Width</strong></th>
<th>Set object width.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Height</strong></td>
<td>Set object height.</td>
</tr>
<tr>
<td><strong>Depth</strong></td>
<td>Set object depth.</td>
</tr>
<tr>
<td><strong>Radius</strong></td>
<td>Set the length of the radius used to round out the corners of the cube.</td>
</tr>
<tr>
<td><strong>Pieces</strong></td>
<td>Set the number of edges used to render the curve of the cube edges.</td>
</tr>
<tr>
<td><strong>X/Y Pieces</strong></td>
<td>Set the number of edges used to render the object face on the X and Y axes.</td>
</tr>
<tr>
<td><strong>Left and right hole</strong></td>
<td>Select to show the left and right sides of the cube as open, as set in hole width, height, and depth. Clear to show the left and right sides of the cube as filled. When facing the light, the left side is shown in black, and the right side is white.</td>
</tr>
</tbody>
</table>
### Front and back hole
Select to show the front and back sides of the cube as open, as set in **hole width**, **height**, and **depth**. Clear to show the front and back sides of the cube as filled. When facing the light, the front side is shown in black, and the back side is white.

### Top and bottom hole
Select to show the top and bottom sides of the cube as open, as set in **hole width**, **height**, and **depth**. Clear to show the top and bottom sides of the cube as filled. When facing the light, the bottom side is shown in black, and the top side is white.

### Hole width
Set the width of the opening in the front, back, top, and bottom of the cube.

### Hole height
Set the height of the opening in the left and right sides of the cube.

### Hole depth
Set the width of the opening in the left and right sides of the cube.

### Hole radius
Set the length of the radius used to round out the inner corners of the cube (when faces are open).

### Map whole texture
Set the texture to be pinched in slightly at the edges to adapt mapping for radius changes.

### Edge pieces
Set the number of edges used to render the curve of the inner corners.

### Hole X/Y/Z shift
Set the offset of the cube opening from the X, Y, and Z axes.

### Object Properties: Spheres
Set the following parameters for 3D sphere objects:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sides</strong></td>
<td>Set the longitudinal resolution of the sphere.</td>
</tr>
<tr>
<td><strong>Segments</strong></td>
<td>Specify the number of segments in the sphere’s surface. Increasing the number improves object resolution, but can slow rendering.</td>
</tr>
</tbody>
</table>

### Object Properties: Cylinders and Cones
Set the following parameters for 3D cylinder and 3D cone objects:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sides</strong></td>
<td>Set the longitudinal resolution of the cylinder.</td>
</tr>
<tr>
<td><strong>Segments</strong></td>
<td>Specify the number of segments in the cylinder’s sides. Increasing the number improves the object’s resolution.</td>
</tr>
<tr>
<td><strong>Inner Radius</strong></td>
<td>Specify the radius of the empty space at the center of the object. 0=no empty space, 1=entire space is empty.</td>
</tr>
<tr>
<td><strong>Cut Angle</strong></td>
<td>Define the <strong>Start</strong> and <strong>Stop</strong> angle coordinates for a removed sector, if you do not want the object (or its cross section) to be a complete circle. (Range = 0-360°)</td>
</tr>
</tbody>
</table>
Object Properties: Rotaries

The 3D rotary object is a sphere object that has been scaled disproportionately to have a lens shape.

<table>
<thead>
<tr>
<th>Subdivision - Length</th>
<th>Set the number of segments in the rotary’s circumference.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subdivision - Cut</td>
<td>Set the number of segments in the rotary’s face.</td>
</tr>
<tr>
<td>Length - Begin/End</td>
<td>Specify the Begin and End angle coordinates for a removed section, if you do not want the rotary to be drawn as a complete circle. (Range = 0-1)</td>
</tr>
<tr>
<td>Cut</td>
<td>Select a preset section from the list.</td>
</tr>
</tbody>
</table>

**NOTE:**
Editing the object’s cross section can be done with the Cut editor. For more information, see Cut Editor on page 94.

Object Properties: Splines

The 3D Spline object can be used to create irregular shapes to use as required, or as an animation path.

<table>
<thead>
<tr>
<th>Subdivision - Length</th>
<th>Set the number of segments through which the spline is drawn.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subdivision - Cut</td>
<td>Set the number of pieces in the cross section of the spline (the shape/resolution of the spline’s ends).</td>
</tr>
<tr>
<td>Begin</td>
<td>Set the location of the beginning point of the object.</td>
</tr>
<tr>
<td>End</td>
<td>Set the location of the end point of the object.</td>
</tr>
<tr>
<td>Path</td>
<td>Select a preset path from the list, to which to connect the spline.</td>
</tr>
<tr>
<td>Scale</td>
<td>Scale the spline’s cross section without scaling the object. The section is scaled uniformly in relation to its center, without reference to the pivot point.</td>
</tr>
<tr>
<td>Cut</td>
<td>Select a preset spline object from the list.</td>
</tr>
</tbody>
</table>

**NOTE:**
Editing the object’s cross section can be done with the Cut editor. For more information, see Cut Editor on page 94.

Object Properties: Extrusions

Set the following for the 3D extrusion object:

| Length    | Set the number of segments in the object’s sides, in length. |
| Cut       | Set the number of segments in the object’s sides in cross-section. |
| Begin     | Set the location of the beginning point of the object. |
### Defining Shapes and Geometry

#### 4. Designing Your Graphics

**NOTE:** Editing the object’s cross section can be done with the Cut editor. For more information, see Cut Editor on page 94.

### Object Properties: Beveled Cut-Outs

Set the following for the 3D beveled cut-out object.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>End</strong></td>
<td>Set the location of the end point of the object.</td>
</tr>
<tr>
<td><strong>Path</strong></td>
<td>Select a preset path from the list, to which to connect the object.</td>
</tr>
<tr>
<td><strong>Scale</strong></td>
<td>Scale the cross section without scaling the object. The section is scaled uniformly in relation to its center, without reference to the pivot point.</td>
</tr>
<tr>
<td><strong>Cut</strong></td>
<td>Select a preset shape object from the list.</td>
</tr>
</tbody>
</table>

**NOTE:** Editing the object’s cross section can be done with the Cut editor. For more information, see Cut Editor on page 94.

### Object Properties: Paper Rolls

The paper roll object can be animated to appear as though it is being unrolled.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Radius</strong></td>
<td>Set the radius of the rolled part of the object.</td>
</tr>
<tr>
<td><strong>Amount</strong></td>
<td>Set the amount of roll applied. When set to 0, the paper roll is fully unrolled, when set to 1, the paper roll is fully rolled. This value can be animated.</td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td>Set the number of segments in the circumference of the rolled part of the object.</td>
</tr>
<tr>
<td><strong>Thickness</strong></td>
<td>Set the distance between rolls (in the scroll) when the roll is fully wound up.</td>
</tr>
</tbody>
</table>
Object Properties: Chart Grid

The chart grid object can be used to define chart grid and axis. There is a separate tab for the Horizontal grid and the Vertical grid.

<table>
<thead>
<tr>
<th>Grid</th>
<th>The range of values on the grid can be set to <strong>Auto range</strong>, or the <strong>min</strong> and <strong>max</strong> values can be adjusted manually. The <strong>Plot data</strong> can be driven by a data series. To create a new data series, click on the drop-down arrow, then right-click on an empty space, and select <strong>Create and refer &gt; FloatArray</strong> or <strong>StringArray</strong>. The values of the newly created array can be edited in the <strong>Stack</strong> window.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labels</td>
<td>The labels can be set to <strong>Auto label</strong>. The <strong>Location</strong> of the labels can be set to Thin Grid or Thick Grid. Selecting <strong>None</strong> hides the labels. The layout against the X or Y axes can be set to: Left, Top, Right, Center, or Off. Also, the values of the shift against the X and Y axes, as well as the rotation of the labels can be adjusted. The labels can be driven by a data series. To select an existing data series, press the drop-down arrow next to <strong>Labels</strong>. From there, you can also create and refer to new data series.</td>
</tr>
<tr>
<td>Axis</td>
<td>Define the style of the axis, by selecting the Pattern, Pattern scale, Width, Arrow shape and size, and the color of the line.</td>
</tr>
<tr>
<td>Thick lines</td>
<td>Set the look of the thick lines of the grid, by selecting the Pattern, Pattern scale, Width, Arrow shape and size, and the color of the line.</td>
</tr>
<tr>
<td>Thin lines</td>
<td>Set the look of the thin lines of the grid, by selecting the Pattern, Pattern scale, Width, Arrow shape and size, and the color of the line.</td>
</tr>
</tbody>
</table>

Object Properties: Geometry Creator

The geometry creator object can be used to create shapes which are driven by functions.

| Creator | Set the color of the shape with the **Are colors** property. |
| Part | Create a new Geometry Part to construct a filled area below the chart line. |

Object Properties: Chart Label

The chart label object can be used to attach labels to chart points and values.

| Labels | Set the label parameters, such as Label source, Layout and Offset against the X and Y axes, and the Text style. |
| Data | Select or create necessary data series for each of the positions: X, Y, and Z. |
Cut Editor

The Cut editor, displayed in the Stack, is used to edit the cross-section (cut) with holes of splines, rotaries, extrusion objects, and beveling, as well as add holes inside the shapes. The viewer displays a cross-section of the current shape, although it might not accurately reflect the object appearance, which is affected by other parameters, such as resolution, or the subdivision of the created element.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit spline</strong></td>
<td>Add new sub-splines or draw new splines. Modify nodes.</td>
</tr>
<tr>
<td><strong>Draw spline</strong></td>
<td>Draw new splines.</td>
</tr>
<tr>
<td><strong>Invert spline</strong></td>
<td>Reverse normals vectors for surface based on cut-out. This option is helpful for fixing geometry coming from SVG imports.</td>
</tr>
<tr>
<td><strong>Show all control points</strong></td>
<td>Show/hide handles for nodes that can be used to edit the cut shape.</td>
</tr>
<tr>
<td><strong>Fit in View</strong></td>
<td>Stretch or shrink the cut shape to fit the viewer.</td>
</tr>
<tr>
<td><strong>Snap to grid</strong></td>
<td>When this option is selected, control points are snapped to the grid as you move them.</td>
</tr>
<tr>
<td><strong>Show grid</strong></td>
<td>Display a grid in the Cut Editor window.</td>
</tr>
<tr>
<td><strong>Join selected end nodes to new segment</strong></td>
<td>Join the selected end nodes to create a new segment.</td>
</tr>
</tbody>
</table>
Defining Shapes and Geometry

<table>
<thead>
<tr>
<th>Node types</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Corner</strong></td>
<td>(diamond)</td>
</tr>
<tr>
<td><strong>Smooth</strong></td>
<td>(rectangle)</td>
</tr>
<tr>
<td><strong>Symmetric smooth</strong></td>
<td>(circle)</td>
</tr>
</tbody>
</table>

For each node, a spline control type can be defined:

- **Start node**: Starts a new path or a subpath.
- **End node**: Ends a path or a subpath.
- **End close node**: Closes a path or a subpath.

### Modification of a selected spline

**Basic operations**

- **Selection**
  - To select a node, press the left mouse button on the node.
  - To deselect a node, press the left mouse button with the CTRL key on it.
  - To deselect all nodes, press the left mouse button on an empty space.

---

**Node operations**

- **Break segment between two non-endpoint nodes**: Break the segment between two selected non-endpoint nodes.
- **Join selected nodes**: Join two selected nodes into one.
- **Break path at selected nodes**: Break a path creating two overlapping nodes at the selected one.

**NOTE:**

Press SHIFT and click within the viewer to toggle the three node types.
4. Designing Your Graphics

Operation in the select, draw and edit mode

| Panning and scaling | • To zoom out, move the mouse wheel downwards.  
| | • To zoom in, move the mouse wheel upwards.  
| | • For panning, press the mouse wheel and drag.  

Draw

- To add a node, press the left mouse button.
- To add the end node and finish drawing the path, press the right mouse button.
- To finish drawing and discard any changes, press the Esc button.

Edit

- To append a node to a path, double the left mouse button.
- To move a node, click on it and drag it.
- To insert a new node into a segment, double click the left mouse button + Alt button on the segment.
- To modify a segment, press the left mouse button on the segment and drag.
- To change the node type, press the left mouse button + Shift button on the node.
- To remove a node, press the left mouse button + Ctrl + Alt keys.
- To hide/show all node handlers, press the left mouse button + the Alt key on the node.

Tools and actions

▶ To create a new section shape:

If the shape you need is not available in the list:

1. In the Editor, open the Cut list.
2. Right-click, and select Create and refer > Cut.
   A new cut is added to the list. Rename it, as required.
3. Click **Cut**.
   The viewer is cleared.
4. Double click inside the viewer to add nodes to use as control points for the new cut.
5. Drag and manipulate the control points as required, until you are satisfied with the new section shape.
   This section can now be reused for other objects, by selecting it from the Cut list.

▶ To invert a spline:

- Click on **Invert Spline** to reverse the spline drawing direction (handles and node types remain unchanged).
To show/hide node handles:

- Click on **Show/hide control points** to show or hide the handles for nodes:

To join selected end nodes to a new segment:

- Click on **Join selected end nodes to a new segment**:

To break a segment into two nodes:

- Click on **Break segment into two nodes** to break a selected segment into two end nodes (with End and Start markers):

To join selected nodes to a new one:

- Click on **Join selected nodes**:
To break path at selected nodes:

- Click on Break path at selected nodes to break the path by creating two new nodes:

![Diagram showing path broken at selected nodes](image)

Importing of SVG files

SVG cut objects with holes can be imported into 4Designer. The import utility can import the SVG objects in two ways:

- as a single cut object - when all SVG objects are combined by “Union” or other path operations,
- as multiple cut objects - when all SVG objects are separated.

To import an SVG object with holes:

- Go to File > Import and select SVG from the list.

**NOTE:**
The imported files should have the "fill-rule" property set to "nonzero". The import does not support gradients and images.

The spline drawing mechanisms implements the fill-rule="nonzero" property described in the SVG W3C recommendation.

The ‘fill-rule’ property indicates the algorithm which is to be used to determine what parts of the canvas are included inside the shape and what parts are excluded from the shape as holes.
Setting Colors and Materials

In the Color editor, you can create and edit two kinds of colors: plain and material (shaded). The following table explains the basic terms used for coloring:

<table>
<thead>
<tr>
<th><strong>Red/Green/ Blue</strong></th>
<th>Set the RGB color values of the selected object.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hue</strong></td>
<td>Set the color type (the pure color).</td>
</tr>
<tr>
<td><strong>Saturation</strong></td>
<td>Set light saturation on the material, affecting the intensity of the color. If similar colors blend or if colors appear dark, saturation is too high. For colors that appear dull or faded saturation is too low.</td>
</tr>
<tr>
<td><strong>Value</strong></td>
<td>Set color brightness. The lower the value is, the more black is added to the hue.</td>
</tr>
<tr>
<td><strong>Ambient</strong></td>
<td>Set the overall light on the surface of the object that gives a general illumination.</td>
</tr>
<tr>
<td><strong>Diffuse</strong></td>
<td>Set the relation between direct and indirect light on an object. The higher the diffusion value, the brighter the object appears.</td>
</tr>
<tr>
<td><strong>Specular</strong></td>
<td>Set the surface reflected color.</td>
</tr>
<tr>
<td><strong>Emission</strong></td>
<td>Set the self-lit color for the material.</td>
</tr>
<tr>
<td><strong>Alpha</strong></td>
<td>Set the (alpha) transparency for the material.</td>
</tr>
<tr>
<td><strong>Shininess</strong></td>
<td>Set the degree of light reflection for the material. Shininess is a combination of specular level and glossiness.</td>
</tr>
<tr>
<td><strong>Two Sided Material</strong></td>
<td>Set the way a texture or material is rendered on an object, affected by the object’s lighting. You can set an object to be lit from outside and from within, using more system resources or switch inner lighting off, when not required for an object, depending on the type of graphics card your system has.</td>
</tr>
<tr>
<td><strong>Pixel lighting</strong></td>
<td>Enable the pixel lighting option to improve the lighting.</td>
</tr>
</tbody>
</table>

Using Plain Colors

For Plain colors, you determine a particular blend of colors using the standard parameters for color, hue, saturation, etc. Plain colors give the object a flat, uniform look.

To apply a plain color to an object:

1. In the RE window or in the Scene tree, select the object to which you want to apply the color.
2. Open the Color editor.
   
   If the object is a 2D object, the plain (non-shaded) Color editor is displayed.
If the object is a 3D object, clear **Shaded** to display the plain color parameters.

3. Select the required color and transparency from the color palette, or
   - click **Custom Color** and set color and transparency in the advanced palette that opens.
Using Material/Shaded Colors

Shaded/Material colors allow you to set four separate color characteristics (ambient, diffuse, emission, specular) as well as lighting that can be applied. Materials give objects a shaded look, with lit and shaded surfaces. Once you create the color, whether plain or material, you can apply it to selected objects.

To apply a material/color shading to an object:

1. In the RE window or in the Scene tree, select the object to which you want to apply the color.

2. Open the Color editor.

   If the object is a 2D object, select Shaded to display the material/shaded color parameters.

   If the object is a 3D object, the material/shaded Color editor is displayed.

3. Click Diffuse, Specular, Emission, and Ambient to set the color for each color characteristic, individually.

4. Select the required color and transparency from the color palette, or click Custom Color and set color and transparency in the advanced palette that opens.

5. Select a light (from the light objects in the scene) to apply to the object. (Open the list, select the light, then click the Lights button.)

6. Select Two sided to set an object to be lit from outside and from within, as required.
Applying Materials

Materials are preset property sets available in 4Designer, such as color, and lighting types. These materials can be directly applied to objects in your scene.

To apply a material to an object:
- From the Materials tab in Assets, drag the material to the object in the RE window.
  Or-
  In the Scene tree, right-click in the Color column of the relevant object, and select New Color > Material from the menu.

In the Color editor, the color of each of the Ambient, Diffuse, Specular, and Emission buttons represents the current RGB settings for that aspect. To change the RGB settings, click the appropriate button and change the values for that aspect in the RGB fields, or click Custom Color for additional options.

Using Lights for a Material

For materials, you can add lighting to the material definition. In the lighting list in the Color editor, drag to move Infinite, Spot, or Point light into the Excluded or Included areas, as required.

For more information, see Lighting on page 128.
Applying Textures

4Designer allows you to apply different types of textures to objects in your scene. There are a number of ways to apply a texture to an object.

To apply a texture to an object

From the Assets:

1. Open the Textures tab in the Assets.
2. Drag the required texture to your object in the RE window or in the Texture column in the Scene tree.

The texture is applied to the object, and the Texture editor is displayed.
3. Set the texture properties, as required.

From the Scene tree:

1. Select the object to which you want to apply texture.
2. In the texture column in the Scene tree, right-click and select New Texture and the required texture type.

The texture is applied to the object, and the Texture editor is displayed.
3. Set the texture properties, as required.

The available texture types are:

<table>
<thead>
<tr>
<th>Texture Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checkers</td>
<td>Apply a checkerboard effect texture. This texture is generated in RE and does not require an external texture file to be loaded.</td>
</tr>
<tr>
<td>Clip</td>
<td>Play a video clip on the object to which the clip texture is applied. 4Designer can use any file format, at any compression (such as Quicktime, WMV, AVI, etc.), and can playback multiple clips concurrently. For more information, see Clip Textures on page 107.</td>
</tr>
<tr>
<td>Combo Texture</td>
<td>A static texture, to which you can also apply a key texture, allowing you to display an image with a mask, and/or a video insertion. For more information, see Combo Textures on page 110.</td>
</tr>
<tr>
<td>Cross</td>
<td>Apply a criss-cross effect texture. This texture is generated in RE and does not require an external texture file to be loaded.</td>
</tr>
<tr>
<td>Gradient</td>
<td>Apply a gradient effect texture. This texture is generated in RE and does not require an external texture file to be loaded.</td>
</tr>
<tr>
<td>Image</td>
<td>A static texture. Any image can be applied as a texture. Supported file types are: BMP, GIF, JPG, JPG2000, TIF, TGA, PCX, PIC, PNG, and SGI. For more information, see Image Textures on page 111.</td>
</tr>
<tr>
<td>Image 3D</td>
<td>A sequence of images that can be sliced on different axes. For more information, see 3D Image Textures on page 111.</td>
</tr>
</tbody>
</table>
### Layers
Use a layer in the scene as a texture.
For more information, see Layer Textures on page 112.

### Line
Apply a diagonal line texture. This texture is generated in RE and does not require an external texture file to be loaded.

### Multi-Texture
Use to apply up to three textures to an object, with different mapping settings.
For more information, see Multi-Textures on page 113.

### Reflection
Use to make the object reflective of a specified texture.
For more information, see Reflection Layer.

### Reflection Layer
Use to make an object reflective of a specified layer in the same scene.

### Rectangle Soft Edge Mask
Use to soften the edges of a rectangle.

### Scene
Use a scene as a texture.
For more information, see Scene Textures on page 116.

### Sequence
A sequence of images in single frames. When creating an animated texture, each saved texture frame in the sequence must be given a consecutive number for the sequence to run in order. When an animated texture is imported, the files are automatically run in order.
For more information, see Sequence Textures on page 117.

### Transition in texture
Apply a transition-in texture for use in 3DPlay or Maestro.

### Transition out texture
Apply a transition-out texture for use in 3DPlay or Maestro.

### Turbulence
Apply a snow/turbulence effect texture. This texture is generated in RE and does not require an external texture file to be loaded.

### Video
A video insertion that will play on the object (cannot be seen in the RE window).
For more information, see Video Textures on page 118.

---

**NOTE**

Clips can only be viewed on an HDVG, not in the RE window.

In the **Texture** tab, you can set texture properties, and define how the texture is mapped on an object. The tab is context sensitive and shows the appropriate properties for the selected texture type.

#### To remove a texture:
- Right-click on the texture icon in the Scene tree, and select **Remove Texture**.
Common Texture Properties

The following properties can be set in the **Texture** tab for all texture types (for the 3D Image texture, you can set scale, translation, and rotation on the Z axis, as well).

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scale X/Y</strong></td>
<td>Set the number of times the texture is repeated on each axis.</td>
</tr>
<tr>
<td><strong>Translation X/Y</strong></td>
<td>Set UV mapping, allowing you to reposition the texture on the object.</td>
</tr>
<tr>
<td><strong>Rotation center X/Y</strong></td>
<td>Set the axis origin around which the texture can be rotated. The default (0,0) value, is the lower left corner of the texture.</td>
</tr>
<tr>
<td><strong>Rotation angle</strong></td>
<td>Set the angle of rotation of the texture, in reference to the Rotation Center.</td>
</tr>
<tr>
<td><strong>Lock Scale</strong></td>
<td>Controls the scale of the texture file’s X and Y axes on the object. Select the Lock Scale check box to lock the aspect ratio.</td>
</tr>
<tr>
<td><strong>Flip Image</strong></td>
<td>Use the Horizontal or Vertical buttons to flip the texture image.</td>
</tr>
<tr>
<td><strong>(Mipmapping) Sharpness</strong></td>
<td>Tweak the texture appearance to be biased towards being sharp or blurry. The lower the value (min. -2.00), the sharper the image, positive values soften the image (max.2.00). Use in conjunction with different mipmapping settings in order to optimize the texture appearance.</td>
</tr>
<tr>
<td><strong>Anisotropy</strong></td>
<td>Enable anisotropic filtering. For more information, see Mipmapping and Anisotropy on page 106.</td>
</tr>
<tr>
<td><strong>Map Type</strong></td>
<td>Set how the texture is mapped on an object.</td>
</tr>
<tr>
<td>None</td>
<td>The texture is applied to every face of the object, and stretched to fit.</td>
</tr>
<tr>
<td>Object Linear</td>
<td>The texture is applied as though projected onto the object from one direction.</td>
</tr>
<tr>
<td>Eye Linear</td>
<td>The texture is applied as though projected at the screen. It appears static, even when the object is moved. It is recommended to use this type with repeat wrapping.</td>
</tr>
<tr>
<td>Sphere Map</td>
<td>The texture is displayed as if the object is a sphere, to allow a reflective effect.</td>
</tr>
<tr>
<td><strong>Wrap Type</strong></td>
<td>Defines texture wrapping.</td>
</tr>
<tr>
<td>Clamp</td>
<td>Border pixels are repeated when the texture is repositioned or resized on the object.</td>
</tr>
<tr>
<td>Repeat</td>
<td>The texture is tiled when it is repositioned or resized on the object.</td>
</tr>
<tr>
<td>Clamp to Border</td>
<td>Textures are limited to the borders of the image file, and no pixels are repeated when the texture is repositioned or resized on the object.</td>
</tr>
<tr>
<td>Mirrored Repeat</td>
<td>The texture is tiled using a mirror effect, when it is repositioned or resized on the object.</td>
</tr>
</tbody>
</table>
4Designer uses pre-calculated, optimized collections of bitmap images (textures) that accompany a main texture in a scene, to increase rendering speed and reduce artifacts. This technique is known as mipmapping.

Each bitmap image of the mipmap set is a version of the main texture, but at reduced level of detail. Although the main texture is still rendered when the view is sufficient to render it in full detail, the renderer will switch to a suitable mipmap image (or interpolate between the two nearest) when the texture is viewed from a distance, or at a small size. Artifacts are reduced, since the mipmap images are anti-aliased.

If the texture has a basic size of 1024 by 1024, then the associated mipmap contains a series of 10 images, each half the size of the previous one: 512x512 pixels, 256x256, 128x128, 64x64, 32x32, 16x16, 8x8, 4x4, 2x2, 1x1 (a single pixel).

Mipmapping and Anisotropy

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min Filter</td>
<td>Defines the type of image filter used to convert the texture to fit a smaller viewing area. For more information, see <em>Mipmapping and Anisotropy</em> on page 106.</td>
</tr>
<tr>
<td>Mag Filter</td>
<td>Defines the type of image filter used to convert the texture to fit a larger viewing area. For more information, see <em>Mipmapping and Anisotropy</em> on page 106.</td>
</tr>
</tbody>
</table>

### Min Filter

- **Nearest**
  - The renderer takes the closest two mipmap images of the same texture size, and creates a new one by blending the two closest images. For example, if a scene is using a 64x64 texture in a space no larger than 40 pixels, it uses the closest two images—32x32 and 16x16.

- **Linear**
  - The renderer takes all the closest mipmap images of the same texture size, and creates a new one by blending the two closest images. For example, if a scene is using a 64x64 texture in a space no larger than 40 pixels, it uses the closest four images—64x64, 32x32, 16x16, and 8x8.

### Mag Filter

- **Nearest**
  - The renderer takes the nearest two mipmap images of the same texture size, and creates a new one by blending the two closest images. For example, if a scene is using a 64x64 texture in a space no larger than 40 pixels, it uses the closest two images—64x64 and 32x32.

- **Linear**
  - The renderer takes all the closest mipmap images of the same texture size, and creates a new one by blending the two closest images. For example, if a scene is using a 64x64 texture in a space no larger than 40 pixels, it uses the closest four images—64x64, 32x32, 16x16, and 8x8.
Mipmapping is an isotropic filter. The filtering is applied equally along both axes of the texture. This can cause blurring if the texture is viewed at a very oblique angle to the camera. For instance, if a 1:1 object is viewed at an angle that results in it appearing as 2:1. The mipmap filter does not consider the view angle, and applies filtering equally to both axes. The result might look something like the following image.

By enabling an anisotropic filter, mipmapping can be applied unequally to the axis of the texture. Setting the anisotropy to 1 will allow the texture to be mipmapped at 2:1, and the result should appear like this:

Clip Textures

Clips are applied as any other texture in 4Designer.

To apply a clip as a texture:

1. Apply a clip texture as described in Applying Textures on page 103.
2. In the Texture tab, browse for the required clip in the Clip Name field.

You can set the following options:

<table>
<thead>
<tr>
<th>Clip Name</th>
<th>Specify the clip file to apply to the selected object. Click the browse button (…) to open the required file.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NOTE:</strong></td>
<td>Audio requires an additional license for your HDVG.</td>
</tr>
<tr>
<td>Control</td>
<td>Set what the clip does when it is loaded in the controller (for this the parameter must be exported). The available options are Pause, Play, ReCue, and Rewind, or combinations of those options.</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Execute</td>
<td>Allows you to preview the setting that you selected in Clip Control. The label on this button changes according to the selection in Clip Control.</td>
</tr>
<tr>
<td>Reload</td>
<td>Use Reload to reload the clip after making any changes in this tab.</td>
</tr>
<tr>
<td>Start at</td>
<td>Set the frame number from which to play the video. Can be exported in order to cut black frames from a clip before it starts to play.</td>
</tr>
<tr>
<td>Go to</td>
<td>Specify the second in the clip from which to start playback.</td>
</tr>
<tr>
<td>Loop Count</td>
<td>Specify the number of times to loop the clip. (0=infinte).</td>
</tr>
<tr>
<td>Alpha in Clip</td>
<td>Select to play the Alpha channel in the clip, clear to ignore the Alpha channel. For more information, see Alpha and Interlacing for Clips on page 109.</td>
</tr>
<tr>
<td>Interlaced</td>
<td>Select to play the clip with interlacing. Clear to play the clip without interlacing. (The clip must have been saved with interlacing enabled). For more information, see Alpha and Interlacing for Clips on page 109.</td>
</tr>
<tr>
<td>Video Clip</td>
<td>Select to play any video in the clip. Clear to disregard video. (This allows playing just audio in a clip)</td>
</tr>
<tr>
<td>Audio Clip</td>
<td>Select to play any audio in the clip. Clear to disregard audio.</td>
</tr>
</tbody>
</table>

Alpha and Interlacing for Clips

When you enable Alpha or Interlacing for a video texture you can display or hide different components of the video signal. For example, you can choose to display or hide the background.

When *Interlaced* is selected for a clip that was exported with Interlacing enabled, and you stop an animation in the middle, you see this:

If interlaced is cleared, your paused image looks like this:
Combo Textures

Combo textures are static textures (images) to which you can apply a mask (key image) and a video insertion.

To apply a combo texture:
1. Apply a combo texture as described in Applying Textures on page 103.
2. In the Texture tab, browse for the required Image and Key image.

You can set the following options:

<table>
<thead>
<tr>
<th>Image</th>
<th>Specify the texture file to apply to the object. Click the browse button (...) to open the required file.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>Specifies a key image to use as a texture mask. Image must be black and white, or contain embedded alpha.</td>
</tr>
</tbody>
</table>

**Image compress mode**
Set the compression applied to the texture; can be set between
- **None** - no compression
- **S3TC** - force use of S3TC compression
- **Inherit** - use the compression used in the scene
Compression can positively affect system performance, but can be turned off for high-resolution textures if artifacts are visible.

**Key compress mode**
Set the compression applied to the key; can be set between
- **None** - no compression
- **S3TC** - force use of S3TC compression
- **Inherit** - use the compression used in the scene
Compression can positively affect system performance, but can be turned off for high-resolution textures if artifacts are visible.

**Use video**
When selected, you can map a video insertion onto the object. When cleared, video insertion is disabled.
A preset video enabled object is available in the Assets tab.

**Input no.**
Specify which of the available video sources is used.

**Reload**
Refreshes the current texture.

Image Textures

Image textures use a static image, mapped to an object as a texture.

To apply an image texture:

1. Apply an image texture as described in Applying Textures on page 103.
2. In the Texture tab, browse for the required Image.

You can set the following options:

<table>
<thead>
<tr>
<th>Load</th>
<th>Specify the texture file to apply to the object. Click the browse button (...) to open the required file.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use image components</td>
<td>Define the components of the image to display. <strong>RGBA</strong> - display the color and alpha components of the image; background areas are invisible, and areas with visible pixels are displayed in color. <strong>RGB</strong> - display the color components of the image. <strong>Alpha</strong> - display the alpha component of the image.</td>
</tr>
<tr>
<td>Texture compress mode</td>
<td>Set the compression applied to the texture; can be set between <strong>None</strong> - no compression, <strong>S3TC</strong> - force use of S3TC compression, <strong>Inherit</strong> - use the compression used in the scene. Compression can positively affect system performance, but can be turned off for high-resolution textures if artifacts are visible.</td>
</tr>
<tr>
<td>Reload</td>
<td>Refreshes the current texture.</td>
</tr>
</tbody>
</table>


3D Image Textures

A 3D Texture is a sequence of textures that can be sliced on different axes. It can be scaled, translated, rotated, and pivoted around all three axes; you can animate values to create the effect of moving through a material.

Aside from all the settings available for 2D image textures, you can also adjust sharpness to tweak texture sharpness (in conjunction with mipmapping settings) in order to optimize the texture appearance.
Layer Textures

A layer texture uses a layer in the scene as a texture, mapped to an object. To use a layer as a texture, you need to have at least one layer to map, and an object to map it to.

To apply a layer texture:

1. Apply an image texture as described in Applying Textures on page 103.
2. In the Texture tab, browse for the required Image.

You can set the following options:

For more information on how to display layers used as textures, see Render to on page 62.

<table>
<thead>
<tr>
<th><strong>Layers to render</strong></th>
<th>Select the scene layers to be rendered as a texture.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Size type</strong></td>
<td>Use the Size type options when working with interlaced video. Force frames - set texture resolution to full, regardless of interlaced or progressive rendering. Current - use the resolution according to the video standard (interlaced or progressive).</td>
</tr>
<tr>
<td><strong>Aspect mode</strong></td>
<td>Full Frame - Use the full canvas of the selected layer as the texture. Scale - Use the Size source parameter to scale the selected layer to the object.</td>
</tr>
<tr>
<td><strong>Size source</strong></td>
<td>Set the texture resolution that is derived from the layer. Canvas - use the same size as the current output. % of canvas - use a percentage value from the canvas as defined above; For example, 50% of an HD canvas is 960x540. Custom size - define the size in pixels.</td>
</tr>
<tr>
<td><strong>Custom X/Y size</strong></td>
<td>Specify the size of the layer texture in pixels.</td>
</tr>
<tr>
<td><strong>Background Color</strong></td>
<td>Set the color of the background of the object to which a layer texture is applied. This color is apparent only when the texture’s alpha value is greater than 0.</td>
</tr>
</tbody>
</table>

Multi-Textures

You can apply up to three textures of any type (except combo texture) to an object, with different mapping settings, using the multi-texture type. This provides flexibility, for example, when different transparency (alpha) levels are set for different parts of the object, or different textures are shown and hidden. Texture unit 1 is displayed as the back layer, and Texture unit 3 is in front.

To apply a multi-texture:

1. Apply a texture as described in Applying Textures on page 103, selecting the multi-texture type.
2. In the Texture tab, for each Texture Unit, click the texture list arrow to open the list of referenced textures.
3. If the required texture type is not in the list, right-click the list and select Create and refer, then select a texture type.
4. Click the texture button to display the texture properties in the Stack.
5. Set the texture properties as described for each texture type.
6. Set the operator to specify the type of blending to be used for the texture:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiply</td>
<td>Darken the blended image. Multiplies the foreground color by the background color for each pixel. Multiplying a color with black produces black; multiplying a color with white leaves the color unchanged.</td>
</tr>
<tr>
<td>Add</td>
<td>Increase the brightness of the foreground color by adding the value of the foreground to the background for each pixel.</td>
</tr>
<tr>
<td>Subtract</td>
<td>Darken the blended image. Subtracts the foreground color from the background color. If the result is less than 0, the color is set to 0.</td>
</tr>
<tr>
<td>Override</td>
<td>This is the scene's default blending mode. Colors are mixed to reflect the lightness or darkness of the original color.</td>
</tr>
<tr>
<td>Mix</td>
<td>Control the visibility of the texture, 0 being fully transparent, 1 being opaque. When you select Mix, the Mix factor setting is enabled.</td>
</tr>
<tr>
<td>Off</td>
<td>Hide the texture channel.</td>
</tr>
</tbody>
</table>
Reflection Textures

The reflection texture is a cubic mapping texture that gives a realistic reflection on objects, making them appear part of a real environment. The assigned texture is projected onto the surface of the object as if it is inside a cube.

The images used can be constructed using a free Nvidia DDS plugin for Photoshop. In Photoshop, the reflection texture must be created in a 6:1 aspect ratio.

**NOTE:**

▲**To create a suitable reflection texture in PhotoShop:**

1. Create a canvas with a 6:1 aspect ratio.
2. Segment your required image into six parts (faces of a cube), in the following order (from left to right): right, left, top, base, face, back.
   
   Use the following example:

   ![Reflection Texture Example](image)

3. Save in DDS format.
   
   After clicking Save, the DDS format window opens allowing you to set various options, as required.

Reflection Layer Textures

The reflection layer texture maps a layer in the scene to an object.

▲**To apply a reflection layer texture:**

1. In a scene with two or more layers, apply a texture to an object as described in *Applying Textures* on page 103, selecting the reflection layer texture type.
2. In a different layer, add the graphics that you want to reflect.
3. Select the reflective object.
4. In the **Texture** tab, open the **Rendered Layer** list.

5. Drag the layer to be reflected to the left window. The layer is mapped to the selected object.
Scene Textures

A scene texture uses a different scene as a texture, mapped to an object. To use a scene as a texture, you need to have at least one scene set up, and an object to map it to in the current scene. In the current version, you cannot play animations from the scene when it is mapped as a texture. However, you can control animations and export of a rendered scene from the controller tool (when working with an HDVG).

To apply a scene texture:

1. Apply an image texture as described in Applying Textures on page 103.
2. In the Texture tab, browse for the required Scene.

You can set the following options:

3. Click Load Scene, and then Render Scene, to see the scene applied as a texture.
### Sequence Textures

When an image sequence texture is applied, the **Texture Sequence** options become available.

**NOTE:**

*When specifying the sequence files, you must use the first file in the sequence. If you use a consecutive file, the preceding files will not be used in the sequence.*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Image</strong></td>
<td>Specify the texture file to apply to the object. Click the browse button (…) to open the required file.</td>
</tr>
<tr>
<td><strong>Use Components</strong></td>
<td>Define the components of the image to display.</td>
</tr>
<tr>
<td><strong>RGB</strong></td>
<td>display the color and alpha components of the image; background areas are invisible, and areas with visible pixels are displayed in color.</td>
</tr>
<tr>
<td><strong>RGB</strong></td>
<td>display the color components of the image.</td>
</tr>
<tr>
<td><strong>Alpha</strong></td>
<td>display the alpha component of the image.</td>
</tr>
<tr>
<td><strong>Texture compress mode</strong></td>
<td>Set the compression applied to the texture; can be set between <strong>None</strong> - no compression, <strong>S3TC</strong> - force use of S3TC compression, <strong>Inherit</strong> - use the compression used in the scene. Compression can positively affect system performance, but can be turned off for high-resolution textures if artifacts are visible.</td>
</tr>
<tr>
<td><strong>Reload</strong></td>
<td>Refresh the current texture.</td>
</tr>
<tr>
<td><strong>Run</strong></td>
<td>Select this check box to activate the animated texture sequence in a forward loop to the end of the animation according to the number set in <strong>Count</strong> (-1 = infinite).</td>
</tr>
<tr>
<td><strong>Infinite</strong></td>
<td>Select this check box together with the <strong>Run</strong> check box for continuous playback.</td>
</tr>
<tr>
<td><strong>Restart</strong></td>
<td>Restart the sequence playback from the beginning.</td>
</tr>
<tr>
<td><strong>Use / Image no.</strong></td>
<td>Select the <strong>Use no.</strong> check box to make the <strong>Image no.</strong> parameter active. Enter a specific image from the sequence as a keyframe. Using an animation, this can reverse or retimel sequence playback without re-rendering the sequence.</td>
</tr>
<tr>
<td><strong>Count</strong></td>
<td>Specify the number of times to loop the animation. (-1 = infinite).</td>
</tr>
<tr>
<td><strong>Repeat</strong></td>
<td>Set the number of times to repeat a texture in a sequence (for example, if the value is 2, then each image is kept on screen for 2 frames). This can make the texture sequence longer without rendering extra frames.</td>
</tr>
</tbody>
</table>
Applying Textures

4. Designing Your Graphics

Video Textures

A video texture uses a video insertion, and displays it on the object to which it is applied.

Transition In/Out Texture

The transition in/out textures are used to display in or out effects in a controller. Apply the transition in or transition out textures by right-clicking the Textures column in the Scene tree. For more information, see Applying Textures on page 103.

Applying Materials and Textures to Groups

Materials and textures can be assigned to group objects and then be passed to all the child objects.

To assign a material/textures to a group:

1. Remove all colors, materials and textures assigned to objects in the group (see To remove a texture: on page 104).
2. Select the Group object, and right-click in the required column in the Scene tree. A menu is displayed.
3. Select New Color/ New Texture and set the required material or texture.
   All objects inherit the same settings from the parent (group).
If you want to assign a different color, material, or texture to an object, select the object, and assign as required.

<table>
<thead>
<tr>
<th>Offset</th>
<th>Set the number of images to play; 1 plays each image, 2 plays every second image, etc. This can serve to speed up the sequence, and/or to randomize the display of the images in the sequence (by entering a number that cannot divide the number of images in the sequence without a remainder).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video</td>
<td>When selected, you can map a video insertion onto the object. When cleared, video insertion is disabled. A preset video enabled object is available in the Asset strip.</td>
</tr>
<tr>
<td>Input no.</td>
<td>Specify which of the available video sources is used (4Designer Advanced only).</td>
</tr>
</tbody>
</table>

Deformations

4Designer allows to apply different kinds of deformations to objects in the scene. These modifiers provide means to sculpt and edit objects.

To apply a deformation to an object:
1. Select the object to which you want to apply the deformation.
2. In the Deformation column in the Scene tree, right-click and select the required deformation type.
3. Set the deformation properties
   The deformation is applied to the object.

Deformations can be applied to a hierarchy of objects. Multiple modifications can be applied to a single object (also of the same type), and they will be processed one by one, in the order from top to bottom of the created list. The process of stacking deformations is illustrated below.

<table>
<thead>
<tr>
<th>1 Create and refer</th>
<th>Right-click on an empty space to create a new deformation, or to refer to a deformation from the Drag items to refer/unrefer window.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 Drag items to refer/unrefer</td>
<td>Right-click on a deformation to open the Editor Stack, clone, rename, remove, or detach the selected deformation.</td>
</tr>
<tr>
<td>3 Property Editor Stack</td>
<td>Edit the properties of the selected deformation.</td>
</tr>
<tr>
<td>4 On/off button</td>
<td>Switch the selected deformation on or off.</td>
</tr>
</tbody>
</table>
Available deformation types

Bend

The **Bend** deformation allows to bend the object in defined coordinates.

![Bend Deformation Examples](image)

- **Angle**: -20, Axis=[0,0,1], UpVector=[0,1,0]
- **Angle**: 45, Axis=[0,0,1], UpVector=[0,1,0]

Available parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Angle</strong></td>
<td>Set the angle to bend from the vertical plane.</td>
</tr>
<tr>
<td><strong>Axis</strong></td>
<td>Specify the axis to be bent.</td>
</tr>
<tr>
<td><strong>Up Vector</strong></td>
<td>Set the direction of the distortion.</td>
</tr>
</tbody>
</table>

Cubify

The **Cubify** deformation allows to morph objects into a cube.

![Cubify Deformation Examples](image)

- **Percent of morphing**: 50
- **Percent of morphing**: 100

Available parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Percent</strong></td>
<td>Set the percent of morphing.</td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td>Set the target size of the cube.</td>
</tr>
<tr>
<td><strong>Center</strong></td>
<td>Set the center of the cube.</td>
</tr>
</tbody>
</table>
CutWithPlane

The **CutWithPlane** deformation allows to remove vertices from one side of the plane and add or modify the triangles on the cut.

Available parameters:

- **Point** Set the point on the plane.
- **Direction** Set the vector perpendicular to the plane.

CutWithSphere

The **CutWithSphere** deformation allows to remove vertices inside or outside of the sphere, and add or modify the triangles on the cut.

Available parameters:

- **Center of sphere** Set the center of the sphere.
- **Radius of sphere** Set the radius of the sphere.
- **Remove inside** Set whether to remove the Interior or Exterior of the object.
Explode

The **Explode** deformation allows to move every triangle of the object away from the center of the object.

![Explode](image)

**Range**

Set the distance for moving the triangles away from the center.

**FreeFormDeformation2, FreeFormDeformation3, FreeFormDeformation4**

The **FreeFormDeformation** modifier allows to deform objects, by altering the points of the mesh surrounding the object. There are three types of the Free Form Deformations, each providing a different lattice solution: 2x2x2, 3x3x3, and 4x4x4. The 4x4x4 modifier, as an example, equips the lattice with four control points across each of its dimensions, resulting in sixteen on each side of the lattice.

![Deformations](image)

**Examples of the Free form deformations:**

*FreeFormDeformation 2*

*FreeFormDeformation 3*

*FreeFormDeformation 4*
Skew

The **Skew** deformation allows to produce a consistent offset in an object's geometry.

![Skew Examples](image)

**Available parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Angle</strong></td>
<td>Set the angle of the linear distortion.</td>
</tr>
<tr>
<td><strong>Axis</strong></td>
<td>Specify the axis that will be skewed.</td>
</tr>
<tr>
<td><strong>Up Vector</strong></td>
<td>Indicate the direction of the distortion.</td>
</tr>
</tbody>
</table>

Spherify

The **Spherify** deformation allows to morph objects into a sphere.

![Spherify Examples](image)

**Available parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Percent</strong></td>
<td>Set the percent of morphing.</td>
</tr>
<tr>
<td><strong>Radius</strong></td>
<td>Set the target radius of the sphere.</td>
</tr>
<tr>
<td><strong>Center</strong></td>
<td>Set the center of the sphere.</td>
</tr>
</tbody>
</table>
Taper

The **Taper** deformation produces a tapered contour by scaling both ends of an object's geometry. When one end is scaled up, the other one is scaled down. You can control the amount and the curve of the taper on two sets of axes.

![Taper Deformation Examples](image)

Available parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Amount</strong></td>
<td>Set the extent to which the top is scaled.</td>
</tr>
<tr>
<td><strong>Curve</strong></td>
<td>Apply a curvature to the sides.</td>
</tr>
<tr>
<td><strong>Axis</strong></td>
<td>Set the central axis or spine of the taper: X (0), Y (1), or Z (2).</td>
</tr>
<tr>
<td><strong>Effect</strong></td>
<td>Set the axis, or pair of axes, indicating the direction of the taper from the primary axis. The available choices are determined by the choice of the primary axis. The effect axis can be either one of the two remaining axes, or their combination. If the primary axis is X, the effect axis can be Y (1), Z (2), or YZ (3).</td>
</tr>
</tbody>
</table>

Tessellation

The **Tessellation** deformation divides every triangle of the object into sub-triangles. To better see the results, it is recommended to change the Polygon mode of the shape to **Lines**.

![Tessellation Deformation Examples](image)

Available parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Flat</strong></td>
<td>Enable this option to sub-divide the triangles without changing the shape. With this option disabled, the deformation tries to reconstruct the curvature of the geometry.</td>
</tr>
<tr>
<td><strong>Subdivision Factor</strong></td>
<td>Set the value (min 1, max 32) of the subdivision factor.</td>
</tr>
</tbody>
</table>
TriangleFlatten

The **TriangleFlatten** geometry allows to replace the normal of each vertex with a common value (being average of all triangle normals).

![TriangleFlatten images]

Available parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Volume</strong></td>
<td>Enable the volume to multiply the transformation by the volume factor.</td>
</tr>
</tbody>
</table>

TriangleToGeometry

The **TriangleToGeometry** deformation turns each triangle of the object into geometry.

![TriangleToGeometry images]

Available parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sides</strong></td>
<td>Set <strong>Common</strong> to join all triangles after deformation, or <strong>Separated</strong> to keep them detached.</td>
</tr>
<tr>
<td><strong>Height</strong></td>
<td>Set the height of the modification.</td>
</tr>
<tr>
<td><strong>Volume</strong></td>
<td>Enable the volume to multiply the transformation by the volume factor.</td>
</tr>
</tbody>
</table>
TriangleTransform

The TriangleTransform deformation allows to apply a transformation to each triangle of an object.

Available parameters:

<table>
<thead>
<tr>
<th>Transformation</th>
<th>Create and refer to a new transformation.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coordinate system</td>
<td>Set the coordinate system to <strong>Object</strong>, when the transformation of the nodes defines the coordinates’ system. Set it to <strong>Normal</strong>, when the normal defines the coordinates’ system.</td>
</tr>
<tr>
<td>Volume</td>
<td>Enable the volume to multiply the transformation by the volume factor.</td>
</tr>
</tbody>
</table>

Twist

The Twist deformation allows to twist the object in defined coordinates.

Available parameters:

<table>
<thead>
<tr>
<th>Angle=25, Bias=0.2</th>
<th>Angle=25, Bias=0.8</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Angle</strong></td>
<td>Set the amount of twist around the vertical axis.</td>
</tr>
<tr>
<td><strong>Axis</strong></td>
<td>Set the axis along which the twist will appear.</td>
</tr>
<tr>
<td><strong>Bias</strong></td>
<td>Define the curvature of the twisted edge.</td>
</tr>
</tbody>
</table>
**VertexTransform**

The *Vertex Transform* transformation allows to apply modifications per vertex of an object.

![Example images]

**Available parameters:**

<table>
<thead>
<tr>
<th><strong>Transformation</strong></th>
<th>Create and refer to a new transformation.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Coordinate system</strong></td>
<td>Set the coordinate system to <strong>Object</strong>, when the transformation of the nodes defines the coordinates’ system. Set it to <strong>Normal</strong>, when the normal defines the coordinates’ system.</td>
</tr>
<tr>
<td><strong>Volume</strong></td>
<td>Enable the volume to multiply the transformation by the volume factor.</td>
</tr>
</tbody>
</table>
Lighting

Light objects determine the type of lighting in a scene. Lights can be a general part of a scene, or be connected to a specific object. Setting lighting preferences is done in the Light editor.

You can add lights to your scene and define the light parameters. Position light objects to set the overall lighting in the scene, or attach one or more lights to material properties to be used for specific objects (see Using Lights for a Material on page 102). The first light is the default when any object is used.

Fields relevant to the **Light** tab:

| **On** | Define if the light effect is On (selected) or Off (cleared). |
| **Type** | Defines the light type as **Infinite**, **Point** or **Spot**. Selecting **Spot** enables the **Cutoff** and **Exponent** parameters. |
| **Cutoff** | Specifies the distance from the light at which the spotlight ceases to illuminate the scene. |
| **Exponent** | Specifies the transition between the hard and soft parts of the spotlight. |
| **Attenuation** | Enables you to adjust the light attenuation (light intensity over a distance) for spot and point lights. You can specify the amount of Constant, Linear, or Quadratic attenuation. |
| **Diffuse, Specular, Ambient** | Select the required box to specify for a light component. |
| **Color** | Edit the color properties of the color aspect. |
Shadows

Two kinds of shadows are available in 4Designer; simple drop shadows that are applied to an object (fake shadow), and real-time cast shadows that are achieved by setting different objects to be the projector, caster, and receiver.

Applying a Fake Shadow

To apply a fake shadow:

1. With the object selected, right-click the Projectors column in the Scene Tree and select New Projectors > Fake Shadow.

2. In the Projectors editor, select the Fake Shadow On check box.

3. Set the softness, shadow offset and coloring, as required.
Applying a Cast Shadow

The appearance of cast shadows is affected by the object set to cast the shadow, the object set to display shadow, and the type of light and other settings set in the Projectors editor.

To set a cast shadow for an object:

1. Place a light object in the scene, or select the existing light.
2. Right-click in the Projectors column in the Scene tree, and select New Projectors > Shadow Projector to set the specific light as a projector.
3. Select the object that you want to cast the shadow.
4. Right-click in the Projectors column in the Scene tree, and select Shadow Caster.
5. Select the object on which the shadow will be cast.
6. Right-click in the Projectors column in the Scene tree, and select Shadow Receiver.
   A shadow is now visible on the receiving object (provided the projector, caster, and receiver are in position).
7. Select the light object, select the Projectors editor, and set the following parameters as required.
**View Mode**  
The View Mode defines projector viewing volume. This is an analogy to the camera settings. Compared to the camera, the projector doesn’t have position and orientation definition because it will be taken from transformation defined in the node to which the projector is referring. I.E., if you have a sphere and set that to be a projector, its position / rotation will control how the light is cast.

- **Auto** - the projector automatically checks what type of light is referred in the node (object) and sets appropriate viewing method.
- **Perspective** - the light is cast as a single bean pointed in one direction.
- **Orthographic** - the light is cast without regard to object distance from the light source, making shadow size constant.
- **Cubic** - the light is cast as if the source is within a cube (that can be textured). If the cube is moved or rotated, the shadow is cast accordingly.

**Near**  
Set the near limit of where the light falls.

**Far**  
Set the far limit of where the light falls.

**Vertical FOV**  
Set the angle limits of the height of the light source (default=45 degrees).

**Aspect**  
Set the aspect ratio of the light source.

**Smoothness**  
The blurring of the shadows cast from the projector. The range of the blurring is 0-50 texels.

**Resolution**  
Set resolution in order to eliminate aliasing from shadows. The projector will automatically try to fit shadow texture resolution to the output resolution. If required, you can override the automatic behavior and set the value as required.

**Color**  
Define color and transparency of the shadow.
Mirroring Objects

Mirroring is used to create a mirror image of an object. The mirror image is referred to
the original object. Its size, location, color, etc. change in relation to the original
object.

💡 TIP
The Mirror scene, installed with 4Designer, contains an example of how mirroring
can be used.

➢ To mirror an object:

1. Select the object in the Scene Tree.

2. Select **Tools > Mirror**.

   The **Mirror Tool** is displayed.

3. Select the direction in which to mirror the object;

   - **Vertical** Create a vertically mirrored object.
   - **Horizontal** Create a horizontally mirrored object.
   - **In Depth** Create an object mirrored on the Z axis.

4. Select or clear additional options;

   - **Fix Lights** Adjust lighting appropriately for lights that are selected in the
     Scene Tree with the original object. When this option is cleared, lighting is not adjusted.
   - **Connect Separated Materials** Mirror color and texture properties as well as placement and size
     properties. When this option is cleared, only placement and size properties are mirrored.

5. Click **OK**.
The Advanced Window

In addition to editing properties in the Editor, you can open the Advanced window to display and edit all available parameters given to an object. This window contains all properties available in the Editor, and sometimes more advanced properties, as well.

**To edit parameters in the Advanced window:**

1. Open the Advanced window.
2. Select a property in the Scene Tree or in the Properties tab, as required.
   The parameters of the selected property are displayed in the window.
3. Edit the Value of the required parameter.

Applying Properties from the Properties Tab

The Properties tab provides a quick way to apply a specific set of properties used in the scene, such as Color or Transformation, to other objects.

**To apply a set of properties:**

1. In the Properties tab, select to filter the properties by active pool type.
2. In the Scene Tree, select the required column.
   All properties used in the scene of the selected type are displayed in the Properties tab.
3. Drag the required set of properties to the target object.
   The properties are applied to the object.
Using a Tracking File

You can reference a camera tracking file created by a TrackingSet recorder in order to preview changing camera paths, and export the path to the Controller application. This allows you to check the appearance of your graphics from the angles recorded by the camera. **Use Tracking** must be selected in the **Camera** editor.

**To set a tracking path file for a camera:**

1. In the Scene tree, select a layer.
2. In the **Camera** editor, select **Use Tracking**.
   The Tracking parameters are enabled.

3. Click ... to browse to the required **Tracking file**.
   Tracking files are saved with a .TSREC extension.
   Once the file is loaded, time and segment data is displayed in the **Properties** tab, from the tracking file.

**To view camera tracking:**

1. Select Play in the tracking file parameters.
2. Click **Play** to play the tracking file from the beginning.
   To stop tracking, click **Stop**.
   To continue from stopping point, click **Continue**.
   To jump to beginning, click **Rewind**.
Depth Buffer

Just as you can set depth buffer settings for a layer (see Depth Buffer on page 68), you can set them for individual objects.

The result of the settings described in this section are affected by separate factors:

- The object hierarchy in the Scene tree.
- The Z-position of each object.

To set the depth settings for an object:

1. Select the object.
2. In the Depth Buffer editor, set the Compare depth function, as required:

<table>
<thead>
<tr>
<th>Inherit</th>
<th>Depth buffering settings are inherited from the parent object or from the scene.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Never</td>
<td>The object is never displayed.</td>
</tr>
</tbody>
</table>
| Less    | The object is always visible. If the object's place in the Scene tree's hierarchy is lower than the place of other objects, then:  
- The object is displayed in front of other objects when its Z-position is greater than the Z-position of other objects.  
- The object is displayed in back of other objects when its Z-position is identical to or less than the Z-position of other objects.  
If the object's place in the Scene tree's hierarchy is higher than the place of other objects, then:  
- The object is displayed in back of other objects, regardless of its Z-position. |
| Less Equal | The object is always visible, as described for the Less setting, with the following exception:  
If the object's place in the Scene tree's hierarchy is lower than the place of other objects, and its Z-position is identical to the Z-position of other objects, then the object is displayed in front of other objects. |
| Greater | The object is visible only in front of other objects, and only in other object’s display area, when all the following conditions are met:  
- The object's (X,Y) position overlaps other objects.  
- The object's place in the Scene tree's hierarchy is lower than the place of other objects, and—  
- The object’s Z-position is less than the Z-position of other objects.  
In all other cases, the object is not visible. |
| Greater Equal | The object is displayed as described for the Greater setting, and is also visible when the object's Z-position is identical to the Z-position of other objects. |
Equal  The object is visible only in front of other objects, and only in other object’s display area, when all the following conditions are met:
- The object's (X,Y) position overlaps other objects.
- The object's place in the Scene tree's hierarchy is lower than the place of other objects, and–
- The object's Z-position is identical to the Z-position of other objects.
In all other cases, the object is not visible.

Not Equal  The object is always visible.
If the object's place in the Scene tree's hierarchy is lower than the place of other objects, then:
- The object is displayed in back of other objects when its Z-position is identical to the Z-position of other objects.
- If the Z-position is not identical, then the object is displayed in front of other objects.
If the object’s place in the Scene tree's hierarchy is higher than the place of other objects, then:
- The object is displayed in back of other objects, regardless of its Z-position.

Always  The object is always visible.
If the object's place in the Scene tree's hierarchy is lower than the place of other objects, then:
- The object is displayed in front of other objects.
If the object's place in the Scene tree's hierarchy is higher than the place of other objects, then:
- The object is displayed in back of other objects.

3. Set Draw in depth. When marked “✓”, the object inherits its setting from the layer. When selected, the object is always shown in color, when cleared the object is not shown, both regardless of the scene/layer setting.

4. Set Clear as required.
When this check box is selected, information regarding the Z axis is not considered between the current layer and the next layer in the Scene tree, so that each layer is rendered independently.
When this check box is cleared, the scene retains the relativity between layers for rendering.
Examples of Object Display Using the Depth Buffer:

The following examples use three objects to illustrate the effects of the depth buffer settings. The numbers reflect each object's place in the Scene tree hierarchy.

**Less**: in the left image, the Z-position of object 2 is greater than the other objects. In the right image, the Z-position is less or identical.

**Greater**: in this image the Z-position of object 2 is less than the other objects.

**Equal/Not Equal** settings shown with identical Z-positions.
Adding Particles to a Scene

**NOTE:**
Using particles requires a separate RenderEngine license. For more information, contact Avid support.

4Designer enables you to add a flying particle effect to a scene. In order to see the effect, the particle object must be set as **Active**.

**To add particles:**

- Drag the Particle object from the **Assets** (under **Miscellaneous**) to the Scene tree or RE window.

The Particle parameters are displayed in the **Shape** editor.

Set the Particle object properties as follows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Active</strong></td>
<td>Select this check box to allow particle emission (when the refresh parameter is animated), or clear to freeze the emission actions.</td>
</tr>
<tr>
<td><strong>Particle Count</strong></td>
<td>Define the number of particles that are emitted in each cycle of particle emission.</td>
</tr>
<tr>
<td><strong>Start Colors</strong></td>
<td>Set the color of the particles, when they are first emitted.</td>
</tr>
<tr>
<td><strong>End Colors</strong></td>
<td>Set the end color of the particles, if they are displayed in slow mode.</td>
</tr>
<tr>
<td><strong>Color Variation</strong></td>
<td>Set the level of variation for particle color. 0=0% variation, and 1=100% variation.</td>
</tr>
</tbody>
</table>
Adding Particles to a Scene

4. Designing Your Graphics

- **Speed X, Y, Z**: Defines the speed of particle movement along each axis, measured in scene units per second. This setting only affects the next cycle of particle emission, not the current emission.

- **Speed Variation X, Y, Z**: Define the level of particle speed variation. 0=0% variation, and 1=100% variation.

- **Slowdown**: Define the rate at which particle movement slows after the initial emission.

- **Distort X, Y, Z**: Define the range of particle dispersal along the X, Y, Z axes.

- **Distort Shift X, Y, Z**: Define a shift for the particle dispersal range along the X, Y, Z axes.

- **Center X, Y, Z**: Define the offset from the particle object center along the X, Y, Z axes.

- **Pulse**: Select this check box to display the particles in bursts. The animation plays out completely, before the next loop begins.

- **Use Once**: When selected, this setting limits particle emission to one time. I.e., the animation appears to be played once, regardless of any loop settings. However, RenderEngine continues to run the animation, even when no particles are emitted.

- **Life (sec.)**: Set the length of time, in seconds, for which each particle is displayed. This setting is affected by the Life Variation setting.
### Adding Particles to a Scene

#### 4. Designing Your Graphics

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Life Variation</strong></td>
<td>Set the level of variation of each emission length. 0=0% variation, and 1=100% variation.</td>
</tr>
<tr>
<td><strong>Fade in (sec.)</strong></td>
<td>Set the fade in time of each particle, in seconds.</td>
</tr>
<tr>
<td><strong>Fade out (sec.)</strong></td>
<td>Set the fade out time of each particle, in seconds.</td>
</tr>
<tr>
<td><strong>Simultaneous Factor</strong></td>
<td>When this setting is set to 1, the number of particles set in <strong>Particle Count</strong> are emitted in one burst, and when they fade out, another burst is emitted until the emission cycle is finished. When set to 0, the number of particles set in <strong>Particle Count</strong> are emitted during the emission cycle.</td>
</tr>
<tr>
<td><strong>Dimension x, Y, Z</strong></td>
<td>Define the particle emitter dimensions, along the X, Y, Z axes.</td>
</tr>
<tr>
<td><strong>Start Size</strong></td>
<td>Set the starting size of the particles (i.e., their size when they are first emitted).</td>
</tr>
<tr>
<td><strong>End Size</strong></td>
<td>Define the end size of the particles.</td>
</tr>
<tr>
<td><strong>Size Variation</strong></td>
<td>Define the level of particle size variation. 0=0% variation, and 1=100% variation.</td>
</tr>
<tr>
<td><strong>Gravity X, Y, Z</strong></td>
<td>Define the pull affecting the particle stream along the X, Y, Z axes.</td>
</tr>
</tbody>
</table>

- **Generation Volume**
  - **Dimension X**
  - **Dimension Y**
  - **Dimension Z**

- **Size Environment**
  - **Gravity X**
  - **Gravity Y**
  - **Gravity Z**
Adding Particles to a Scene

4. Designing Your Graphics

Limits

Define the limits of an area in which the emitted particles exist. Select one of the Use Min/Max check boxes as specified in the Min/Max value fields. Select one of the Use Relative Min/Max check boxes to set the limit relative to the position of the emission source. Use Muffle to set the bounciness of the particles off of the limits that you set.

<table>
<thead>
<tr>
<th>Limits</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Muffle</td>
<td>0.10</td>
</tr>
</tbody>
</table>
5. Working with Text

In this section:

- *Creating Text and Text Deco Objects* on page 143
- *Setting Text Size and Density* on page 147
- *Decorative Text* on page 149
- *Animating Text Characters – Text Effects* on page 154
- *Ticker Objects* on page 157
- *Clock Objects* on page 159
- *Countdown Clock* on page 162
- *Subtitles* on page 163
Creating Text and Text Deco Objects

In 4Designer you can create text objects and then add various properties, such as three dimensions, color, texture, and many other properties for controlling the look and feel of your text.

A text deco object is a text object with decoration presets. Edit a text deco object as you would edit a standard text object. See also Decorative Text on page 149.

To create a text object:

1. From the Assets tab, select a Text or TextDeco object, and drag it into the Preview window or the Scene tree.

2. In the Shape editor, specify the object parameters as required.

The following options are displayed:

| Font | Select the font family from the available fonts for the text objects. Set bold and Italics for the text style. For more information, see Available Fonts on page 145. |
| Character size | Set font size for individual characters within the text object, according to the currently selected character/s in the text editor. (Enabled when Allow Style Modifiers is selected.) Values represent Em measurements. |
| Text editor | Edit, align, emphasize, underline the text, apply super and subscript, etc. |
| Kern Pairs | Enable pair kerning for text – depending upon the pairing of letters this may reduce the space between them. For example, A and V can be placed closer together so that the top left of the V is directly above the bottom right of the A. |
| Mono spaced | Apply monospacing to the text. |
| **Allow Style Modifiers** | Select this check box to apply different formats to text within the same object. When this check box is selected, additional formatting controls above the Input box for font face, font size, bold, italic, and alignment. You can format any text within the object, as required. When this check box is cleared, you can only set formatting for the object. For more information, see *Available Fonts* on page 145. |
| **Size** | Set the size of the text characters. This property can be set to **Poster, Base Title** (=default), **Ticker** and **Pica**. This value affects the font resolution and appearance, and is independent of object scale. Linked to the Font Size. For more information, see *Setting Text Size and Density* on page 147. |
| **Capitalization** | Set the capitalization style for the text; **Normal**–display text as typed, **Small Caps**–display text in small capitals, **All Caps**–display text in normal sized capital letters, **All Small**–display text entirely in lower case letters, **Title case**–display text with first letter in each word capitalized. |
| **Type (of text box)** | **Auto** – Automatically scale the size of the text box according to the length of text entered. **Word wrap** – Enable word wrapping. A red bounding box will appear around the text, indicating the width of the wrapping area. **Shrink to fit** – Fit all entered text into the area specified by the width parameter. **Shrink and wrap** – Fit all entered text into a horizontally and vertically defined space. |
| **Font Size** | Set the detail level of the text. For more information, see *Setting Text Size and Density* on page 147. |
| **Kerning** | Set the spacing (overlap) between characters. |
| **Width** | Set the width of the text box. (When the type of text box is **Auto**, the width cannot be adjusted.) |
| **Skew** | Set the tilt, i.e., the angle of skew (in degrees) that is applied to text. |
| **Leading** | Set the spacing between lines of text. |
| **Height** | Controls the height of the text box. (When the type is **Auto**, the height cannot be adjusted.) |
| **Text Style** | Select a predefined text style from the list to apply to the object. For more information, see *Predefining Styles and Decorations* on page 145. |
| **Text Decoration** | Select predefined text decoration from the list to apply to the object. For more information, see *Predefining Styles and Decorations* on page 145. |
Creating Text and Text Deco Objects

5. Working with Text

Available Fonts

A red dot next to a font name in the font list, means that this font is installed in the 4Designer font folder (\g:\fonts) but not in the system fonts folder (c:/windows/fonts). This does not affect the final output, only the text displayed in the text entry field. You can correct this issue by installing the indicated fonts from 4Designer font folder into the system fonts folder.

Predefining Styles and Decorations

You can predefine a style or decoration for quick application to text objects in the same scene. A new default text style/decoration is added for every text object added to the scene (called NewText style or New Decoration), and numbered according to the order in which the object is added to the scene. Available styles/decorations are displayed in each list; click the arrow next to Text style or Text decoration to see the list.

To predefine a text style:

1. In the Shape editor, click Text style.

   The style properties are displayed in the Stack.

2. Set the required style properties.
This style can be applied to any text object in the scene, by selecting the object, and then selecting the style name.

**NOTE:**
For a style, you can set the Horizontal and Vertical scale of the text. This scale is independent of transformation scaling. Use this when you want to scale all text objects that share the same style.

▷ To add a new text style or decoration:
1. Click the arrow to open the style or decoration list.
2. Right-click the list.
3. Select *Create and refer* to create a new style and refer it, or *Clone and refer* to create a clone from the current style and refer it.
   The style/decoration is added to the list. (You must select it and click the respective button to apply it.)

▷ To predefine a text decoration:
1. Click *Text decoration*.
   The decoration properties are displayed in the **Stack**.
2. Set the required decoration properties.
   This decoration can be applied to any text object, by selecting the object, and then selecting the decoration name.

▷ To remove or rename styles/decorations:
- In the list, right-click the relevant style/decoration.
Setting Text Size and Density

In the **Shape** editor of a text object there are two settings—**Size** and **Density**—each with four possible options; **Poster, Base Title, Ticker** and **Pica**.

For the best text rendering, assign the most appropriate style according to the size of text required on screen. By default, the **Size** and **Density** properties are locked, so that the text size fits the current density (i.e., resolution). You can unlock the properties, but the text quality might not be optimal.

In this example, the **Size** of both objects is **Base Title**, but the **Density** is different.

It is better to change the size of text using the **Size** property, rather than scaling the object in the Transformation strip, for the best text rendering.

In this example, the lower object’s size and density is set to **Ticker**, and it has been scaled up to be as large as the **Base Title** object.
The same applies when scaling down. In this example, the upper object’s size and density is set to Poster, but it has been scaled down to be as small as the Pica object.
Decorative Text

The decorative text options provide effects for text objects. In the Stack, set the object to Emoticons or 3D Text and apply decoration effects as required by selecting the check boxes.

2D Text

2D text is geometry-based, and has no depth. This type of text object has a much sharper look when the object is enlarged. You can apply various types of decoration. Depending on the selected effect, the Decoration area looks something like this:

The following properties can be set for 2D text objects in the Stack:

**Background**
Set a background for the text object, by selecting this check box. When you select Background, you can set:
- **Vertical margins** - set the margins of the background, added above and below the text object.
- **Horizontal margins** - set the margins of the background, added at either side of the text object.
- **Opacity** - set the opacity of the background separately from the rest of the text.
- **Color Override** – set the color of the background separately from the rest of the text.
- **Texture Override** – apply a texture as the background separately from the rest of the text.

For more information, see Applying a Texture as Text Decoration on page 151.

**Bevel**
A bevel is an effect that gives the text object’s edge a 3D look. Select the Bevel check box to display the bevel effect or clear the check box to hide it.
When you select Bevel, you can set:
- **Size** – the size of the bevel effect in pixels.
- **Direction** – of the bevel effect in degrees.
- **Opacity** – of the bevel effect(0-1).
- **Color Override** – set the color of the bevel separately from the rest of the text.
- **Texture Override** – apply a texture as the bevel separately from the rest of the text.
**Border**

The defining border of the fonts.

Select the **Border** check box to display the border or clear the check box to hide it.

When you select **Border**, you can set:

- **Size** – set the border width. Range is 0-10 pixels.
- **Opacity** – set the opacity of the text border.
- **Color override** – set the color of the text border separately from the rest of the text.
- **Texture override** – apply a texture as the text border separately from the rest of the text.

For more information, see *Applying a Texture as Text Decoration* on page 151.

**Glow**

The glow effect of the text, adds pixels beyond the text border.

Select the **Glow** check box to display a glow effect or clear the check box to hide it.

When you select **Glow**, you can set:

- **Size** – set the glow width. Range is 0-10 pixels.
- **Smooth** – define how blurred the glow effect’s edges are. Range is 0-10.
- **Opacity** – set the opacity of the glow effect.
- **Color override** – set the color of the glow effect.
- **Texture override** – apply a texture as the glow effect. For more information, see *Applying a Texture as Text Decoration* on page 151.

**Shadow**

You can display a shadow for the text, in a chosen direction.

Select the **Shadow** check box to display a shadow or clear the check box to hide it.

If **Shadow** is selected, you can set:

- **Size** – set the shadow width. Range is 0-10 pixels.
- **Smooth** – define how blurred the shadow edges are. Range is 0-10.
- **Distance** – controls the distance of the shadow from the object
- **Direction** – controls the direction of the light source relative to the object.
- **Opacity** – set the opacity of the shadow.
- **Color override** – set the color of the shadow.
- **Texture override** – apply a texture as the shadow.

For more information, see *Applying a Texture as Text Decoration* on page 151.

**Text**

Select the **Text** check box to display the fill of the fonts, or clear it to hide the fill.

- **Opacity** – set the opacity of the fill.
- **Color override** – set the color of the fill.
- **Texture override** – apply a texture as the fill.

For more information, see *Applying a Texture as Text Decoration* on page 151.
Applying a Texture as Text Decoration

You can apply a texture to a text object, as you would to any primitive object, as described in Applying Textures on page 103.

For decorated text, you can apply a texture for an effect in the Stack.

To apply a texture:

1. Click Text decoration to display the Text decoration effects in the Stack.
2. For any of the effects, select the Texture override check box.
3. From the drop-down list, choose a texture to apply.
   - The texture is applied.
   - If no texture has been referenced in the drop-down list, or if you want to reference a new image, clip or animation, proceed as follows:
     a. In the drop-down list, right-click and select Create and refer.
     - A list of texture types is displayed.
     b. Select the required texture type.
     - A new texture is added to the drop-down list.
     c. Click Texture override.
     - The texture properties are displayed in the Stack.
     d. Edit the properties as required. For more information, see Common Texture Properties on page 105.

Emoticons

4Designer can implement emoticons using the following file:

G\ResourcesRE\Emoticons\Emoticons.xml.

By default this file references a folder containing graphic files provided with 3Designer. You can use your own emoticons by changing the path of the referenced folder, and the names of the files that each unicode sequence refers.

In the file, emoticons like ":))" should precede ":)", because the first matching emoticon is used; otherwise ":))" will appear as a ":)" graphic with the ")" symbol.

Errors may also be caused by the use of the "<" sign.

To display emoticons:

1. Click Text decoration to display the Text decoration effects in the Stack.
2. Select Use Emoticons.
3D Text

Choose 3D from the Text decoration properties in the Stack to create three dimensional text objects that can be seen from any camera angle, and decorated as required.

**NOTE:**
*Emoticons are not supported for 3D text objects, and are not displayed correctly.*

For a three dimensional text object, you can set effects for different angles of the object, and you can edit the beveling as required. Depending on the selected effect, the Decoration area looks something like this:

For 3D text you can edit the following properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Back** | Set how the back side of the text object is displayed. If this check box is selected, you can set:  
**Override** – apply a texture to the back face. For more information, see *Applying a Texture as Text Decoration* on page 151.  
**Override color and opacity** – set the color and opacity of the back face. |
| **Body** | Set how the body, i.e., sides of the text object are displayed. If this check box is selected, you can set:  
**Override** – apply a texture to the body. For more information, see *Applying a Texture as Text Decoration* on page 151.  
**Override color and opacity** – set the color and opacity of the body. |
| **Front** | Set how the front face of the text object is displayed. If this check box is selected, you can set:  
**Override** – apply a texture to the face. For more information, see *Applying a Texture as Text Decoration* on page 151.  
**Override color and opacity** – set the color and opacity for the face. |
<table>
<thead>
<tr>
<th>Bevel</th>
<th>Define the shape of the cross section of the text. You can choose a predefined bevel or design your own. Here you can also set:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Complexity</strong></td>
<td>the number of facets the body has. These facets can be seen only when a material is applied to the object.</td>
</tr>
<tr>
<td><strong>Width</strong></td>
<td>the width of the back face of the text object.</td>
</tr>
<tr>
<td><strong>Height</strong></td>
<td>the depth of the text object.</td>
</tr>
<tr>
<td><strong>Start</strong></td>
<td>where the text appears in relation to the bounding box (in front, or behind).</td>
</tr>
<tr>
<td><strong>Smooth</strong></td>
<td>select this check box to smooth the edges of the section. For more on extrusions, see <em>Cut Editor</em> on page 94.</td>
</tr>
</tbody>
</table>
Animating Text Characters – Text Effects

In addition to being able to animate text objects as any other primitive object, the characters within text objects can be animated for various in- and out-effects when playing a scene.

To apply an existing text animation:

1. In the Assets, in the Miscellaneous tab, open the Text Effects folder.
2. Drag a text effect to the Text Effect column of the required text object in the Scene Tree.
   The effect is applied to the object, and can be previewed using Play in the Animation strip.

To create a text effect from scratch:

1. In the Scene Tree, right-click the text object in the Text Effect column.
   A non-defined effect is applied to the text object, and the Text Effect editor is displayed.
Edit the following text effect properties as required, setting keyframes in order to animate character display;

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Duration mode</strong></td>
<td><em>Linear</em> – animate the text along the timeline, with time shifts between the letters as set in the Time Shift parameter. Duration is calculated by the number of keyframes and the total of time shifts, and cannot be set definitively. Scale - animate the each character for the duration of the keyframe animation (scale animation time to the effect time). This is useful, for example, when a text object has a large number of characters and the animation should play until all characters are displayed. Shrink – animate the text for the duration of the time set under Max Duration. Time shifts and keyframes are reduced proportionately. Scale to duration – animate the text for the duration of the time set under Max Duration. Time shifts and keyframes are extended proportionately.</td>
</tr>
<tr>
<td><strong>Order</strong></td>
<td>Set the order in which the characters are animated: Left to right - animate the characters on the left first. Right to left - animate the characters on the right first. In to Out - animate the characters from the center, outwards, as set in the effect. Out to In - animate the characters from the ends, inwards, as set in the effect. In to Out Symmetrical - animate the characters from the center, outwards, relative to character position. Out to In Symmetrical - animate the characters from the ends, inwards, relative to character position.</td>
</tr>
<tr>
<td><strong>Time Shift</strong></td>
<td>Set the pause between displaying each character in the text object, in seconds.</td>
</tr>
<tr>
<td><strong>Max Duration</strong></td>
<td>Set the total duration of the text animation. This can only be used when using Shrink/scale to duration timing.</td>
</tr>
<tr>
<td><strong>Alpha</strong></td>
<td>Set the transparency of the characters in the text object.</td>
</tr>
<tr>
<td><strong>Text Coordinates Position</strong></td>
<td>Set the position of the text in the object on the X, Y, and Z axes. (This is not the position of the bounding box itself).</td>
</tr>
<tr>
<td><strong>Text Coordinates Rotation</strong></td>
<td>Set the rotation range of all characters in the text object on the X, Y, and Z axes, relative to the first character.</td>
</tr>
<tr>
<td><strong>Text Coordinates Scale</strong></td>
<td>Set the scale of the characters in the text object on the X, Y, and Z axes, relative to the first character.</td>
</tr>
<tr>
<td><strong>Scale Lock</strong></td>
<td>Lock the scale along the selected combination of axes to maintain the proportion between any axes.</td>
</tr>
<tr>
<td>Letter Coordinates Position</td>
<td>Set the position of each character in the text object relative to the X, Y, and Z axes.</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>The difference between the text coordinates and letter coordinate positions can be seen only when certain Y/Z rotation is applied.</td>
</tr>
<tr>
<td>Letter Coordinates Rotation</td>
<td>Set the rotation range of each character in the text object on the X, Y, and Z axes, relative to its pivot.</td>
</tr>
<tr>
<td>Letter Coordinates Pivot</td>
<td>Set the each character pivot point, to be used when animating rotation. Set the value from 0.0-1.0 to place the pivot inside character bounds. A higher value moves the pivot outside character bounds.</td>
</tr>
<tr>
<td>Letter Coordinates Scale</td>
<td>Set the scale of each character in the text object on the X, Y, and Z axes, relative to the center of each character.</td>
</tr>
<tr>
<td>Scale Lock</td>
<td>Lock the scale along the selected combination of axes to maintain the proportion between any axes.</td>
</tr>
</tbody>
</table>
Ticker Objects

A ticker object is a group object with specific properties that allow you to display data in a horizontally or vertically moving display. You can update this data continuously within the ticker framework, which contains unique or repeatable objects.

For example, a typical ticker object is a horizontal running bar of stock quotes. The ticker might include two text objects and a cone object:

**Text1** - Name of a company whose stock is traded on the stock exchange.
**Text2** - Updated stock quote for this company.
**Cone1** - A cone object, pointing upward and colored green represents an increase in the stock quote, or pointing downward and colored red to represent a decrease in the stock quote.

**To create a Ticker object:**

1. From the **Assets**, drag a Ticker object to the Scene Tree or the RE Window.
2. To add objects to the ticker, drag any primitive object into the ticker group in the **Object Tree**.
   
   To correctly position multiple objects in the ticker, connect the left/right bounding box of one object to the position of the next object in the ticker as follows:
   
   a. Select the first object in the ticker.
   
   b. In the **Object** editor, under **Bounding Box**, select the **Right** extension button, and select **Out Parameter**.
   
   c. Select the second object in the ticker.

   d. In the **Transformation** strip or the **Transformation** editor, select the **X** position extension button, and select **In Parameter**.

   e. In the **Connections** window, verify that the first object is the **Source** and the second object is the **Target**.

   f. Click **Connect**.

   When the right edge changes, the object is positioned correctly. Set the offset between objects in the **Pivot** transformation as required.

7. To set overall ticker properties, open the **Shape** editor.

Editing a Ticker Object

The Ticker object is a container that animates other objects to run as a ticker display. Objects in the ticker can be displayed multiple times. Each instance of an object in the ticker is called a Clone.

For example, if you have a ticker with a single text object inside, this text would be cloned multiple times for each piece of data.

The item count is the number of clones to create in the queue; usually five is enough. If the objects are very small, you might see an empty space in the ticker when you send your data because the queue is too short.
The ticker is edited in the Shape editor:

<table>
<thead>
<tr>
<th>Run / Stop / Continue</th>
<th>Control the playback of the ticker object.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speed</td>
<td>Set the speed at which the template clone moves through the visible area.</td>
</tr>
<tr>
<td>Show Ticker Group</td>
<td>Select this check box to display ticker content, or clear to hide ticker content, which is used to create each of the text instances. This is only required for authoring.</td>
</tr>
<tr>
<td>Rebuild Ticker</td>
<td>Click Rebuild Ticker after adding a new item to the ticker, to update ticker contents on-screen. All ticker instances and exports are re-linked.</td>
</tr>
<tr>
<td>Direction</td>
<td>Set the direction and orientation of the ticker object (Left-to-Right, Right-to-Left, Bottom-to-Top, Top-to-Bottom, Into-the-Screen and Out-of-the-Screen).</td>
</tr>
<tr>
<td>Width</td>
<td>Set the width of the ticker object (for objects other than text, the orange box).</td>
</tr>
<tr>
<td>Height</td>
<td>Set the height of the ticker object.</td>
</tr>
<tr>
<td>Depth</td>
<td>Set the depth of the ticker object.</td>
</tr>
<tr>
<td>CloneOffset</td>
<td>Set the offset (distance) between clones (text instances).</td>
</tr>
<tr>
<td>Item Count</td>
<td>Set the number of repeatable items that can be displayed in the ticker. (The next item in the stack is not displayed until one of the preceding five items leaves the ticker bounding box.)</td>
</tr>
<tr>
<td>Clipping Planes</td>
<td>The clipping planes define the virtual area in which objects are visible to the camera. The position of the clipping planes is defined by the Height, Width and Depth parameters. This check box activates their display in the RenderEngine view, which aids the alignment of mask layers. This is drawn as an orange bounding box around the ticker object. Clipping planes are required only during scene authoring.</td>
</tr>
</tbody>
</table>
Clock Objects

For a clock object, you can set the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable</strong></td>
<td>Control if the clock runs or not. The <strong>Enable</strong> check box is selected by default. Clear the check box to stop the clock.</td>
</tr>
<tr>
<td><strong>Format</strong></td>
<td>Select clock format from the list; for example, the clock can run as a stopwatch, or display the date. Make changes to the display in the second field, as required. For more information, see <strong>Editing Clock Format</strong> on page 160.</td>
</tr>
<tr>
<td><strong>Time Shift</strong></td>
<td>Set how many seconds the clock is ahead or behind the system clock.</td>
</tr>
<tr>
<td><strong>Draw options</strong></td>
<td>Set polygon fill and object culling options. For more information, see <strong>Common Properties</strong> on page 85.</td>
</tr>
<tr>
<td><strong>Start</strong></td>
<td>Set the starting value of a counter format clock.</td>
</tr>
<tr>
<td><strong>End value</strong></td>
<td>Set the end value of a counter format clock, provided the <strong>Stop at End Value</strong> check box is selected. Click <strong>Reset</strong> to restart the counter.</td>
</tr>
<tr>
<td><strong>Countdown</strong></td>
<td>For counters, select this check box to set the counter to run backwards. Clear to run forwards.</td>
</tr>
<tr>
<td><strong>Stop at end value</strong></td>
<td>Set the counter to stop when it reaches the End value</td>
</tr>
<tr>
<td><strong>Updated on screen</strong></td>
<td>Select this check box to continue running the clock in the background even when it doesn’t appear to be running on-screen.</td>
</tr>
<tr>
<td><strong>0 format</strong></td>
<td>Set the text to display once a backward counter reaches Zero.</td>
</tr>
<tr>
<td><strong>Text style</strong></td>
<td>Apply a preset text style to the clock. For more information, see <strong>Predefining Styles and Decorations</strong> on page 145.</td>
</tr>
<tr>
<td><strong>Decoration</strong></td>
<td>Apply a preset text decoration to the clock. For more information, see <strong>Predefining Styles and Decorations</strong> on page 145.</td>
</tr>
<tr>
<td><strong>Smoothness</strong></td>
<td>Set the anti-aliasing of the text. -1.0 is smoother, 1.0 is more pixelated. This is most apparent when size is adjusted correctly, as explained in <strong>Setting Text Size and Density</strong> on page 147.</td>
</tr>
</tbody>
</table>
Editing Clock Format

You can edit the clock object to appear in different formats. For a clock format that displays the time as read from the system, you can change the way a weekday, month, or year is displayed. For example, you can show the full date without the time (“August 21, 2007”), instead of the default date format (“08/21/07 11:43:03”). For a counter you can indicate positive or negative time. (See Function Operators on page 171.)

To edit the clock format:

1. In the Shape editor, clear the Enable check box.
2. In the Format String field, use the following table to format the clock as required.

<table>
<thead>
<tr>
<th>Modification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>Add * after the % to display the number of the second or minute in the current day. (Instead of the second relative to the minute or the minute relative to the hour).</td>
</tr>
<tr>
<td>–</td>
<td>Add – after the % to display negative time when the clock format is a counter. Using – causes a null display for positive time.</td>
</tr>
<tr>
<td>0</td>
<td>When encountered, output value is filled with zeros on left side (“08:30”).</td>
</tr>
<tr>
<td>Y</td>
<td>The year in four-digit format (“2007”).</td>
</tr>
<tr>
<td>y</td>
<td>The year in two-digit format (“07”).</td>
</tr>
<tr>
<td>M</td>
<td>The month in two-digit format (“08” for August).</td>
</tr>
<tr>
<td>D</td>
<td>The day of the month in two-digit format (“07” for August 7th).</td>
</tr>
<tr>
<td>h</td>
<td>The hour of day.</td>
</tr>
<tr>
<td>m</td>
<td>The minute in the hour.</td>
</tr>
<tr>
<td>s</td>
<td>The second in the minute.</td>
</tr>
<tr>
<td>t</td>
<td>The millisecond in the second.</td>
</tr>
<tr>
<td>stra</td>
<td>Add stra after the % to display the weekday in abbreviated form (“Tue”).</td>
</tr>
<tr>
<td>strA</td>
<td>Add strA after the % to display the full weekday name (“Tuesday”).</td>
</tr>
<tr>
<td>strb</td>
<td>Add strb after the % to display the month in abbreviated form (“Aug”).</td>
</tr>
<tr>
<td>strB</td>
<td>Add strB after the % to display the full month name (“August”).</td>
</tr>
<tr>
<td>strp</td>
<td>Add strp after the % to display AM/PM.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>strw</td>
<td>Add strw after the % to display the number of the weekday (e.g., Monday=1, etc.)</td>
</tr>
<tr>
<td>strj</td>
<td>Add strj after the % to display the number of the day in the year (e.g., February 3rd=34)</td>
</tr>
<tr>
<td>strU</td>
<td>Add strU after the % to display the number of the week in the year</td>
</tr>
</tbody>
</table>
Countdown Clock

A Countdown clock object is used for counting down to a specific point in time. You can set the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Control if the clock runs or not. The Enable check box is selected by default to run the countdown to the date and time set as the End. Clear the check box to stop the clock.</td>
</tr>
<tr>
<td>End</td>
<td>Set the date and time of the end point.</td>
</tr>
<tr>
<td>Format</td>
<td>Select clock format from the list. For more information, see Editing Clock Format on page 160.</td>
</tr>
<tr>
<td>Object Center Modification</td>
<td>Set the object center from which the object is aligned for the X, Y, and Z axes. For more information, see Common Properties on page 85.</td>
</tr>
<tr>
<td>Draw options</td>
<td>Set polygon fill and object culling options. For more information, see Common Properties on page 85.</td>
</tr>
<tr>
<td>Text style</td>
<td>Apply a preset text style to the clock. For more information, see Predefining Styles and Decorations on page 145.</td>
</tr>
<tr>
<td>Text Decoration</td>
<td>Apply a preset text decoration to the clock. For more information, see Predefining Styles and Decorations on page 145.</td>
</tr>
</tbody>
</table>
Subtitles

Text objects can be converted into subtitle objects. Subtitles are timecode-based to display text specified in an STL file (or set of files) at a given time.

To define a text object as a subtitle:

1. Select the text object in the Scene Tree.
2. Right-click in the object’s Shape column in the Scene Tree.
3. Select New Shape >Subtitle.

The Subtitle Controls in the Shape editor are displayed.

4. Set the subtitle parameters as described below:

<table>
<thead>
<tr>
<th>Subtitle Set</th>
<th>Browse to the STL file or file set to be used.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line in number</td>
<td>Set the number (as defined in the STL file) of the first line that is displayed in the subtitle object.</td>
</tr>
<tr>
<td>Line out number</td>
<td>Set the number (as defined in the STL file) of the last line that is displayed in the subtitle object.</td>
</tr>
<tr>
<td>STL Offset</td>
<td>Tweak synchronization by adding an offset, in fields, to the timecode.</td>
</tr>
<tr>
<td>Screen line resolution</td>
<td>Adjust font size (height), by defining how many lines should be displayed.</td>
</tr>
<tr>
<td>Jump to timecode</td>
<td>Jump to the specified time in the STL file.</td>
</tr>
<tr>
<td>Play</td>
<td>Start/Stop subtitles.</td>
</tr>
<tr>
<td>Rewind</td>
<td>Rewind subtitles to beginning of STL file.</td>
</tr>
</tbody>
</table>
5. Working with Text

### Subtitling

**Trigger**

- **Absolute TC** – text is shown/hidden according to timecode specified in each line in the STL file.
- **STL Program Start** – production begins according to the Start of Program timecode value specified in the STL file.
- **Manual** – set the start time of the production when a command is received from an automation system. Individual lines are displayed relative to the specified time.
- **Entered Program Start** – specify the start time of the production. Individual lines are displayed relative to the specified time.

**NOTE:** These definitions apply when using a real, external timecode device.

### Absolute timecode

When **Entered Program Start** (above) is selected, you can enter the start time.

### Adjust to Safe Area

Adjust the resolution of lines to be displayed only in the safe area.

### Adjust to Full Screen

Adjusts the resolution of lines to fit full-screen display.

### Test Line

If the parameter is empty then no lines are displayed. The value is a prefix to the counter of a line.

### Srt width

Set the width of the box, where the .SRT subtitles are placed.

### Srt height

Set the height of the box, where the .SRT subtitles are placed.

### Object Center Modification

Set the object center from which the object is aligned for the X, Y, and Z axes. For more information, see Common Properties on page 85.

### Draw options

Set polygon fill and object culling options. For more information, see Common Properties on page 85.

### Text style

Apply a preset text style to the clock. For more information, see Predefining Styles and Decorations on page 145.

### Text Decoration

Apply a preset text decoration to the clock. For more information, see Predefining Styles and Decorations on page 145.

### Smoothness

Set the anti-aliasing of the text. -1.0 provides the smoothest look, and 1.0 will appear more pixelated. This is generally most apparent when size is adjusted correctly, as explained in Setting Text Size and Density on page 147.

### Type (of text box)

- **Auto** – Automatically scales the size of the text box according to the length of text entered.
- **Word wrap** – Enables word wrapping. A red bounding box will appear around the text, indicating the width of the wrapping area.
- **Shrink to fit** – Fits all entered text into the area specified by the width parameter.
- **Shrink and wrap** – Fit all entered text into a horizontally and vertically defined space.
5. Format the Subtitle object’s style and decoration as required.
All Subtitle control parameters can be exported for use in a controller application.

| Width     | Set the width of the text box.  
|           | (When the type of text box is Auto, the width cannot be adjusted.) |
| Height    | Controls the height of the text box.  
|           | (When the type is Auto, the height cannot be adjusted.) |
6. Working with Data

In this section:

*The Connections Window* on page 167
*Exporting Parameters for Real-time Manipulation* on page 168
*Internal Connections* on page 169
*Using Functions* on page 170
*Using Math Function Parameters* on page 176
The Connections Window

In 4Designer, data related options are defined in the Connections window.

The tabs in the window are where you define the data options;

The **Math** tab is for writing functions using the available mathematical expressions. The editor checks expression syntax, uses auto-complete for quicker writing, and marks incorrect syntax.

The **Global Math** tab lists all functions used in the scene. These can be dragged to the function editor to apply to any object.

The **Exports** tab lists all exports created in the scene
Exporting Parameters for Real-time Manipulation

Object parameters can be exported, to enable real-time values to be updated while the scene is on-air.

Most editable parameters in the Editors that are accompanied by an extension button can be exported for real-time manipulation.

For more information, see on mathematical expressions, see Using Functions on page 170.

To export a parameter:

1. In an Editor, click the extension button (see Extension Buttons on page 48) next to the parameter you want to export.
2. Select Create Export.

The Connections window opens.

3. In the Value field (in the Exports tab), specify a value for the object parameter.
4. In the Target Property column, select the property that you want to export and click Connect.

Exported properties are listed at the bottom of the Connections window.

TIP
You can drag and drop the extension button of any property from the Editor to the Source or Target lists to make it the current property.

5. If you want to export more than one property, click New to create a new export row, and repeat steps 3-4.

Multiple Exports can be connected to a single property, and an export can be connected to multiple properties.
Internal Connections

In 4Designer, you can make internal connections between object properties. For example, make a connection between the positions of two objects, or connect an object’s position to its size, color, etc. Attach properties of objects in many different ways – to each other, and to the properties of other objects. You can create up to nine internal connections from separate parameters to the same parameter in a single object.

To create a connection:

1. Select the object whose properties you want to connect.
2. Click the extension button of the relevant property. A menu is displayed.
3. Click **Out Connection** or **In Connection** as required.

<table>
<thead>
<tr>
<th>Out Connection</th>
<th>To create a connection from the selected source property.</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Connection</td>
<td>To create a connection to the selected target property.</td>
</tr>
</tbody>
</table>

The **Connections** window opens with the Connections tab displayed.

4. Drag the required parameter (from the extension button) to the corresponding property (source/target).
5. Click **Connect**.

The internal connection is added to the list of connections.

In the Object tree, a small green square is displayed beside the property for which the connection was made. Clicking the square displays the **Connections** dialog box.
Using Functions

You can write functions for target properties that affect the behavior of your scene under specified conditions. These user-defined functions can affect the animation of an object or can define a static condition. Conditions can be defined as If-Then statements, or as standard mathematical expressions. The function editor highlights incorrect entries and auto-completes functions and variables.

4Designer uses the following parameters to build expressions:

- **E** represents the **External** data value.
  
  Used when external data is required by a scene element. However the data may vary according to what is entered. For example, for a scene element scalable between 0 and 10 units, you could enter a value between 0 and 100 (for a percentage), and the user-input data (E) must be divided by 10 to fit into the scene. In this case the function should be E/10.

- **I** represents the **Internal reference** data value that is passed from one parameter to the next.
  
  It is used when more than one dynamic value is needed for a specific math function. For example, when you create a pie chart, the second section of the pie must receive both external data (to sets its size), and data from the first pie section (to set its starting position).

- **A** represents the user-defined **Animation** of the object parameter.
  
  The A parameter represents the animation value for the property. It is used when the selected object has been animated to change object animation. The value of A always ranges from the value set in the first keyframe to the value of the last keyframe of the animation.

  For example, a cylinder is animated to grow from 0 to 5 units in a certain number of key frames. The scale of the cylinder has been exported so that the user can alter the size dynamically. The expression A*E causes the cylinder to grow from 0 to the imported value (E), and is multiplied by the value of the animation when the animation is played. When you add an export to a parameter that is animated, it automatically receives a math function of A*E. This is because the parameter receives two values at once.

  A + E adds the export value to the animation, so if the animation is from 0 to 1, and you add 1 to the export, then it will be from 1 to 2.

**To define a function for a property:**

1. In an Editor, click the extension button for the property for which you want to write the function.
2. Select **Function for** from the menu. The **Connections** window opens with the **Global Math** tab open.

![Connections window]

The selected property is displayed as the **Target Property**.

3. Drag a function from the list to the math editor to apply it to the selected parameter, or write a function in the **Math** tab.

After you close the **Connections** window, a small blue square appears in the property column in the Scene Tree.

The connections window has a column marked **Value** showing the calculated value of the connection, useful when combined with functions. The table in the following section contains a list of operators that can be used.

In the **Global Math** tab, you can drag an existing function onto the entry window to copy the function directly.

**Function Operators**

The calculator in 4Designer has three general types:

- **Expression**, for example:
  
  \[
  \sin(45); \quad \ln(\atan(y, \abs(x)));
  \]

  There must always be a semicolon character (;) at the end of an expression.

- **Definition**, for example:
  
  \[
  \text{define } x = 4;
  \]

  or

  \[
  \text{define myVar} = \cos(\exp(x) + 1.2);
  \]

  There must always be a semicolon character (;) at the end of an expression.

  Definitions from previous versions can be used.

- **If-Else**, for example:
if () { [definition;] expression; } [else { [definition;] expression; }] 
Data between [] is optional.
Curly brackets {} are not required if only an expression occurs.
A simple version, for example, is:
if (x > 0) sin(x);
or
if (x > 0) sin(x); else –sin(x);
If-else expressions can be multilevel, too, for example:
if (a > b)
{
  define x1 = a / b;
  if (x1 >= 1.23)
    ln(x1) + 4.5;
  else
    {
      define x2 = x1 / 2.3;
      ln(x2 / 0.4) + sin(x1);
    }
  }
else
  0.0;

- Difference between two values (subtraction).
!= Not equal.
% Modulo.
& Binary “and”.
&& Logical “and”.
* Product of two values (multiplication).
/ The result of one value divided by another value (division).
^ One value powered by another value.
| Binary “or”.
|| Logical “or”.
+ Sum of two values (addition).
< Less than.
<= Less than or equal to.
== Equal.
> Greater than.
>= Greater than or equal to.
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>abs(x)</td>
<td>Returns the absolute value of x.</td>
</tr>
<tr>
<td>acos(x)</td>
<td>Returns the arccosine of x in the range 0 to pi radians. If x is less than -1 or greater than 1, acos is indefinite.</td>
</tr>
<tr>
<td>asin(x)</td>
<td>Returns the arcsine of x in the range -pi/2 to pi/2 radians. If x is less than -1 or greater than 1, asin is indefinite.</td>
</tr>
<tr>
<td>atan(x)</td>
<td>Returns the arctangent of x in the range -pi/2 to pi/2 radians. If x is 0, atan returns 0.</td>
</tr>
<tr>
<td>atan2(y, x)</td>
<td>Returns the arctangent of y/x in the range -pi/2 to pi/2 radians. If both parameters are 0, the function returns 0. The signs of both parameters are used to determine the quadrant of the return value.</td>
</tr>
<tr>
<td>bool(x)</td>
<td>Returns x as bool.</td>
</tr>
<tr>
<td>ceil(x)</td>
<td>Returns a value representing the smallest integer that is greater than or equal to x.</td>
</tr>
<tr>
<td>cos(x)</td>
<td>Returns the cosine of angle x. The angle x is assumed to be in radians.</td>
</tr>
<tr>
<td>cosh(x)</td>
<td>Returns the hyperbolic cosine of angle x. The angle x is assumed to be in radians.</td>
</tr>
<tr>
<td>date(x)</td>
<td>Returns formatted string with current date using format x. 0= mm/dd/yy 1=mm/dd/yyyy 2=dd/mm/yy 3=dd/mm/yyyy 4=d (no leading zero) 5=dd (with leading zero) 6=m (no leading zero) 7=mm (with leading zero) 8=yy 9=yyyy</td>
</tr>
<tr>
<td>deg(x)</td>
<td>Return degree = x * 180 / PI.</td>
</tr>
<tr>
<td>exp(x)</td>
<td>Returns the exponential value of x. On overflow, exp is infinite; on underflow it returns 0.</td>
</tr>
<tr>
<td>float(x)</td>
<td>Return x as float.</td>
</tr>
<tr>
<td>floor(x)</td>
<td>Returns a floating-point value representing the largest integer that is less than or equal to x.</td>
</tr>
<tr>
<td>format(x, y)</td>
<td>Return formatted string using pattern x. Format depend of type y format(&quot;%03d&quot;, y) if y is int = 24 return string &quot;024&quot; format(&quot;%.3f%%&quot;, y) if y is float = 1.2353 return string &quot;1.24%&quot; format &quot;qwe%s&quot;, y) if y is string = &quot;rty&quot; return string &quot;qwerty&quot; bool type is converted to int type.</td>
</tr>
<tr>
<td>getenv(x)</td>
<td>Return environment variable named 'x'.</td>
</tr>
<tr>
<td>hypot(y, x)</td>
<td>Returns the length of the hypotenuse of a right triangle, given the length of the two sides x and y.</td>
</tr>
<tr>
<td>int(x)</td>
<td>Returns x as int.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td><code>ln(x)</code></td>
<td>Returns the natural logarithm of x. If x is negative, it is indefinite. If x is 0, it is infinite.</td>
</tr>
<tr>
<td><code>log(x)</code></td>
<td>Returns the base 10 logarithm of x. If x is negative, it is indefinite. If x is 0, it is infinite.</td>
</tr>
<tr>
<td><code>max(a,b)</code></td>
<td>Returns the larger of a and b.</td>
</tr>
<tr>
<td><code>min(a,b)</code></td>
<td>Returns the smaller of a and b.</td>
</tr>
</tbody>
</table>
| `prec(x,y)` | Return string, created from float y using precision x.  
  - prec(2, y) if y = 24.243 return string "24.24"  
  - prec(3, y) if y = 1.2358 return string "1.236"  
  Second argument y, is always internally converted to float type. |
| `prec2(x,y)` | Same as prec(x,y), using "," as a separator (and not "."). |
| `rad(x)`  | Return radians = x * PI / 180. |
| `rand(x,y)` | Return random value between x and y (float). |
| `restore(x)` | Return unicode string variable named ‘x’. |
| `setenv(x)` | Return “true” if action defined environment variable x was successful, otherwise return “false”.  
  x should be as "myvar=abcdef". |
| `setenv2(x)` | Return “true” if action defined environment variable x was successful, otherwise return “false”.  
  x should be as "myvar", y should be as "abcdef". |
| `shifl(x,y)` | Return x << y. |
| `shiftr(x,y)` | Return x >> y. |
| `sin(x)`  | Returns the sine of x. The angle x is assumed to be in radians. |
| `sinh(x)` | Returns the hyperbolic sine of x. The angle x is assumed to be in radians. |
| `sqrt(x)` | Returns the square root of x. If x is negative, sqrt is indefinite. |
| `Store(x,y)` | Returns “true” if action defined string variable x was successful, otherwise returns false.  
  x should be as "myvar", y should be as L"abcdef" (unicode string). |
| `strabs(x)` | Returns string operation of abs (does not change precision of input value). |
| `strchr(x,y)` | Return position of character y in string x. |
| `string(x)` | Return x as string. |
| `strstr(x,y)` | Return y characters of string x from left side. |
| `strlen(x)` | Return string length. |
| `strright(x,y)` | Return y characters of string x from right side. |
| `tan(x)`  | Returns the tangent of x. The angle x is assumed to be in radians. |
Two expressions can be compared and a reaction defined for the result of the comparison, using comparison operators:

<table>
<thead>
<tr>
<th>Comparison Operators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;</code></td>
<td>Smaller</td>
</tr>
<tr>
<td><code>&gt;</code></td>
<td>Greater</td>
</tr>
<tr>
<td><code>&lt;=</code></td>
<td>Smaller or equal</td>
</tr>
<tr>
<td><code>&gt;=</code></td>
<td>Greater or equal</td>
</tr>
<tr>
<td><code>=</code></td>
<td>Equal</td>
</tr>
<tr>
<td><code>!=</code></td>
<td>Not equal</td>
</tr>
</tbody>
</table>

Two expressions can be compared and a reaction defined for the result of the comparison, using comparison operators:

<table>
<thead>
<tr>
<th>Valid Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>The value calculated from the animation.</td>
</tr>
<tr>
<td>E</td>
<td>The value provided externally (via an exported parameter).</td>
</tr>
<tr>
<td>I</td>
<td>The value provided internally (via a connection to another parameter).</td>
</tr>
</tbody>
</table>
Using Math Function Parameters

This section describes how to use the 4Designer E, I and A parameters.

Using External Data with a Math Function

The E parameter represents a user-input value. It is typically used when external data is required for a scene, but the entered data needs to be altered to fit the scale of the scene. For example, when you have a bar in a scene that needs to be scaled between 1 and 10 units, and the user will enter a value between 1 and 100, the user-input data (E) must be divided by 10 to fit the units of the scene. In this case, you should enter E/10 in the Function field of the Math Function window.

Using Internal Data with a Math Function

The I parameter represents a value passed internally from one math function to another. It is typically used when more than one dynamic value is needed for a specific math function. For example, when you create a pie chart, the second section of the pie chart must receive both external data (to set its size), and data from the first pie section (to set its starting position).

Using the Animation Parameter in a Math Function

The A parameter represents the animation value for the property. It is typically used in a math function when the selected object has been animated and the math function affects object animation. The value of A always ranges from 0 to 1.

For example, a cylinder has been animated to grow from 0 to 5 units in a certain number of key frames, and the scale of the cylinder has been exported so that the user can alter the size dynamically. A*E in the Function field of the Math Function window causes the cylinder to grow from 0 to the imported value (E) and is multiplied by the value of the animation, when the animation is played. When you add an export to a parameter that is animated, it automatically receives a math function of A*E. This is because the parameter receives two values at once.

A + E adds the export value to the animation, so if the animation is from 0 to 1, and you add 1 to the export, then it will be from 1 to 2.

Math Functions for Parameter Type STRING

Mathematical (Data) functions can be combined with a formatting description to produce a string output.

The formatting description is always surrounded with quotation marks (") and combined with a plus sign (+).

There are two different types of formatting:

- Converting the float that emerges from the math function to a string
- Adding a static string

For converting a float to a string, the formatting description that must follow the math function has the following syntax:
\F

- then (optional) **number of pre comma digits** (0’s are added on the least significant side if necessary)
- then ‘.’ or ‘,’ (the comma – can be shown as ‘.’ or ‘,’)
- then number of post comma digits
- then (optional) a **static string**

**Examples**

An (external) float value is connected to the string. It should be shown with a ‘.’ as a comma, and with two digits after the comma.

**Math function is:** prec (2, E);

Same as the previous example, but the external input is divided by 100 and a ‘%’ sign is shown.

**Math function is:** prec (2, float(E/100));

Same as the previous examples, but a static text ‘Quote:’ precedes the math function

**Math function is:** "Quote:" + prec(2, float(E/100)) + "%".

**NOTE:**

The definition of pre-comma digits is not applicable for negative values.
Animations are created by defining changes in the parameters of an object throughout a series of frames. For example, to define the movement of an object along the X-axis. The first and end frames of each segment of change are identified by keyframes. Each sequence, can be defined as an animation group, that can be reused. A master animation is used to time different sequences, add triggers for other events to begin, and export values at specific times in the animation.

In this section:

The Animation Strip on page 179
The Animation View on page 181
Keyframe Fields on page 184
Defining an Animation Sequence on page 188
Animation Groups on page 192
Triggers on page 194
Animating Along a Path on page 203
Triggers on page 194
Master Animations on page 206
The Animation Strip

Animations are made using the timeline shown in the Animation strip at the bottom of the main window. The timeline displays keyframe markers for each animated sequence, to indicate the points of change on the timeline.

To the left of the timeline, the following control buttons are available:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rewind</td>
<td>Go to the beginning of the current animation group.</td>
</tr>
<tr>
<td>Previous keyframe</td>
<td>Go to the previous keyframe.</td>
</tr>
<tr>
<td>Play in Reverse</td>
<td>Play the animation in reverse.</td>
</tr>
<tr>
<td>Play</td>
<td>Play the animation.</td>
</tr>
<tr>
<td>Continue</td>
<td>Continue the animation from the current keyframe.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stop the animation.</td>
</tr>
<tr>
<td>Finish loop</td>
<td>Finish loop and continue the animation.</td>
</tr>
<tr>
<td>Go to the next keyframe.</td>
<td>Go to the next keyframe.</td>
</tr>
<tr>
<td>Go to the end of the animation.</td>
<td>Go to the end of the animation.</td>
</tr>
<tr>
<td>Create</td>
<td>Create a new master animation or animation group.</td>
</tr>
<tr>
<td>Remove</td>
<td>Remove current animation group.</td>
</tr>
<tr>
<td>Clone</td>
<td>Clone current animation group.</td>
</tr>
<tr>
<td>Mirror</td>
<td>Mirror current animation group.</td>
</tr>
<tr>
<td>Main</td>
<td>Select the current animation group to display.</td>
</tr>
<tr>
<td>Create keyframe.</td>
<td>Create keyframe.</td>
</tr>
<tr>
<td>Record</td>
<td>Start / Stop record.</td>
</tr>
</tbody>
</table>
Open the Key Filter dialog box to sort keyframes by type. For more information, see *Sorting Keys by Type* on page 187.

Select the current keyframe to display.

**NOTE:**
*This field is not displayed if the timeline is set to use a timecode (see *Miscellaneous* on page 231).*

Set the start frame of the animation range (to the left of the Timeline) or the end frame of the animation range (to the right of the Timeline).
The Animation View

The **Animation View** provides an extended view of your animation objects, properties, and parameters as channels or splines.

In the **Animation View**, you can manipulate and edit animated sequences, set out-of-range behavior, use spline visualization to set acceleration and deceleration of your animation, and set up master animations.

**To open the Animation View:**

- Click **Animation View**.

![Animation View](image)

In the **Animation View**, all animated scene elements are displayed in a tree hierarchy with a timeline. Each animation group is displayed as a branch at the same hierarchical level in the tree, above its channels. A channel with the property’s keyframes is displayed with each tree branch. Any parameter you animate creates a channel in the **Animation View**.

When you perform an activity on a higher-level entity, such as a parameter type channel, all of its lower level entities (parameter parts, e.g.) are affected.

Various keyframes are represented as follows:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Individual" /></td>
<td>Individual keyframes, that are connected to object properties.</td>
</tr>
<tr>
<td><img src="image" alt="Stop/Pause" /></td>
<td>Stop/pause when the frame is played in the animation.</td>
</tr>
<tr>
<td><img src="image" alt="Trigger" /></td>
<td>Triggers that activate an action when the frame is played in the animation.</td>
</tr>
<tr>
<td><img src="image" alt="Update" /></td>
<td>Update an export value when the frame is played in the animation.</td>
</tr>
<tr>
<td><img src="image" alt="Control Keyframe" /></td>
<td>Any keyframe created for a property that is animated, is displayed as a control keyframe in the object's animation channel.</td>
</tr>
</tbody>
</table>
Animation View Controls

Use the controls in the Animation View to edit objects, properties, or parameters in your animations. This table describes the toolbar buttons not described previously in The Animation Strip on page 179.

<table>
<thead>
<tr>
<th>Animation group list</th>
<th>Select the animation to display in the Animation view from the list of all animation groups in the scene.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter keys</td>
<td>Open the Key Filter to select the key types for filtering.</td>
</tr>
<tr>
<td>Animations Setup</td>
<td>Open the Animations Setup window. For more information, see Automatic Animation Rewind on page 192 and Filtering Keyframes on page 193.</td>
</tr>
<tr>
<td>Sort by Object/Poo</td>
<td>By default, animation channels are sorted according to pool specifications. Toggle to sort channels according to object.</td>
</tr>
<tr>
<td>Specification</td>
<td>By default, animation channels are displayed as tracks, linearly, along the timeline. Toggle to display channels in curve form, to help visualize acceleration and deceleration of the animation.</td>
</tr>
<tr>
<td>Begin/End</td>
<td>Toggle to enable the Begin and End fields for editing, to set any range for the animation group. When Begin and End are not enabled, the range is set to the length of the longest animated element. This range is indicated by a green background.</td>
</tr>
<tr>
<td>Remove Keyframe</td>
<td>Remove the selected keyframe from the timeline.</td>
</tr>
<tr>
<td>Copy Keyframe</td>
<td>Copy the selected keyframe to the timeline.</td>
</tr>
<tr>
<td>Paste Keyframe</td>
<td>Paste the selected keyframe to the timeline.</td>
</tr>
<tr>
<td>Move keyframe to current time</td>
<td>Move the selected keyframe to the current timeline position.</td>
</tr>
<tr>
<td>Edit keyframes</td>
<td>Open the Keyframe editor to change individual keyframes.</td>
</tr>
<tr>
<td>Fit view to key times/values</td>
<td>Optimize the current view to display all keyframes.</td>
</tr>
<tr>
<td></td>
<td>In Spline view, optimize the current view to display the range of the values of the selected animations.</td>
</tr>
</tbody>
</table>
### Using the Right Mouse Button

You can use the right mouse button to set various options on animation channels listed in the Animation View.

When you select a channel and right-click, you have the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Set segment into linear mode** | Available in Spline view;  
Set the selected segment of an animation to run linearly, with a constant speed.  
Set the selected segment of an animation to run with acceleration/deceleration.  
Set the selected segment of an animation to be freely manipulated by the spline handles, affecting animation acceleration/deceleration.  
Set the selected segment of an animation to show keyframes only, and not the movement or gradualization between keyframes. |
| **Segment Controls**     | Show or hide segment control handles. Available in Spline view.              |
| **Range Edit Mode**      | Edit the animation range. All ranges can be scaled to retime the animations. Available in Track view. |

#### Select All Keys
Select all keyframes in the selected channel.

#### Set Key
Create a keyframe at the clicked frame.

#### Remove Key
Remove all the keys at the selected frame.

#### Remove Selected Keys
Remove the selected key/s.

#### Copy Keys
Copy selected keys to the clipboard.

#### Paste Keys
Paste keys copied to the clipboard (CTRL+V).

#### Mirror Channel
Reverse the order of the keyframes in the channel.

#### Remove Channel
Remove the selected channel from the Animation group.

#### Go To Time
Move animation marker to the clicked frame.

#### Move to Front
When control items overlap in the display, click one to see all items overlapping, and select the one to bring forward for selection.

#### Left Out of Range Mode
Specify the behavior for the channel animation before the first keyframe in the channel (Constant, Loop, Relative Loop, Linear, None). For more information, see Setting Out-of-Range Behavior on page 191.

#### Right Out of Range Mode
Specifies the behavior for the channel animation after the end keyframe in the channel (Constant, Loop, Relative Loop, Linear, None). For more information, see Setting Out-of-Range Behavior on page 191.
Keyframe Fields

Create an animation by setting keyframes that act as milestones along the timeline and indicate changes in object properties.

The animation timeline displays the current keyframe number when you move the yellow slider. If you enter a value in the current keyframe field, the slider jumps to that position.

The timeline also displays the start and end frame numbers of the section of the timeline that is currently in view. By entering new values in these fields, you can rescale and move the timeline. You can also drag the slider, to view the hidden sections. The values in the first and last keyframe in view are automatically updated to reflect the visible section.

To create a keyframe in the Animation strip:

There are a number of ways to create a keyframe:

- Enter the keyframe number in the Current Keyframe field, and press ENTER (as mentioned previously).
  
  Change the object parameters to animate, click the extension button next to the parameter, and click Create Key. This can be done to change transformation and visibility properties. Other properties are animated by opening their extension button menu and selecting Set key.
  
  A keyframe is recorded for the parameter at the current point on the animation timeline.

- Click the Create Keyframe button. This opens the Create Keys dialog box, where you can set a keyframe as follows.

![Create Keys dialog box]

<table>
<thead>
<tr>
<th>Create keys for</th>
<th>Determine the object for which you want to set the keyframe (All, selected and sons, current and sons, selected w/o sons, current w/o sons).</th>
</tr>
</thead>
<tbody>
<tr>
<td>at</td>
<td>Set the keyframe position.</td>
</tr>
</tbody>
</table>
To create a keyframe in the Animation View:

1. Double-click a blank area in a channel for the parameter that you want to animate. A gray diamond is displayed, indicating a new keyframe.
2. Slide the diamond along the channel line to place it where you want in the animation timeline.

   **NOTE:**
   Selecting a higher-level entity adds keyframes for all its lower level entities, simultaneously.
   Speed up or slow down an animation by dragging the end keyframe (indicated by a white square).

To set a stop/pause:

1. In the Animation View, right-click within the control channel, and select Set Key. A control keyframe is added.
2. Right-click the key in the control channel, and select Edit.
The **Key Editor** opens.

3. Set the **Key Name** (for use in a Controller), **Time** (frame number), and type of **Stop**.

   Enabling **Stop**, in the control channel, stops all the animations in the animation channels simultaneously.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pause</strong></td>
<td>Select this option to stop the selected keyframe animation</td>
</tr>
<tr>
<td></td>
<td>for the specified number of frames.</td>
</tr>
<tr>
<td><strong>Until Continue Invoked</strong></td>
<td>Select this option to stop the animation until continued by</td>
</tr>
<tr>
<td></td>
<td>user.</td>
</tr>
</tbody>
</table>

4. Click **Close**.
Deleting a Keyframe

Select the keyframe on the timeline and press the DELETE key.
For more information, see Deleting a Channel on page 187.

Deleting a Channel

Right-click the name of the channel in the tree, and select **Remove Channels** from menu.
Delete and change operations can also be carried out for multi-selections of keyframes; keys can be lassoed directly from the timeline, or from the list of channels.

Sorting Keys by Type

Keys can be sorted in the tree by object or by pool.

*To toggle between object/pool display:*

- Click 🟢 or 🔴.
Defining an Animation Sequence

For each animated sequence, you need to define the parameters that determine the starting status of the object(s) before the animated action, and to define start and end keyframes for the animation, which constitute the range.

**To create a sequence manually:**

1. Place the objects in your scene at their required starting positions.
2. In the Animation Timeline, enter a new keyframe number in the **Current Keyframe** field (or use the yellow slider).
3. Change the object properties, as required.
4. When changing transformation properties (position, rotation, scale), you can click the **Create Key** to open the **Create Keys** dialog box.
   
   When changing other properties, click the relevant extension button(s), and select **Set Key**.
5. Continue to change the object, and set keys for the changes, as required.

The animation can be played at any point, provided there is a start and end keyframe. For more information, see *Changing Keyframe Properties* on page 189.

**To record an animation sequence:**

1. Click **Record** in the Animation strip.
   
   The background turns red.
2. Select the object you want to animate, and set the animated parameters to their start point.

   **NOTE:** *When using the record function the starting properties of an object are not recorded. If you want any property to be animated, you must record its values (by making a change) after you click **Record**.*
3. Enter the next keyframe number in the **Current Keyframe** field (or use the yellow slider).
4. Change the object as required.
5. Enter a new keyframe number in the **Current Keyframe** field (or use the yellow slider).
   
   This adds a keyframe at the current frame.
6. Add as many keyframes as required, by changing parameters, and setting the current frame.
7. Click **Record** again to stop the recording.
   
   The background turns gray.
   
   A small pink indicator appears in the Scene tree near the property that was animated (in the Transformation column); clicking the square displays the Animation window.
Changing Keyframe Properties

Keyframe properties are changed in the Key Editor.

► To change keyframe properties in the Animation strip:
1. Right-click the keyframe you want to change.
   A menu is displayed.
2. Select Edit Key.
   A list of the recorded channels is displayed for the selected keyframe.
3. Select the required channel.
   The Key Editor dialog box is displayed (see The Key Editor on page 189).

► To change keyframe properties in the Animation View:
- Double-click the gray diamond that represents the keyframe whose values you want to change.
  The Key Editor dialog box is displayed (see The Key Editor on page 189).

The Key Editor

The Key Editor allows you to edit the value of a keyframe for a specific parameter. Change the values for that keyframe as described in the following table:
Defining an Animation Sequence

7. Animations

Setting Animation Speed

To set animation speed (in the timeline or in the Animation View):

- Shrink an animation segment to increase animation speed (of the segment),
  -or-
  stretch an animation segment to decrease animation speed (of the segment).

<table>
<thead>
<tr>
<th>Channel Name</th>
<th>This is the name of the parameter whose settings are shown in the dialog box (it cannot be changed).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key Name</td>
<td>Assign the keyframe a meaningful name. This is used by controller applications that air the 4Designer scenes.</td>
</tr>
<tr>
<td>Time</td>
<td>Indicate the current keyframe.</td>
</tr>
<tr>
<td>Value</td>
<td>Set the value of the current parameter at the current keyframe, as required.</td>
</tr>
</tbody>
</table>
| Segment - Mode | Define playback settings for the segment following the keyframe. Available options are:  
  Linear – the animation speed between keyframes is constant.  
  Jump – this segment of the animation shows only the current keyframe and the next keyframe, not the movement or gradualization between them.  
| Segment - Acceleration | Set the segment following the keyframe to accelerate when it starts. The value here defines the percentage of the segment time during which the animation accelerates. The acceleration is relevant from the keyframe. For example, enter a value of 25% to accelerate object animation for the first quarter of the segment. |
| Segment - Deceleration | Set the segment following the keyframe to decelerate before it ends. This value defines the percentage of the segment time during which the animation decelerates. The deceleration is applied at the end of the segment. For example, enter a value of 25% to decelerate object animation for the last quarter of the segment. |
| Loop         | Select the Loop check box to loop the animation and enable the relevant options:  
  Length – define the length of the loop. Each repetition goes back the defined number of frames, counting from the end keyframe, and plays the animation from that point.  
  Repeat – choose this option to loop the animation according to the value in the adjacent field.  
  Repeat infinite – choose this option to loop the animation infinitely. |
Setting Out-of-Range Behavior

When animating objects, there are two time ranges that can be set:

The range of an animated property (“channel”) is the length beginning with the first keyframe, and ending with the end keyframe.

The animation group range is the length set for the group (with all objects and properties that are animated in it). By default, this range starts at the first starting keyframe along the timeline, and ends at the last end keyframe that is placed on the timeline (when multiple properties are animated). However, you can set this range to begin earlier, and end later.

In the Animation View, the animation group range is indicated by green highlighting in the main channel. You can change the default animation group range using the Begin/End fields (range is locked by default, so unlock to change).

Out of range behavior refers to the behavior of an animated property before its first keyframe, and after its end keyframe. This allows more looping options.

To set out-of-range behavior:

1. In the Animation View, right-click a channel/parameter for which you want to change the out of range behavior.
2. From the menu, select:

<table>
<thead>
<tr>
<th>Left Out of Range Mode</th>
<th>Specify the behavior mode for the channel animation before the first keyframe in the channel.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right Out of Range Mode</td>
<td>Specify the behavior mode for the channel animation after the end keyframe in the channel.</td>
</tr>
</tbody>
</table>

3. Then select the required option:

<table>
<thead>
<tr>
<th>Constant (default)</th>
<th>Object is displayed with the properties of the frame before the start keyframe (in the left out-of-range) and with the properties of the frame after the end keyframe (in the right out-of-range).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop</td>
<td>The animated parameter is looped before/after its range, playing the animation as defined within range.</td>
</tr>
<tr>
<td>Relative Loop</td>
<td>The animated parameter is looped before/after its range, relative to its value at its end keyframe.</td>
</tr>
<tr>
<td>Linear</td>
<td>The animated parameter plays linearly, as defined in its start/end keyframe.</td>
</tr>
<tr>
<td>None</td>
<td>The animated parameter does not generate a value for the property channel.</td>
</tr>
</tbody>
</table>
Animation Groups

In 4Designer you can create multiple animation groups that can be played independently of each other. Each group is an animation sequence, and they can be played in parallel or sequentially, using a master animation or a common timeline. This is useful when the entire animation sequence is not linear or is not completely predefined prior to going on-air.

Creating Multiple Animation Groups

To create multiple animation groups

1. In the Animation strip, click the New Animation Group button. The default name for a new group, Animation, appears in the drop-down list as the current animation group.
2. Change the name as required. The animation group is automatically saved and added to the list.
3. Define the animation, as described in Defining an Animation Sequence on page 188.

NOTE: The displayed animation group and the playback controls are applicable only to the currently selected animation group in the list of animation groups.

Automatic Animation Rewind

When working with multiple animation groups in a scene, it can be useful to set some animations to automatically rewind when the scene is saved. When a scene is saved, the current position for each animation group is stored; if you leave an animation without rewinding it, when you reload the scene in a controller, the scene will be displayed in a played state. Depending upon the construction of the scene, this could result in a single frame of the scene in a ‘played’ state being displayed on air when the scene is cued.

Automatic rewind lets you load the scene without the need to rewind animations or cue the scene first.

To rewind animation groups when scene is saved:

- In the Animation Setup dialog box, select Rewind on Save for the required animation group:

NOTE: The Rewind button allows you to rewind all selected animations in the current scene without saving.
Filtering Keyframes

You can hide or display certain keyframes in an animation group, according to selected object(s), or to parameter type.

To select a keyframe filter:

1. Click **Key Filter** in the animation strip.
   - The **Key Filter** opens.
   - From the list, select the objects to **Show keys for**.
   - Select or clear the check boxes for keyframes associated with the relevant parameters.
   - Keyframes are shown or hidden in the timeline, as specified.
Triggers

4Designer allows you to set a trigger for actions to be executed. You can use animation time or interaction as a trigger to play an animation group, a telestrator function, a ticker, or to set a value. Triggers are marked on the timeline.

To show the Triggers:

■ Click Triggers to display the Triggers window.

The available trigger types are:

<table>
<thead>
<tr>
<th>Trigger Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Animation Time</td>
<td>Execute an action when an animation group reaches a specified frame. Animation time triggers are displayed on the timeline. See Animation Triggers on page 194.</td>
</tr>
<tr>
<td>Export</td>
<td>Execute an action when an export value is changed to the specified value. See Export Triggers on page 195.</td>
</tr>
<tr>
<td>Interaction</td>
<td>Execute an action when an interactive event occurs. See Interaction Triggers on page 195.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Execute an action when the value of a defined parameter meets the condition in the trigger. See Parameter Triggers on page 196.</td>
</tr>
<tr>
<td>Countdown</td>
<td>Execute an action when the specified countdown item reaches its end. See Countdown Triggers on page 196.</td>
</tr>
</tbody>
</table>

Animation Triggers

To create an animation trigger:

1. In the Triggers window, drag an Animation Time trigger from Events to the Details area.
2. Select the trigger in the Details area. The trigger Properties are displayed.
3. From the list, select the Animation group that will act as a trigger or contain the keyframe to be used as a trigger.
4. Select or clear the Condition check box, as required.
   - If Condition is cleared, the defined action is triggered when the animation group is played.
5. If Condition is selected, define the keyframe or click Get to use the current keyframe. The defined action is triggered when the specified keyframe is reached and the trigger is updated under Details.
Export Triggers

To create an export trigger:
1. In the **Triggers** window, drag an **Export** trigger from **Events** to the **Details** area.
2. Select the trigger (that you just dragged).
   - The trigger **Properties** are displayed.
3. Select the required export to act as a trigger from the list

Interaction Triggers

To create an interactive trigger:
1. In the **Triggers** window, drag an **Interaction** trigger from **Events** to the **Details** area.
2. Select the trigger (that you just dragged).
   - The trigger **Properties** are displayed.
3. Select the required interaction type:

<table>
<thead>
<tr>
<th>Interaction Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap</td>
<td>Trigger an action when the object is tapped.</td>
</tr>
<tr>
<td>Hold begin</td>
<td>Trigger an action when the object is held.</td>
</tr>
<tr>
<td>Hold update</td>
<td>Trigger an action when the object is being held.</td>
</tr>
<tr>
<td>Hold end</td>
<td>Trigger an action when the object is released.</td>
</tr>
<tr>
<td>Drag begin</td>
<td>Trigger an action when starting to drag the object.</td>
</tr>
<tr>
<td>Drag update</td>
<td>Trigger an action when the object’s position is updated by dragging.</td>
</tr>
<tr>
<td>Drag end</td>
<td>Trigger an action when finished dragging the object.</td>
</tr>
<tr>
<td>Manipulation begin</td>
<td>Trigger an action when the object is manipulated in any way.</td>
</tr>
<tr>
<td>Manipulation end</td>
<td>Trigger an action when the object is finished being manipulated in any way.</td>
</tr>
<tr>
<td>Finger down</td>
<td>Trigger an action when the object is swiped down.</td>
</tr>
<tr>
<td>Finger up</td>
<td>Trigger an action when the object is swiped up.</td>
</tr>
</tbody>
</table>
4. Select the object for interaction.
Parameter Triggers

To create a parameter trigger:

1. In the Triggers window, drag a parameter trigger from Events to the Details area.
2. Select the trigger (that you just dragged).
   The trigger Properties are displayed.
3. Drag a property/attribute to the list to set as a trigger.

Countdown Triggers

To create a countdown trigger:

1. In the Triggers window, drag a countdown trigger from Events to the Details area.
2. Select the trigger (that you just dragged).
   The trigger Properties are displayed.
3. Select a countdown property from the list.

Deleting Triggers

To delete all triggers in the scene:

■ In the Triggers window, click Purge Events.

Triggering Actions

Five types of actions can be triggered;

- Animation Value Actions on page 197
- Animation Actions on page 198
- Set Value Actions on page 200
- Telestrator Actions on page 201
- Ticker Actions on page 202
Animation Value Actions

Animation value actions are for animating an interactive object to a specific point after it has been manipulated.

After setting the trigger type, set the triggered action;

To trigger an animation value:

1. In the **Triggers** window, from **Events**, drag the **Animation value** action to the **Details**, and append it to the required trigger.
2. Select the action (that you just dragged).
   The action **Properties** are displayed.
3. Drag the property or attribute that you want to animate to **for property named**.
4. Set **animate value from** to animate the property from its current state:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Const</strong></td>
<td>Animate to or by (according to the animation type setting) the value specified in <strong>to value</strong>.</td>
</tr>
</tbody>
</table>
| **Input1** | Animate the property through interactivity. Animate to or by (according to the animation type setting) the number of fingers used in the interaction.  
1 finger = set **to value** to 0.  
2 fingers = set **to value** to 1.  
3 fingers = set **to value** to 2.  
4 fingers = set **to value** to 3. |
| **Input2** | Animate the property through interactivity according to the position of the received interaction on the X axis; this value is set as the **to value**. The property is animated to this value. |
| **Input3** | Animate the property through interactivity according to the position of the received interaction on the Y axis; this value is set as the **to value**. The property is animated to this value. |

**NOTE:**

**Input2** and **Input3** are most commonly used to animate position properties, but can be used for any property. For example, using **Input2**, set the alpha property to 0 by tapping the left side of the screen or to 1 by tapping the right side of the screen.
5. Set **by animation type**:

<table>
<thead>
<tr>
<th>Go to</th>
<th>To animate the object to the specified value, each time the trigger is received.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go by</td>
<td>To animate the object by the specified value, incrementally, each time the trigger is received.</td>
</tr>
<tr>
<td>Stop</td>
<td>To stop a running animate value action for this property. There must be two triggers; one set to Go to/Go by, and a second set to Stop (for the same property).</td>
</tr>
</tbody>
</table>

6. Set the duration (**at time period**), acceleration (**with anim accel**), and deceleration (**with anim decel**) of the animation, as required.

**Animation Actions**

Regardless of the trigger type, you can use a trigger for various animation group options. Animation groups can be played from the beginning, stopped, paused, continued, rewound, or you can use a trigger to stop a looped animation at the end of its next cycle (break loop).

These actions can be used to control multiple animations while other animations or interactions are being executed, without any additional commands being issued manually.

After setting the trigger type, set the triggered action;

To trigger an animation group:

1. In the **Triggers** window, from **Events**, drag the **Animation action** to the **Details**, and append it to the required trigger.
2. Select the action (that you just dragged).
   The action **Properties** are displayed.
3. In the next list, select the action to apply to the animation group; Rewind and Play, Stop, Pause, Continue, Rewind, or Break Loop.
4. Select the animation group in the scene, to which to apply the action.
   The action is displayed in the list of conditions, and the complete chain of logic is displayed in the bottom list.
Set Action Script

The Action Scripts can be executed when a Trigger condition is fulfilled. After setting the trigger type, set the triggered script;

To execute a script:

1. In the Triggers window, from Actions, drag the Action Script to the Details, and append it to the required event.

2. Select the Action Script that you just dragged. The activate script window is displayed.

3. Drag the extension button of the property that you want to use in the script into the script editor. Edit the code as required. Click on the Help button to open Scripts Help file, which contains all the necessary information on available types, constructors, operators and functions.

4. Press Set and verify script to check the syntax. Possible errors are displayed in the Errors window:

5. Click on Execute script to test the script.
Set Value Actions

The Set Value action allows you to set any scene/object parameter value to on or off. After setting the trigger type, set the triggered action;

To trigger the set value:

1. In the Triggers window, from Events, drag the Set value action to the Details, and append it to the required trigger.
2. Select the action (that you just dragged).
   The action Properties are displayed.
3. Drag the extension button of property that you want to set to the button beside For property named.
   The property is displayed on the button.
4. Select the trigger action from set value from.
5. Set its value as required.
Telestrator Actions

The telestrator is most commonly triggered by an Interaction trigger. You can create buttons to set the telestrator to be shown or hidden, draw, and do/undo. The telestrator receives inputs from the x,y coordinates sent from the interactive device connected to the HDVG.

After setting the trigger type, set the triggered action;

To trigger the telestrator:

1. In the Triggers window, from Events, drag the Telestrator action to the Details, and append it to the required trigger.
2. Select the action (that you just dragged).
   The actions Properties are displayed.
3. In the next list, select the action to apply to the telestrator;
   
<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Activate</strong></td>
<td>Activate the telestrator.</td>
</tr>
<tr>
<td><strong>Deactivate</strong></td>
<td>Deactivate the telestrator.</td>
</tr>
<tr>
<td><strong>Show</strong></td>
<td>Show the telestrator.</td>
</tr>
<tr>
<td><strong>Hide</strong></td>
<td>Hide the telestrator.</td>
</tr>
<tr>
<td><strong>Start draw</strong></td>
<td>Start using the telestrator with input from the assigned device.</td>
</tr>
<tr>
<td><strong>Add point</strong></td>
<td>Add drawn points along the telestrator’s input path. Define the point’s position according to X,Y.</td>
</tr>
<tr>
<td><strong>End draw</strong></td>
<td>Stop drawing the telestrator’s path.</td>
</tr>
<tr>
<td><strong>Clear all</strong></td>
<td>Clear all telestrator drawings.</td>
</tr>
<tr>
<td><strong>Erase</strong></td>
<td>Switch the telestrator to Erase mode.</td>
</tr>
<tr>
<td><strong>Undo</strong></td>
<td>Undo last telestrator action.</td>
</tr>
<tr>
<td><strong>Redo</strong></td>
<td>Redo last telestrator action.</td>
</tr>
<tr>
<td><strong>Set style</strong></td>
<td>Set the telestrator style from the list in the details.</td>
</tr>
</tbody>
</table>

The action is displayed in the Details.
Ticker Actions

Regardless of the trigger type, you can use a trigger to control a ticker to play, stop, pause, or continue. A ticker could be triggered by animation, for example, bringing in a lower third animation to start ticker playback, or through an interaction, for example, tap a “button” to start the ticker.

After setting the trigger type, set the triggered action;

To trigger the ticker:

1. In the Triggers window, from Events, drag the Ticker action to the Details, and append it to the required trigger.
2. Select the action (that you just dragged).
   The action Properties are displayed.
3. In the next list, select the action to apply to the ticker; play, pause, continue, or stop.
4. Select the ticker in the scene, to which to apply the action.
   The action is displayed in the Details.
Animating Along a Path

A quick way to animate an object is to create a path, attach it to the Run function, and then attach a Run to the object. The object runs along the path, frame by frame, until it reaches the end of the path. You can also use a spline as a path.

**To animate an object on a path object:**

1. Place a path for the object in the scene (from the Misc. library).
2. Select the object that you want to animate and open the Transformation editor.
3. Under **Modifiers**, right-click and select **Create and refer > Path Modifier** to link the object to the path.
4. Right-click the modifier in the list and select **Edit**.
5. In the stack, select the required **Path container**. This refers the object to the path placed in the scene previously.
6. Select **Use Position** or **Use Rotation** as required. **Position** links the object’s position to the path. **Rotation** causes the object to rotate relative to the direction in which it is traveling.

   **NOTE:** **Position** links the object’s X, Y, Z position to the path’s position. **Rotation** links the object’s X, Y, Z rotation to the orientation of the path. You can separate the object from the path in the **Connections** dialog box, by removing the connections that are not required from the list of connections.

7. To animate the object’s position along the path, change the **Position on path**. This value ranges from 0 (start of the path) to 1 (end of the path). Objects can be animated along the path by creating keyframes at the desired position, as described in **Changing Keyframe Properties** on page 189.

**To animate an object on a spline object:**

1. Place a spline object and a group object in the scene (in addition to the object to animate along the spline).
2. In the spline’s Shape editor, drag the path button to the group object in the Scene Tree.

A path is applied to the group in the Helper properties.

3. Select the object that you want to animate and open the Transformation editor.

4. Under Modifiers, right-click and select Create and refer > Path Modifier to link the object to the path.

5. Right-click the modifier in the list and select Edit.

6. In the stack, in the Path container list, select the group. This refers the object to group with path properties.

7. Select Use Position or Use Rotation as required.
   - **Position** links the object’s position to the path.
   - **Rotation** causes the object to rotate relative to the direction in which it is traveling.
NOTE: Position links the object’s X, Y, Z position to the path’s position. Rotation links the object’s X, Y, Z rotation to the orientation of the path. You can separate the object from the path in the Connections dialog box, by removing the connections that are not required from the list of connections.

8. To animate the object’s position along the path, change the Position on path. This value ranges from 0 (start of the path) to 1 (end of the path). Objects can be animated along the path by creating keyframes at the desired position, as described in Changing Keyframe Properties on page 189.

Editing a Path

The Helper/Path editor is enabled when you add a path asset to a scene (from the Misc. folder in the Assets). Here, you can define parameters for animating on a run path, as described in Animating Along a Path on page 203.

To set a path:

1. With the path selected in the Scene tree, open the Helper/Path editor.

2. Double click any value to change the control point coordinates.

3. Right-click and select Insert or Append to add control points. Insert adds the control point to the control point list in the editor before any existing paths. To add control points after any existing control points, click Append.

4. In the Interpolation type list, select one of the following:

<table>
<thead>
<tr>
<th>Linear</th>
<th>With a run value of 0.5, the object would be placed halfway along the path. Animation is relative to the beginning and end points, and timing remains constant between the two, regardless of the placement of the control points between them.</th>
</tr>
</thead>
<tbody>
<tr>
<td>NonLinear</td>
<td>With a run value of 0.5, the object would be placed on the middle control point of the path (if you have an even number of segments), or halfway along the middle segment (if you have an odd number of segments), regardless of the length of the other segments. Animation between the points is constant for each pair of points.</td>
</tr>
</tbody>
</table>

5. Select or clear the Closed check box to close the start and end points of the path (thus enabling a loop).
Master Animations

Master animations are used to control timing between different animation groups directly in 4Designer, rather than having to schedule how animations are run in a controller. The master animation is a separate timeline that can contain any of the animation groups in a scene, repeatedly; these animations can be arranged on the timeline freely. A master animation can also be set to trigger other actions and export defined values at specific times. A scene can have multiple master animations, as required.

▷ To add a master animation to a scene:

- In the Timeline, click **New master animation group**.  
  A new master animation is created.

▷ To add animation groups to a master animation:

1. In the **Animation view**, from the list of animations, select the master animation.  
   The animation groups available in the scene are listed.
2. Right-click in an empty area, and select **Add Animation to Master Group**.  
   The animation groups available in the scene are listed.
3. Select the group to add to the master animation.  
   Groups are listed in alphabetical order.
4. Arrange each group on the timeline, as required.  
   To use a group repeatedly, use **Add Animation to Master Group** to add it to the master animation again.
5. Add triggers and exports as required, from the right-click menu. (To be edited in their respective windows.)  
   For more information, see **Triggers** on page 194 and **Exporting Parameters for Real-time Manipulation** on page 168.
8. Interactivity

You can define all 4Designer objects as interactive, in order to be manipulated when using a touch screen or a mouse. This interactivity must be enabled in 4Designer, along with any graphic changes that are required, using animations or exports. Expected results of the user’s touch must be set up in the 3DPlay controller.

**NOTE:**
This feature requires a separate license in RenderEngine. For more information, contact Avid support.

Physical properties and constraints can be applied to objects using the physics engine, in order to simulate natural movement and to keep objects within certain boundaries at all times, especially when using touch-screen manipulation.

**TIP**
The Interactive_game scene, installed with 4Designer, contains an example of what can be done with interactivity and triggered animations.

In this section:

- *Making Objects Interactive* on page 208
- *Applying Physical Properties* on page 212
- *Constraining Objects* on page 215
- *Web Interaction* on page 219
8. Interactivity

To enable interactivity for an object:

1. Select the object in the Scene Tree.

2. Right-click in the Interactions column in the Scene Tree, and select New Interaction > External Manipulation.

The Interactions editor is displayed.
3. Define the object’s interactivity as follows.

<table>
<thead>
<tr>
<th>Interaction</th>
<th>Define the object as interactive, in order to enable it to ‘sense’ a trigger for other events to take place, as set up in the 3DPlay controller.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Can Tap</strong></td>
<td>the object can trigger an event with a single touch to the screen. This parameter must be selected when the scene is loaded if the object needs to be interactive at any point during the scene.</td>
</tr>
<tr>
<td><strong>Can Tap Active</strong></td>
<td>export this parameter in order to enable and disable interactivity from the controller, when the object needs to be interactive.</td>
</tr>
<tr>
<td><strong>Can Drag</strong></td>
<td>the object can trigger events when touching, dragging, and releasing the object on screen. Different events can be triggered for each of the three actions. This parameter must be selected when the scene is loaded if the object needs to be interactive at any point during the scene.</td>
</tr>
<tr>
<td><strong>Can Drag Active</strong></td>
<td>export this parameter in order to enable and disable interactivity from the controller, when the object needs to be interactive.</td>
</tr>
<tr>
<td><strong>Can Hold</strong></td>
<td>the object can trigger an event when touching and releasing the object on screen. Different events can be triggered for each of the two actions. This parameter must be selected when the scene is loaded if the object needs to be interactive at any point during the scene.</td>
</tr>
<tr>
<td><strong>Can Hold Active</strong></td>
<td>export this parameter in order to enable and disable interactivity from the controller, when the object needs to be interactive.</td>
</tr>
</tbody>
</table>

**NOTE:**
It is recommended not to set both drag and translate for an object.

<table>
<thead>
<tr>
<th>Coordinate system</th>
<th>Screen - Use the coordinates of the screen area to identify interaction events.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Texture - use the coordinates of a texture assigned to the object to identify interaction events.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Style</th>
<th>Manipulation means that an object can be moved, turned, or resized on a touch screen. When the style is set to No manipulation, the object can be used to trigger an event only. When the style is set to On screen or On grid, the Manipulation control settings (below) are displayed.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>NOTE:</strong> If no Manipulation style or control options are selected, the object is still treated as an interactive object that is manipulated by touching and releasing. No other actions affect the object.</td>
</tr>
</tbody>
</table>

| Damping              | Set damping to gradually reduce the repetitive action of an object. Lower values set the object to respond to dragging interaction more quickly. Higher values limit the “bounce” an object displays when released from dragging. |

<p>| Inertia              | Set the level of inertia applied to the object to determine how much it continues to move after it is released from the interaction. |</p>
<table>
<thead>
<tr>
<th>Constraint Force Mixing</th>
<th>Set the perceived hardness of the constraints set for an object. Lower values make the constraints inflexible, higher values make the constraints appear flexible.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error Reduction Parameter</td>
<td>Specify what proportion of the joint error is fixed during the next simulation step. 0 means that no correcting force is applied and the bodies will drift apart as the simulation proceeds. 1 means that the simulation will attempt to fix all joint error during the next time step. However, setting 1 is not recommended, since joint error will not be completely fixed due to various internal approximations. A value between 0.1 to 0.8 is recommended (0.2 is the default).</td>
</tr>
</tbody>
</table>
| Manipulation Control | These settings define whether an object can be moved, turned, or resized on a touch screen. How the action is done on screen depends on the capabilities of the screen itself. **Translation** – enables an object to be moved on screen, horizontally, vertically or in both directions. If translation is set to none, then the object is unmovable on a touch screen.  

**NOTE:** It is recommended not to set drag and translate for an object together.  

**Rotation** – enables an object to be turned on a touch screen (i.e., rotated around its Z axis).  

**Scale** – enables an object to be resized on screen, depending on the type of manipulation that the screen supports.  

Manipulation grid - these parameters become available when a manipulation style is selected; set the ways an object can be manipulated for the selected style. |
Tips for Designing Interactive Scenes

- Export the physics engine state so that you can enable/disable physics from 3DPlay.
- Remember that users need an indication that the system has ‘sensed’ their action. Provide user feedback; program the object so that it is completely obvious the object has been triggered.
- Allow convenience for left and right-handed users.
- Do not scale interactive objects, or their parent nodes / child nodes to zero on any axis. (The physics engine cannot simulate an object with no physical presence). If you need to hide an object, turn off the visibility.
- Avoid placing interactive objects at the same Z-position, if they need to overlap.
- Objects cannot simultaneously use Drag and Free Manipulation; drag is a gesture across the object which will overrule free manipulation.
- Make objects large enough for comfortable manipulation by presenters in real time.
- Masks or other invisible objects in front of interactive objects might block the selection of the interactive objects. Make sure interactive objects are not blocked by objects that you cannot see. The same applies to overlapping objects.
- Existing scenes can be reworked for interactivity conveniently, by using hotspots: place interactive objects that are displayed without color or key in front of drawn objects, so that the drawn objects appear interactive. You can use an animation to provide user feedback.
- Transparent interactive objects can be used in a display that appears blank/empty to trigger an ‘animation-in’ type action. Once the action is executed, you can disable the transparent object by switching its visibility off.
- Be aware that objects that are offset from their axis may show unexpected results when using direct manipulation.
- You can design scalable objects for single touch screens by adding an interactive control button to switch an object between scaling mode, and direct manipulation.
Applying Physical Properties

To apply physical properties to an object:

1. In the Scene Tree, right-click the object in the Physics column.
2. Select New Physics > Physics.

The following default physical properties are displayed in the Physics editor and applied to the object:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mass</td>
<td>Define object mass, between 1 and 0. 1=A high mass object in motion will come to rest, when released, before a low mass object. 0=immovable object. The objects will still cause collisions with other objects, but they will never move. This allows you to make objects that act as barriers within scenes.</td>
</tr>
<tr>
<td>Damping Angular</td>
<td>Set angular damping to define how the quickly the object decelerates in relation to its rotation, between 1 and 0. 0=infinite rotation, 1=no rotation.</td>
</tr>
<tr>
<td>Damping Linear</td>
<td>Damping is the effect reducing the repetitive action of an object. Set linear damping to define how the quickly the object decelerates in relation to its position, between 1 and 0. 0=infinite movement, 1=no movement.</td>
</tr>
<tr>
<td>Restitution</td>
<td>Define the resilience of the object, between 1 and 0. 1=completely resilient, 0=completely soft.</td>
</tr>
<tr>
<td>Friction</td>
<td>Define the friction of the object with other objects, between 1 and 0. 1=maximal friction (no slide), 0=no friction (no resistance).</td>
</tr>
<tr>
<td>Object Type</td>
<td>Dynamic objects move when you activate the Physics Engine, and mass is taken into account. Static objects remain in place, and mass is disregarded.</td>
</tr>
<tr>
<td>Collisions</td>
<td>Select this check box to set the object to collide with other physical objects, or clear to set as an object with physical properties that does not collide with other objects.</td>
</tr>
</tbody>
</table>
Applying Physical Properties

8. Interactivity

Activating Physics

In order to see the effect of the physical properties set for objects, you must activate the Physics Engine.

➢ To display the Physics Engine dialog box:

- Open the Scene Configure window, and click the Physics tab.

Set the options in the Physics Engine dialog box as required:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play/Stop Physics</td>
<td>Activate or deactivate the Physics Engine to simulate objects physical properties.</td>
</tr>
<tr>
<td>Save scene before physics activated</td>
<td>Select this check box to automatically save the entire scene each time you activate the Physics Engine.</td>
</tr>
<tr>
<td>Stop at scene save</td>
<td>Select this check box to deactivate the Physics Engine each time you save the scene (recommended).</td>
</tr>
</tbody>
</table>
To play physical properties:

- Click Play 🎁 in the Physics tab.

**NOTE:** Export the physics play state for all interactive scenes; turning the physics on/off from 3Dplay is required to run interactivity (or to stop the user from interacting with the scene).
Constraining Objects

Constraints are joints that connect two dynamic objects together. Each constraint provides a different type of joint, which limits the motions of the dynamic objects in a specific way.

The constraint object is an object with no visual or physical properties. A constraint must have two referring objects. If only one object requires a constraint, a dummy object (with no visual or physical properties) must be created to be used as a node for referral.

The following constraint types are available in 3Designer:

<table>
<thead>
<tr>
<th>Constraint</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cage</td>
<td>The cage constraint uses a scene object to create a three-dimensional border around an object (or group of objects). Any objects included in the cage constraint will remain inside the cage when manipulated.</td>
</tr>
<tr>
<td>Cone twist</td>
<td>The cone twist is an angular joint that can behave like a human elbow. It is a special point to point constraint that adds cone and twist axis limits. The x-axis serves as twist axis.</td>
</tr>
<tr>
<td>Generic 6 degrees</td>
<td>A generic constraint that can emulate a variety of standard constraints by changing the parameters of the six degrees of freedom that are available.</td>
</tr>
<tr>
<td>Hinge</td>
<td>The hinge constraint defines a line in space around which referred objects can rotate.</td>
</tr>
<tr>
<td>Point to Point</td>
<td>This constraint defines a point that referred objects are bound to; the distance of the objects from this point is constant, but the position of the constraint can vary.</td>
</tr>
<tr>
<td>Slider</td>
<td>The slider constraint defines a line in space along which referred objects can move or rotate around. This constraint is defined for the X axis only. For the object to appear to move along any other axis, the constraint and objects must be grouped, and the group must be rotated.</td>
</tr>
</tbody>
</table>

To create a constraint between two objects:

1. Create an object with no visual or physical properties; right-click an existing object on the Scene Tree, and select New Container.
   An empty node is created in the scene. Rename it, as required.
2. In the Scene Tree, right-click in the Constraints column, and select New Constraints.
3. Select the type of constraint.
4. In the Constraints editor, select the objects to be connected or affected.
5. Set the constraint parameters for each type as described in the following sections.
### Cage Constraint

The cage constraint creates an area of space defined by the bounding box of the defined object. The space can contain anything that is included with the constraint.

For example, a box object and all objects that are included within the volume of the box. (Although the objects can bounce off the walls of the cage, they do not collide in the same way as if they had physical properties.)

The following options can be set for a cage constraint:

<table>
<thead>
<tr>
<th>Cage effect enabled</th>
<th>Select to turn the cage effect on, or clear to turn off.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restitution</td>
<td>Define the resilience of the cage, between 1 and 0. 1=completely resilient, 0=completely soft.</td>
</tr>
<tr>
<td>Size</td>
<td>Set a boundary limit for the XYZ sides of the cage constraint. When disabled, the cage will be infinite in that direction.</td>
</tr>
<tr>
<td>Objects in cage</td>
<td>Objects in the Scene Tree are listed here. Move them right or left to set if they are affected by the cage constraint or not.</td>
</tr>
</tbody>
</table>

### Cone Twist Constraint

The cone constraint is like an elbow joint, allowing you to flex your arm on two axes rather than one (like a hinge).

The following options can be set for a cone constraint:

<table>
<thead>
<tr>
<th>Span 1 Angle</th>
<th>Set the angular range of axis 1 of the cone twist.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Span 2 Angle</td>
<td>Set the angular range of axis 2 of the cone twist.</td>
</tr>
<tr>
<td>Twist Angle</td>
<td>Set the angular range of how much the objects can rotate around the X axis. For example, When you roll your wrist, your elbow joint does not flex, yet your arm turns about its length.</td>
</tr>
<tr>
<td>Motor angular enabled</td>
<td>Select this check box to move the object, or clear to disable motion.</td>
</tr>
<tr>
<td>Motor angular max impulse</td>
<td>Define the force applied to the object to create movement. The greater the max impulse, the less the motor will be impeded by objects that touch it.</td>
</tr>
<tr>
<td>Damping angular</td>
<td>Reduce or increase the repetitive action of an object as required.</td>
</tr>
<tr>
<td>Node 1, 2</td>
<td>The list contains all the objects in the Scene Tree. Select the two objects to connect.</td>
</tr>
<tr>
<td>Motor target rotation</td>
<td>The motor provides automatic motion around the XYZ axes without user input or animation.</td>
</tr>
</tbody>
</table>
### Generic Six-Degree Constraint

The generic constraint constrains two objects together without any other limitations.

The following options can be set for a generic constraint:

<table>
<thead>
<tr>
<th><strong>Linear limits</strong></th>
<th>Set the range of movement of the objects along the each axis.</th>
</tr>
</thead>
</table>
| **Angular limits**| Set the rotation range of the object around the constraint for each axis.  
**No limit** for free rotation, **Rigid** for no rotation, **Limited** to set rotation limits in degrees.  
When **Limited** is selected, set the following:  
**Limit High** - the greatest object rotation angle.  
**Limit Low** - the smallest object rotation angle. |
| **Node 1, 2**     | The list contains all the objects in the Scene Tree. Select the two objects to connect. |

### Hinge Constraint

The hinge constraint defines a line in space around which referred objects can rotate. By moving the objects to their required positions prior to starting the physics engine, you determine the distance from the hinge constraint.

The following options can be set for a hinge constraint:

| **Angular limit type** | Set the rotation range of the object around the constraint.  
**No limit** for free rotation, **Rigid** for no rotation, **Limited** to set rotation limits in degrees.  
When **Limited** is selected, set the following:  
**Limit High** - the greatest angle that the objects can be rotated.  
**Limit Low** - the smallest angle that the objects can be rotated. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Motor enabled</strong></td>
<td>The motor drives the hinge to a specific point. The object can be moved manually around the constraint, but upon releasing the object, the motor would drive it to the <strong>Motor angle</strong> over the time set in <strong>Motor time</strong>.</td>
</tr>
<tr>
<td><strong>Motor max impulse</strong></td>
<td>Define the force applied to the object to create movement. The greater the max impulse, the less the motor will be impeded by objects that touch it.</td>
</tr>
<tr>
<td><strong>Node 1, 2</strong></td>
<td>The list contains all the objects in the Scene Tree. Select the two objects to connect.</td>
</tr>
</tbody>
</table>
Point to Point Constraint

A point to point constraint defines a point that referred objects are bound to; the distance of the objects from this point is constant, but the position of the constraint can vary.

Node 1, 2  The list contains all the objects in the Scene Tree. Select the two objects to connect.

Slider Constraint

A slider constraint defines a line in space along which referred objects can move or rotate. This constraint is defined for the X axis only. For the object to appear to move along any other axis, the constraint and objects must be grouped, and the group must be rotated.

The following options can be set for a slider constraint:

<table>
<thead>
<tr>
<th>Linear limit Type</th>
<th>Set the range of movement of the objects along the slider path. <strong>No limit</strong> for free movement along the slider path (and off-screen), <strong>Rigid</strong> for no movement, <strong>Limited</strong> to set position limits on the X axis.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node 1, 2</td>
<td>The list contains all the objects in the Scene Tree. Select the two objects to connect.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Linear limit high/low</th>
<th>Set the low and high range of movement of the objects along each axis.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Angular limit type</td>
<td>Set the rotation range of the object along the slider path. <strong>No limit</strong> for free rotation, <strong>Rigid</strong> for no rotation, <strong>Limited</strong> to set rotation limits in degrees. When Limited is selected, set the following: <strong>Limit High</strong> - the greatest angle that the objects can be rotated to. <strong>Limit Low</strong> - the smallest angle that the objects can be rotated to. <strong>NOTE:</strong> Rotation must be selected in physics tab.</td>
</tr>
<tr>
<td>Angular Motor enabled</td>
<td>This motor drives the object around the X axis. <strong>Max force</strong> define the force applied to the object to create movement. The greater the max impulse, the less the motor will be impeded by objects that touch it. <strong>Velocity</strong> is the speed of the object along the slider. Set the initial speed of the object around the X axis.</td>
</tr>
<tr>
<td>Linear Motor enabled</td>
<td>This motor drives the object along the length of the slider. <strong>Max force</strong> define the force applied to the object to create movement. The greater the max impulse, the less the motor will be impeded by objects that touch it. <strong>Velocity</strong> is the speed of the object along the slider. Set the initial speed of the object along the slider.</td>
</tr>
<tr>
<td>Node 1, 2</td>
<td>The list contains all the objects in the Scene Tree. Select the two objects to connect.</td>
</tr>
</tbody>
</table>
Web Interaction

Interactive objects can be set as an interface with a Windows PC application, a feature useful for controlling a web browser. The PC must have a video card capable of HD-SDI output, and be running the MouseTalk application.

To set the object as a control:

1. After setting the object as interactive (see Making Objects Interactive on page 208), select the Can Tap and Can Drag interactions in the Interactions editor.
2. In the Scene Tree, right-click the Interactions column, and select Edit Interactions.

   The Interactions editor is displayed.
3. Set the Coordinate system to Texture.
4. Rename the object (F2). The prefix must be “ExtInt”.

   The object can now control a connected PC interface.
9. Customization

In this section:

Customizing the Main Screen on page 221
Customizing the Scene Tree on page 222
Setting Preferences on page 223
Customizing the Main Screen

4Designer’s main screen is organized for convenient use, and has a number of preset options that allow you to switch between preset screen setups quickly and easily from the Layout toolbar (see Layout options on page 225).

To adapt the main screen to your needs, drag any pane by its side bar to the required area.

Completely hide or display tabs from the Windows options in the View menu (see page 37).

enaries

To save a layout:

- Select View > Layout > Save layout.
  Layouts are saved as .MDL files

To load a saved layout:

- Select View > Layout > Load layout, and select any .MDL file.

For more information, see Layout on page 225.
Customizing the Scene Tree

The Scene Tree’s display mode can be controlled from its heading strip. Right-click within the tree to open a menu with the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New Layer</strong></td>
<td>Create a new layer in the scene.</td>
</tr>
<tr>
<td><strong>New Container</strong></td>
<td>Create a dummy object, with no visual or physical properties, to use as a placeholder.</td>
</tr>
<tr>
<td><strong>Group Containers</strong></td>
<td>Add the selected objects to a new group.</td>
</tr>
<tr>
<td><strong>Rename</strong></td>
<td>Rename the selected object.</td>
</tr>
<tr>
<td><strong>Remove</strong></td>
<td>Delete the selected object.</td>
</tr>
<tr>
<td><strong>Cut Copy Paste</strong></td>
<td>Cut, copy, or paste objects in the Scene Tree.</td>
</tr>
<tr>
<td><strong>Split</strong></td>
<td>Divide the current tree view into two horizontal panes.</td>
</tr>
<tr>
<td><strong>Merge</strong></td>
<td>Remove the selected split pane from the tree view.</td>
</tr>
<tr>
<td><strong>Previous/Next Layer</strong></td>
<td>Jump to previous or next layer in the Scene Tree.</td>
</tr>
<tr>
<td><strong>Isolate Selection/Clear Isolation</strong></td>
<td>Display only the selected objects in the RE window. Clear Isolation re-displays all objects.</td>
</tr>
<tr>
<td><strong>Expand/Shrink</strong></td>
<td>Expand All - display all elements of the scene in the Scene Tree. Expand Sub Tree - display all elements of the selected layer. Shrink All - display only layer elements in the Scene Tree. Shrink Sub Tree - display the current layer element only, hide objects.</td>
</tr>
</tbody>
</table>
Setting Preferences

Many of 4Designer’s default settings can be customized for your needs.

**NOTE:**

*Changing preferences sometimes requires 4Designer to be restarted.*

To set your program preferences:

1. Select **View > Settings**.
   
   The **Preferences** window opens.

2. Select an item from the list on the left, and set your preferences, as required.
Appearance

In the Appearance window, you can select the GUI layouts to be displayed by the Layout toolbar buttons, select a style sheet to change 4Designer’s look, and alter the color coding used in the math and trigger editors.
4Designer has five available predefined screen layouts, that are displayed using the toolbar button, shown here.

| Layout 1
| Layout 2
| Layout 3
| Layout 4
| Layout 5

You can change the layout names or browse to select different .MDL layout files to be loaded for each button.

<table>
<thead>
<tr>
<th>Style Sheet</th>
<th>Select an HTML style sheet to change 4Designer’s look.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Math Editor Colors</td>
<td>Customize the color coding for different function type display in the math editor.</td>
</tr>
<tr>
<td>Trigger Editor Colors</td>
<td>Customize the color coding for different element type display in the trigger editor.</td>
</tr>
</tbody>
</table>
9. Customization

Extension Button Hotkeys

In the **Extension button hotkeys** window, you can set shortcuts for extension button options.

➤ **To assign a shortcut:**

1. In the list on the left, select an action that is not connected to a shortcut.
2. In the list on the right, select a shortcut that is not in use.
3. Click **Connect**.

   The shortcut is connected to the action.
Files and Directories

The **Files and Directories** window provides information about what folders 4Designer uses as resource libraries, how 4Designer connects to RenderEngine, and where the log file is stored. Resource paths cannot be changed in this window.

<table>
<thead>
<tr>
<th>Working directory</th>
<th>The folder in which all application files are stored.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pools Specification file</td>
<td>The file that controls what parts of the GUI are displayed.</td>
</tr>
<tr>
<td>Icons directory</td>
<td>The folder where any special icons used by plugins (such as ARTS) are stored.</td>
</tr>
<tr>
<td>Specification Icons directory</td>
<td>The folder where you can place pool/specification icons to replace them in 4Designer without recompiling. Default icons are embedded in the code. E.g., ARTS use this directory for some of their plugins to add customization to the embedded icons.</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reference directory</td>
<td>The directory in which all data shared with other applications is stored.</td>
</tr>
<tr>
<td>Projects directory</td>
<td>The directory in which all projects created in 4Designer are stored (unless otherwise specified).</td>
</tr>
<tr>
<td>RenderEngine Configuration directory</td>
<td>The directory in which data relating to RenderEngine’s video format is stored.</td>
</tr>
<tr>
<td>Start remote RE script</td>
<td>Select a file to use as a script to start RenderEngine on an HDVG.</td>
</tr>
<tr>
<td>Script called after scene compact</td>
<td>Select a file to use as a script to execute when a scene is saved.</td>
</tr>
</tbody>
</table>
Hotkeys (Shortcuts)

In 4Designer you can set the Hotkeys to reconfigure the keyboard shortcuts, as required.

To assign a hotkey/shortcut:
1. In the left column, select an action that is not connected to a shortcut.
2. Place the cursor in the Hotkey field at the top and press the required keyboard shortcut.
3. Click OK.
   The shortcut is connected to the action.

To cancel a hotkey/shortcut:
- Double click the keyboard combination in the Shortcut column, and delete it.
Log

In the **Log** window, you can define the log file path, which entries are recorded in the log file, and color code the entries.

- **To set log file entries**
  1. Select the type of entry you want in the log file.
  2. Select the color for each entry type.
  3. Click ... to set the file path.
  4. Click **Close** to close the dialog box.
Miscellaneous

The **Miscellaneous** window contains various setting options.

<table>
<thead>
<tr>
<th>Animation</th>
<th>Set the animation timeline to <strong>Snap to Fields</strong> (0, 0+, 1, 1+, etc.) or <strong>Snap to Frames</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default mode for</td>
<td>Set the default animation mode used when creating a keyframe. <strong>Linear</strong> - the sete segment of</td>
</tr>
<tr>
<td>keyframe creation</td>
<td>the animation following the keyframe is accelerated at its beginning and decelerated at its end.</td>
</tr>
<tr>
<td></td>
<td>The rates of acceleration and deceleration can be set as required. For more information, see</td>
</tr>
<tr>
<td></td>
<td><strong>Changing Keyframe Properties</strong> on page 189.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Timeline space bar shortcut - jump</td>
<td>Set the number of keyframes to jump when you press the space bar.</td>
</tr>
<tr>
<td>Auto advancing timeline</td>
<td>When selected, the option to automatically advance a looped animation (on the timeline) is applied in the RE window. When cleared, a looped animation is played once in the RE window, without looping.</td>
</tr>
<tr>
<td>Display Timecode instead of frame</td>
<td>Set the timing method used for animation. When cleared (default) fields and frames are displayed in the timeline, and in all other time-related parameters. When selected, time is displayed in HH:MM:SS format.</td>
</tr>
<tr>
<td>Create keys for</td>
<td>Select or clear the parameters to use when using Create Key in the Animation strip to create a keyframe, and the level to which the selected parameters are applied.</td>
</tr>
<tr>
<td>Show dialog while creating keys</td>
<td>Select this option to show the Create Keys dialog box when you click Create Key in the Animation strip. Clear to create a key with the last used settings.</td>
</tr>
<tr>
<td>Create new float keyframes with free handles</td>
<td>When creating new keyframes, create free handles for them in the Animation view, in spline mode.</td>
</tr>
<tr>
<td>History</td>
<td>Set or remove a limit to the number of user actions to be saved in the history.</td>
</tr>
<tr>
<td>Autosave</td>
<td>Enable/disable Autosave, and set its frequency when enabled.</td>
</tr>
</tbody>
</table>
Object Operations

In the **Object Operations** window, you can define what happens to applied properties (available in the Used Objects gallery), when the object or property is removed or renamed.

**To set remove/rename options:**

1. Select the object or property for which you want to change remove/rename options.
2. Choose the appropriate remove/rename options on the right.
3. Click **OK** to close the dialog box.
Paste

You can set the paste options to save time performing repetitive tasks that can be performed upon pasting.

For example, when copying objects, you can set 4Designer to copy the color properties but not the light properties, or choose to refer certain properties.

Select Settings > Paste Options (in 4Designer Advanced), or in the Preferences dialog box, select Paste Options.

To set paste options:

1. Select the icon that corresponds to the Property Editor tab whose paste options you want to change, and select the appropriate option in the right column.
2. Similarly, select the appropriate Paste options for Animations, Exports, and Keyframes.
In the **RenderEngine** window, you can set the RenderEngine to run locally with the RenderEngine preview in Windows, or remotely, connected to an HDVG, and set many RE window related options.

### Display safe area
Hide or display the safe work area indicator in the Preview window. From the list, you can select the safe area aspect to display when 4Designer is started. This list reflects the selection made in the Main toolbar (see *Tools Menu* on page 35). If you select **Current** from the list, the safe area is shown according to the **Display Aspect** set under **Local**.

### Allow use of locks
**Allow Use of Locks** – select this check box to lock RE from being used by another application.
### Current Object Color

The current object is the last selected object, either selected in the Object Tree/Preview window, or found in a search. Display or hide each indicator by selecting or clearing the respective check box. Click the color bar to display the Color Picker window to change the color.

- **Border** – a border around the outer pixels of the object that highlights the object.
- **Local bounding box** – the object’s bounding box.
- **Hierarchial bounding box** – the group’s bounding box, if there is a selected group.
- **Ticker box** – indicates the clipping planes of a ticker object.
- **Text box** – indicates when text type is word-wrap.

### Selected Object Color

A selected object is any object that has been selected in the Object Tree/Preview window (multi selection is possible, but the last selected object is still the “current” object). Display or hide each indicator by selecting or clearing the respective check box. Click the color bar to display the Color Picker window to change the color.

- **Border** – a border around the outer pixels of the object that highlights the object.
- **Local bounding box** – the object’s bounding box.
- **Hierarchial bounding box** – the group’s bounding box, if there is a selected group.

### Mouse Above Object Color

Set the color that is displayed when hovering the mouse over any object in the Preview window.

- **Border** – a border around the outer pixels of the object that acts as a highlight.
- **Local Bounding Box** – the object’s bounding box.
- **Hierarchial Bounding Box** – the group’s bounding box, if there is a selected group.

### Local RE video format

- **Format** – select the video standard. To use a custom video standard, select Custom from the list, and set **Width** and **Height** dimensions, **Frame Rate**, and **Display Aspect**, as required.
- **Process priority** – set the priority of the Preview window for computer resource allocation.
- **Multi tiles** - select the number of screens to which your output is sent (such as a PowerWall video wall), and their layout.

- **Behavior of RE when scene has different defined aspect ratio**
  - define how the scene is displayed when authored using one aspect ratio and displayed in a viewport with a different aspect ratio.

### Local RE viewports

Select the number of viewports to display in the local RE window.

### HDVG RE

HDVG mixing - see [Internal Mixer](#) on page 237
Internal Mixer

The internal mixer option is activated in the **RenderEngine** settings in **HDVG mixing**. This option allows you to use the internal linear keyer of the HDVG platform to apply mixing, turn mixing off, or to use RenderEngine’s current mixing setting.

Switching on pre-multiplied mixing causes the HDVG board to render half-transparent pixels on the video background correctly. When you use pre-multiplication the background must be set to black. Borders of objects that are on top of the mixed picture become brighter.

![Pre-multiply off](image1.png)  ![Pre-multiply on](image2.png)
10. Shaders

In this section:

*Using Shaders* on page 239

**NOTE:**

Using shaders requires a separate license, obtainable from Avid. For more information, contact Avid support.

Old CG shaders are not supported in 4Designer. Shaders written in CG should be ported to GLSL. Scenes created using versions earlier than RE 7.X (containing shaders) will not be rendered correctly unless the shaders are re-assigned.
Using Shaders

Shaders are used to define different surface or modeling attributes for a 4Designer object. Shaders can affect the geometry of the object (vertex) or the surface of the objects (pixel) for different effects that are not normally achievable in real-time graphics. The shader feature allows filtering to be applied to objects.

Available Shaders range from simple effects, such as sepia toning, edge detection, and luminance filtering, to more complex morphing and wave effects. Currently, two shaders can be applied to an object, one of each type. This must be encoded in the shader file. To see how to do this, see *Creating a Shader from Scratch* on page 241.

Following are some examples of the effects that can be achieved using Shaders:

- Text is twisted on the z-axis. The amount of twist can be controlled and animated.

- A blur shader is applied to the brick texture. The amount of blur can be animated. This could be used, for example, to blur and sharpen different video insertions, in order to focus attention.
• A pixel shader is applied to the object. The appearance of the text is affected by an additional vertex shader. This displacement can be animated to give the text a floating look.

Applying a Shader

Shaders are available in the Shaders folder in the Misc. tab in the Assets.

To apply a shader:

1. Select an object.
2. Drag and drop a shader from the Shaders folder onto the object (in the Preview window or in the Scene Tree).
3. Click the shader object in the Scene Tree to open the **Shader** editor.

All shaders that have been applied in the scene can be selected from the Shader list.

When you click **Shader** (in the Editor), the selected shader can be edited in the stack.

Creating a Shader from Scratch

This section gives an example of how to create a shader from scratch for use in 4Designer.

**To create a shader file:**

1. Open a text editing program, such as Notepad or Wordpad.
2. Copy and paste the following GLSL code in to the file.

   ```glsl
   #include "FragmentCommon.glsl"
   #include "FragmentFunctions.glsl"
   // Twirl filter
   uniform float twist_rotation;
   vec2 calcTexCoord(vec2 aTexCoord)
   {
      vec2 p5 = vec2(0.5, 0.5); // center point
      vec2 offset_tc = aTexCoord.xy - p5; // re-center texture coordinate
      float dis = length(offset_tc); // distance to the center
      float angle = atan(offset_tc.y, offset_tc.x) + twist_rotation*(dis-1); // new angle
      vec2 new_tc = dis*.7*vec2(cos(angle), sin(angle)) + p5; // new texture coordinate
      //
      return new_tc;
   }
   vec3 calcTexCoord(vec3 aTexCoord)
   {
      return vec3(calcTexCoord(aTexCoord.st), aTexCoord.p);
   }
   void main()
   {
      // Diffuse
      if (State.IsLightingEnabled)
         OutColor = mix(In.DiffuseBack, In.Diffuse, gl_FrontFacing);
      else
         OutColor = In.Diffuse;
      OutUniqueColor = State.Color.Unique;
      // Texturing
   }
   ```
if (TextureUnits.Count > 0)
{
if (TextureUnits.Unit[0].Type == TextureUnitType2D)
OutColor = ProcessTextureUnit(0, OutColor, texture(Tex2D[0],
calcTexCoord(In.TexCoord[0].st)));
if (TextureUnits.Count > 1)
{
if (TextureUnits.Unit[1].Type == TextureUnitType2D)
OutColor = ProcessTextureUnit(1, OutColor, texture(Tex2D[1],
calcTexCoord(In.TexCoord[1].st)));
if (TextureUnits.Count > 2)
{
if (TextureUnits.Unit[2].Type == TextureUnitType2D)
OutColor = ProcessTextureUnit(2, OutColor, texture(Tex2D[2],
calcTexCoord(In.TexCoord[2].st)));
if (TextureUnits.Count > 3)
{
if (TextureUnits.Unit[3].Type == TextureUnitType2D)
OutColor.a *= texture(Tex2D[3], calcTexCoord(In.TexCoord[3].st)).a;
if (TextureUnits.Unit[3].Type == TextureUnitType2DArray)
OutColor.a *= texture(Tex2DArray[3], calcTexCoord(In.TexCoord[3].stp)).a;
}
}
}
}
// ProcessMasks();
// Specular
if (State.IsLightingEnabled)
OutColor.rgb += mix(In.SpecularBack.rgb, In.Specular.rgb, gl_FrontFacing);
// Global alpha
OutColor.a *= State.Color.GlobalAlpha;
// Alpha test
if (State.Test.IsAlpha &&
OutColor.a <= State.Test.AlphaReference)
discard;
}
3. Save the file as G:\Shaders\TwirlTextureFragmentShader.cg
Assigning a Shader to an Object

To assign a shader:

- Select an object in the Scene Tree, and click Tools > Shaders. The Shader Importer dialog box opens.

Assign the correct shader type in the appropriate field, and click OK.
11. Importing Objects

In this section:

4Designer can import models that have been created in a third-party modeling package. Models may contain texture, materials and key frame animations that can all be used and edited after being imported to 4Designer. You can also import models that have been prepared in a flipbook format.

4Designer supports import of the following formats: OBJ, DXF, 3DS, LWO, DAE, VRML, X3D, and FBX.
Exporting Graphics for Use in 4Designer

Export 3D models for use in 4Designer in one of the following formats:

- VRML
- OBJ
- DXF
- 3DS
- DAE
- LWO
- X3D
- FBX

Select the properties to export for use in 4Designer, as required.

Limitations of Object Importing

Different object types support importing different properties, as detailed here:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VRML</td>
<td>The same support as in 3Designer, support for the X3D format has been added, geometry based on triangles, possibly on quads.</td>
</tr>
<tr>
<td>OBJ</td>
<td>Format without animation, geometry based on triangles, possibly on quads.</td>
</tr>
<tr>
<td>DXF</td>
<td>Format without animation, geometry based on triangles, possibly on quads.</td>
</tr>
<tr>
<td>3DS</td>
<td>Animations without rotations, geometry based on triangles, possibly on quads.</td>
</tr>
<tr>
<td>DAE</td>
<td>Linear and bezier animations supported. Sampled animations. Advanced animations of skeletons and skins not supported, geometry based on triangles, possibly on quads.</td>
</tr>
<tr>
<td>LWO, LWS</td>
<td>Linear and bezier animations supported. Sampled animations. Geometry based on triangles, possibly on quads.</td>
</tr>
<tr>
<td>FBX</td>
<td>Animations without rotations. (FBX versions 2011 (7.1) and 2012 (7.2) are supported.)</td>
</tr>
</tbody>
</table>
Importing Objects into 4Designer

To import an object:

1. Select File > Import.
2. Select one of the following options:

<table>
<thead>
<tr>
<th>Import</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compacted Scene</td>
<td>Browse to import a 3Designer or 4Designer scene from another system. All required resources are saved to the correct locations.</td>
</tr>
<tr>
<td>Geometry 3D</td>
<td>Browse to import an object of the following types: FBX, DAE, 3DS, LWS, LWO, OBJ, DXF.</td>
</tr>
<tr>
<td>Mocha Objects</td>
<td>Open a dialog box to set how to import Mocha objects or camera paths.</td>
</tr>
<tr>
<td>PDF</td>
<td>Browse to import a PDF file as a texture applied to a rectangle object. Each Page of the PDF is converted into an object.</td>
</tr>
<tr>
<td>Photoshop</td>
<td>Browse to import graphics in Adobe PSD format.</td>
</tr>
<tr>
<td>PowerPoint Presentation</td>
<td>Browse to import an MS PowerPoint presentation. PowerPoint must be installed.</td>
</tr>
<tr>
<td>VRML/x3d</td>
<td>Browse to import an object of the following types: WRL, VRML, X3D.</td>
</tr>
<tr>
<td>SVG</td>
<td>Browse to import an SVG object</td>
</tr>
</tbody>
</table>

3. For each object, select the properties that you want to import from the options displayed for that object type, considering the limitations specified in VRML Elements in 4Designer on page 248.

When importing VRML objects, select the required options as follows:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use lights</td>
<td>Enables importing lights used in the VRML model.</td>
</tr>
<tr>
<td>Double sided mesh</td>
<td>If you have triangles that are oriented incorrectly, and you have no tools available to reorient them (such as 3dsMax), select this check box to correct the problem.</td>
</tr>
<tr>
<td>Reverse all normals</td>
<td>If all your triangles are incorrectly oriented, select this check box to invert all of the objects’ normals.</td>
</tr>
</tbody>
</table>
### Animation Cycles
If you are importing a Flipbook VRML model, this option is enabled; here you can select which of the animation types are imported.

When the **Common Textures** check box is selected, the textures that are used in the scene will automatically be referenced to each model that is created from the flipbook. If the check box is cleared, a new instance of each texture will be assigned to each model in the flipbook.

The **Common Lights** check box is disabled and selected. The lights in the scene are automatically referenced to all the materials.

When the **Common Materials** check box is selected, the materials that are used in the scene will automatically be referenced to each model that is created from the flipbook. If the check box is cleared, a new instance of each material will be assigned to each model in the flipbook.

### Use Textures
Select this check box and specify a path to import the VRML model with the accompanying textures.

### Use Animations
Select this check box to import animations with the scene. The following options are enabled:

- **As Non-editable**: the animation is imported as-is, and there is no possibility to change the positions or values of the keys.
- **As Editable Keyframes**: separate keyframes for each frame of the animation are created; this can take several minutes to complete, depending on the length of the animation and complexity of the scene.

**Use Frame Rate** allows you to set the frame rate for the incoming animation. It should be the same as the frame rate used in the VRML exporting application.

Select the **Do not interpolate rotation** check box to correct problems with rotation animations. Usually, these problems appear as jumps in the animation.
VRML Elements in 4Designer

Transparent objects in the VRML scene have to be defined in the object hierarchy; in the view tree, place transparent objects below those which will be seen behind the transparent object. Another way to think of the hierarchy is to place the objects that would be at the back of the scene at the top of the hierarchy, and the objects at the front of the scene at the bottom.

Objects in Maya which were exported without shader information (only texture, but no color) will need to have new materials defined in 4Designer. 4Designer multiplies the material color with the pixel of the textures. Otherwise the Maya objects will appear in black.

The camera is always on the top of the hierarchy. It is shown together with the options for the whole layer. One more camera can appear in the hierarchy if it was included in the VRML scene.

The objects of the VRML scene are nested in sub-groups. They can be opened by clicking on the ‘+’ icon next to their names. To open all sub-groups in the hierarchy, click the right mouse button and select Expand / Shrink > Expand All.

Changing Materials in the Scene

The materials of the objects depend upon the export from Maya. An export from Maya can include an object with texture, but without color information. This is why each material has to be adjusted in 4Designer. For most objects it makes sense to use a 100% white material. 4Designer multiplies the material color with the pixels of the textures.

The best is to start with one material and replace it with a plain color, or plain material which is 100% white (RGB values of 255).

Transparent Objects and Brilliance Effects

It is the best to create transparent objects and shine effects directly in 4Designer. In this way the optimal real time performance can be reached.

A transparency effect can be achieved by selecting an object and using the tab “Color” in the property editor. There you can find the color information and also the alpha values. This value has to be changed from 1.0 (fully opaque) to approx. 0.2 depending on the intensity of the transparency.

To obtain a reflection effect, open the texture browser and select a silver or chrome texture. To change texture mapping, select Map Type > Spheremap in the Mapping Properties.

Animated Textures

Animated textures will be mapped as a picture sequence onto the objects. To map an animated texture onto an object, you should select the object in the Tree View, right click in the texture column and select New Texture > Animated Texture. The texture editor tab will now be selected, and the sequence may be assigned. To start the sequence on the right side of the editor tab, there is a section with video sequence options. Set the first button on ‘Loop’. Now the texture will run continuously.
Exporting Tips for Other 3D Software

3ds MAX / Maya:
The VRML exporter from Maya and 3ds MAX, give incorrect positions to pivot points in Animation. After being imported, the animations will run correctly, but the user will not be able to create new animation based on those pivots.

Lightwave:
When exporting VRML from LightWave, the option PROTO should be deselected.
Exporting VRML from LightWave may also produce a syntax error with the creation of two commas, one after the other. Removing one of the commas will solve the problem.

Blender:
Some VRML files exported from Blender may contain material settings that are not imported correctly. Edit the VRML file, and replace and entry MA_(null) with MA_.
When importing VRML files from Blender enable the option “Double Sided Mesh”.

VRML Binary Format:
Some VRML content developers want to minimize download time for their customers, so they compress the file using gzip. To work around a bug in some web browsers, many authors choose to name those zipped worlds "foo.wrl" instead of "foo.wrl.gz", the default file name that gzip generates. After decompressing the file, it should be an ASCII format VRML file.

Cinema4D:
Before importing graphics created in Cinema4D, bake the textures to the objects, and remember to save them in VRML format.
Appendix

This appendix contains the following section:

Line Charts Design on page 254

Isometric camera - preview of the available presets on page 259
Line Charts Design

Modifying the Background of a chart

The background of a chart is defined under the chart group in the Scene tree. It can be any object with any color or texture. The example below has the background implemented as a group (1) of three alternative objects, which can be switched by controlling the “Background” export (2).

➢ To change the background of a chart:

1. In the Control Interface, select the Background export (as shown on the illustration above).
2. Right-click on one of the available options, and select Send export:

3. The background of the chart changes according to your selection.

Changing the point marker type

The point marker types are defined as sub-containers of the Points container. Any shape can be chosen to represent the points on the chart.
The illustration below presents an example of three alternative point types, implemented as sub-objects (1) of the points array container, which can be selected by controlling the “point type” export (2).

To change the point type:
1. In the Control Interface, select the point type export (as shown on the illustration above).
2. In the O column, type in the number representing the child object of the points container and press Enter.
3. The point type changes accordingly.

Defining a fill area underneath the line

You can define the look of the fill in the Area Chart. This shape is implemented with the Geometry creator object “Area B”. It uses the same data serie as the “line B” element, therefore it responds to any changes made to the line.
To change the color or texture of the fill area:

1. In the RE window or in the Scene tree, select the Area B object.

2. To change the color, open the Color editor. Select the required color and transparency from the color palette.

3. To change the texture, in the texture column in the Scene tree, right-click and select New Texture and the required texture type. The texture is applied to the object, and the Texture editor is displayed, where you can edit required properties.

Defining the style and depth of the line

The line in the Area Chart example is implemented with accurately scaled cuboids, and has an added texture. The pattern scale of the texture and the line depth can be adjusted to create a different look.

To change the pattern scale:

1. In the Control Interface, select the Line_Style_Scale_Y export (as shown on the illustration below).

2. In the O column, type in the desired value and press Enter.

3. The pattern scale changes accordingly.
To change the depth of the line:

1. In the Control Interface, select the line depth export (as shown on the illustration below).

2. In the O column, type in the desired value and press Enter.

3. The depth of the line changes accordingly.
Animation of a chart

The charts can be animated in various ways. The Line Chart example uses two kinds of animation effects: T and scissor, and Soft mask.
Isometric camera - preview of the available presets

The Isometric camera allows to control the projection by manually setting the angles and scales of the axes. The table below illustrates how the defined presets modify the preview of the objects in the RE window.

<table>
<thead>
<tr>
<th>Preset</th>
<th>X angle</th>
<th>Y angle</th>
<th>Z angle</th>
<th>X scale</th>
<th>Y scale</th>
<th>Z scale</th>
<th>Preview</th>
</tr>
</thead>
<tbody>
<tr>
<td>Isometric</td>
<td>60°</td>
<td>0°</td>
<td>120°</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td></td>
</tr>
<tr>
<td>Dimetric</td>
<td>63.44°</td>
<td>0°</td>
<td>116.57°</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td></td>
</tr>
<tr>
<td>Trimetric</td>
<td>75.96°</td>
<td>0°</td>
<td>126.87°</td>
<td>1.0</td>
<td>1.0</td>
<td>0.7071</td>
<td></td>
</tr>
<tr>
<td>Military</td>
<td>45°</td>
<td>0°</td>
<td>135°</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td></td>
</tr>
<tr>
<td>Cavalier</td>
<td>90°</td>
<td>0°</td>
<td>135°</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td></td>
</tr>
<tr>
<td>Top-Down</td>
<td>90°</td>
<td>0°</td>
<td>180°</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td></td>
</tr>
</tbody>
</table>
## Index

### A

- action buttons 48
- activating ticker 158
- adding object to scene 28, 84
- animated texture 104
- animation 13
- along a path 203
- automatic rewind 192
- defining 188
- group 192
- keyframe properties 189
- master 206
- speed 190
- timeline 179, 192
- animation view
  - buttons 182
  - creating keyframe 185
  - window 181
- applying
  - material 102
  - shader 240
  - textures 103
- asset strip
  - adding objects 55
  - material 102
- audio 107
- autosave 232

### B

- Blender 249
- blending modes 60, 75
- bounding box 77

### C

- camera
  - perspective 66
  - tab 62
  - target 66
- camera layer
  - flat/orthogonal 63
  - free layer 64, 65
  - perspective layer 66
  - window camera 67
- Cinema4D 249
- clip texture 107
- clipping planes 66, 158
- clock object 159
- color tab
  - lighting 102
- coloring layer 25
- complex object 55
- connecting parameters 168
- copying
  - object properties 56
- crawl, See ticker object
- create keys dialog box 184
- creating
  - groups 59
  - internal connections 169
  - keyframe 184
  - layer 62
  - pie chart 35
  - scene 40
  - ticker 157
- damping 213
- data connections 168
- decorated text 149
- defining
  - animation 188
  - hotkeys 229
- deleting
  - channel 187
  - keyframe 187
  - triggers from scene 196
- DVG video output 45

### E

- editing
  - clock object 159
  - keyframe properties 189
  - ticker 157
- emoticons 151
- environment 71
- exporting parameters 13, 168
R
remove options 233
rename options 233
renaming object 58
RenderEngine 22, 26
restitution (resilience) 213

S
safe area 235
scene
  creating 40
deleting 43
scene thumbnail 42
scenes
  loading 41
search 43
setting
  grid properties 84
  preferences 229
shaders 239
shape tab 85
shortcuts 229
single child mode 74
snap timeline to fields/frame 231
stack 29
starting 3Designer 21
startup options 21

T
text deco objects 149
text effects 149
text objects 143
texture
  animated 104
  applying 103
  applying as text effect 151
through folder 28
thumbnail 42
ticker activation 158
ticker object 157
time format 232
time format (clock) 160
timeline 179
timeline jump 232
touch and release interactivity 209
touchscreen objects 208
tracking file 134
transformation 81
trigger 194
triggers
  deleting triggers from scene 196